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Introduction 

Introduction 

Microsoft Word for the Macintosh is the best sell
ing word processor for the Macintosh platform 
with more than one million users throughout 
the world. Word for the Macintosh version 5.0 
started shipping in late December 1991 and 
marked the ftrst major update to the program 
since the April 1989 release of version 4.0. 

Word has suffered from a checkered past in the 
Macintosh community. Previous releases openly 
violated Apple's human interface guidelines. Mi
crosoft's current philosophy is to provide as con
sistent a user interface as possible between its 
programs that run under the Macintosh operat
ing system and the Windows environment un
der the MS-DOS operating system. 

Die-hard Macintosh fans will bemoan some as
pects of Word's user interface. Those users that 
are familiar with Word for Windows, however, 
will breath a sigh of relief. 

At a retail price of $495, Word is definitely a 
high-end word processing product. I haven't 
used Word for several years and I was pleasantly 
surprised at some of the new features offered in 
the latest release. I also breathed a sigh of relief at 
the stability of version 5.0 under System 7. 
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Who Can Use This Book 

This book is intended for anyone who is current
ly using or contemplating the purchase of Mi
crosoft Word. Two specific groups of users are 
targeted: 

• Individuals and very small workgroups who 
are using Microsoft Word. 

• Network administrators within medium-to
large-sized organizations who are using Mi
crosoft Word. 

This book is not meant to be a replacement for 
Microsoft's documentation set. Nor is this book 
intended to replace the wide variety of books 
and other information available for using Word. 

I'm assuming that you have at least a passing ac
quaintance with things Macintosh; that you 
know how to click and double-click on screen 
items and that you understand the basic Macin
tosh operating conventions. 

I'm not assuming that you're an expert, but I am 
assuming that you have read at least the most ba
sic parts of the documentation set that came 
with your computer and with Microsoft Word. If 
you haven't, it's OK; go and do it now. This book 
will still be here when you get back. 

About the Series 

Page viii 

This book is part of the Business One Irwin Rapid 
Reference series. Each is designed basically the 
same way, and with the same intention: to pro
vide coverage of the basic functionality of lead
ing software applications for the Apple 
Macintosh family of computers. 



The underlying idea for this series is that most 
people are far too busy to wade through enor
mous amounts of documentation, and that they 
shouldn't have to; at least not to perform basic 
tasks within the product. 

Each book in this series covers the basic func
tionality of the product at hand. 

The underlying idea at work here is that basic in
formation will enable you to become productive 
quickly, allowing you to explore the deeper lev
els of a program's functionality later, when you 
have more time. 

A wide variety of titles is currently under devel
opment. If there are specific titles you would like 
to see, please don't hesitate to contact the pub
lisher or the author. 

Business One Irwin 
1818 Ridge Road 
Homewood, IL 60430 
800/634-3966 

Michael Fraase 
Arts & Farces 
2285 Stewart Avenue 
Suite 1315 
Saint Paul, MN 55116 
612/698-07 41 

Navigating This Book 

Introduction 

This book, like the others in the Rapid Reference 
series, is organized in a series of relatively short 
chapters for brevity and easy navigation. 

The material is thoroughly cross-referenced 
wherever possible, and a complete table of con
tents and index are provided. 
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Conventions Used In This Book 

i~, 
lml 
1!:-::.1 

Pagex 

Each title in the Rapid Reference series contains 
various tips, warnings, and items flagged for your 
consideration. These items are represented 
graphically throughout the entire series using 
the following conventions: 

The checkmark is used to mark an item for your 
consideration. It is recommended that you con
sider this information before going any further 
in the process described. Items marked with the 
checkmark are important to consider, but will 
not cause any serious problems if you ignore or 
disregard them. The checkmark is also used to 
identify undocumented features as well as tips 
and shortcuts. 

The familiar caution icon is used in a manner 
consistent with Apple's documentation and hu
man user interface guidelines. The caution icon 
is used throughout this book to call your atten
tion to an operation that may have undesirable 
results if completed. 

The stop icon is used in a manner consistent 
with Apple's documentation and human user in
terface guidelines. The stop icon is used to call 
your attention to an operation that can cause a 
serious problem. The stop icon is used only for 
information that can cause serious and some
times irreparable damage. Pay close attention to 
any stop icons. 
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CHAPTER ONE 

Before You Install ... 

Several issues must be considered and addressed 
before you install System 7, regardless of whether 
you're working with a single Macintosh or sever
al hundred. The best place to start is with a com
patibility assessment. 

Compatibility Assessment 

Forget most of what you've heard about System 
7 incompatibilities; they're much fewer and 
much less severe than what you've been told. 
While you're at it, you can also forget what Ap
ple says about requirements. 

According to Apple, any Macintosh with 2 
MBytes of memory and a hard disk drive can run 
System 7. Technically, that's true, but most ob
servers agree that 4 MBytes of RAM is the practi
cal minimum to perform useful work. 

That's not as bad as it seems. 1 MByte SIMMs were 
selling for about $35 and 4 MByte SIMMs were 
selling for about $150 in the first week of Octo
ber 1991. As of early june 1992, 1 MByte SIMMs 
were selling for about $31 each and 4 MByte 
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SIMMs were selling for about $115. A general rule 
of thumb is that you can never have too much 
RAM. I use 20 MBytes and would be lost with less. 

Technology Works is the best source of Macin
tosh memory modules I've found. They're not 
the cheapest, but they are of high quality and 
come well packaged. in addition, the company 
includes a Memory Upgrade Installation Guide that 
is informative and lucid. (Technology Works, 
4030 Braker Lane West, Suite 350, Austin, TX 
78759. Phone 800/933-6113 or 512/794-8533; 
fax 512/794-8520.) 

A Crash Course In Memory 

Page2 

Every Macintosh currently sold has sockets to 
hold memory modules. Memory is upgraded by 
installing Single In-Line Memory Modules 
(SIMMs) in these sockets. Various Macintosh 
models differ in the number of SIMM sockets 
available and the speed of the SIMMs required. 

Compact Macintosh models (Macintosh Plus, 
Mac SE, Classic, and Classic II) usually have a to
tal of four SIMM sockets in two separate banks of 
two sockets each. 

Modular Macintosh models (Macintosh II, Ilx, 
Ilcx, Ilci, LC, Ilsi, and Ilfx) usually have either 
eight SIMM sockets in two banks of four sockets 
each, or they have 1-2 MBytes of RAM soldered 
on the motherboard combined with a single two 
or four socket bank. 

SIMMs are rated in nanoseconds of access time. 
Compact Macintosh models require 150 ns 
SIMMs. Most modular Macintosh models require 
120 ns or 100 ns SIMMs, except for the Ilfx and 
Ilci, which require 80 ns SIMMs. 
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It's just fine to use faster speed SIMMs than re
quired, but using slower speed SIMMs will result 
in problems. Mter a short time the Macintosh 
will begin to crash or lock up unexpectedly. Buy
ing faster speed SIMMs offers the advantage of 
compatibility with faster Macintosh models or 
future accelerator upgrades. The best rule of 
thumb is to buy the fastest SIMMs you can find. 

Most SIMMs are interchangeable, although the 
Macintosh Ilfx SIMMs have more connectors on 
them and will only work in the Ilfx. In addition, 
the various memory configurations for the porta
ble are completely different. The Macintosh Por
table and the PowerBooks all require the use of 
Static RAM or pseudo-static RAM instead of the 
standard Dynamic RAM (DRAM) used by the oth
er Macintosh models. 

SIMMs are currently available in 256 KByte, 5 12K, 
1 MByte, 2MB, 4MB, 8MB, and 16MB configu
rations from a wide variety of vendors. 

Each SIMM bank must be completely full or com
pletely empty. 

Each SIMM bank, if filled, must be filled with 
SIMMs that are all the same size. 

If you're only filling one SIMM bank, fill Bank A. 
The location of Bank A varies between the differ
ent Macintosh models. 

In most cases the larger capacity SIMMs should be 
installed in Bank A. Most of the exceptions to 
this rule revolve around the use of on-board vid
eo on the Macintosh Ilci. 

Macintosh SIMMs are relatively easy to install. 
I'm not much of a propeller-head-I've never 
soldered anything in my life-and I managed to 
remove and add SIMMs to both a Macintosh Ilci 
and a Macintosh SE/30 with no problem. Adding 
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memory to the Ilci was a cake walk; the SE/30 
was a bit more difficult, but posed no problem 
once I convinced myself I wasn't going to get 
electrocuted and the monitor wasn't going to 
implode. 

Be careful! You can get electrocuted and the 
monitor can implode on compact Macintoshes if 
you're not cautious. In addition, you may void 
your warranty, and the SIMM clips are notorious
ly fragile. If you're not comfortable mucking 
about within the computer's innards, pay some
one to do it for you. 

Connectix Corp. offers a wonderful publication, 
The Macintosh Memory Guide, free of charge. It 
covers the memory requirements and possible 
configurations of all Macintosh models and is in
dispensable. (Connectix Corp., 2655 Campus 
Drive, San Mateo, CA 94403. Phone 800/950-
5880 or 415/571-5100; fax 415/571-5195.) 

32 Bits and What Do You Get? 

If you have a Macintosh II, Ilx, Ilcx, or SE/30 
you'll need another Connectix product-MODE 
32-if you want to use System 7's 32-bit address
ing to access more than 8 MBytes of memory. In 
addition, MODE 32 allows you to access more vir
tual memory on the older Macintosh models. 

In late September 1991, Apple and Connectix 
announced an agreement whereby Connectix 
would be made available free of charge and Ap
ple would offer a refund to all users who had al
ready purchased MODE 32. 

The Macintosh Plus, SE, and Classic compact 
models-because they are not equipped with a 
paged memory management unit (PMMU)-are 
limited to a total of 4 MBytes of memory and are 
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unable to use virtual memory in any case unless 
you install a third-party accelerator. 

Hord Disk Drive Copoclty 

System 7 requires a minimum of about 4 MBytes 
of hard disk drive space. If you have a 32-bit 
clean Macintosh (LC, Ilci, Ilsi, and Ilfx) and want 
to use virtual memory, you will need even more 
hard disk drive space. 80 MByte hard disk drives 
with Quantum or Maxtor mechanisms were sell
ing for about $500 in early October 1991. A gen
eral rule of thumb is to buy a hard drive with two 
or three times the capacity you think you'll need. 
Like memory, you can't have too much hard disk 
space. 

What About Ethernet? 

System 7's built-in file sharing capabilities prom
ise to bog down many networks and Ethernet 
will have to be considered by most large organi
zations and many small ones. 

A working rule of thumb is to consider Ethernet 
alternatives when your network begins to slow 
noticeably or when you need faster network ac
cess. Even then, try before you buy, or hire a con
sultant for an hour or two to assess your 
particular situation. 

As of early October 1991, Ethernet cards were 
selling for between $200 and $300 and eight
port Ethernet hubs add between $750 and $1000 
to the total cost. As of early june 1992, mid-level 
quality Ethernet cards were selling for as low as 
$150 and hubs for as low as $500 or so. 
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Pass the Software, Please 
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While most mainstream software packages are 
fully compatible with System 7, many software 
applications will have to be upgraded to add ad
ditional functionality under System 7. 

The price of admission for this additional func
tionality varies wildly. For example, Microsoft 
wants $129 per copy to upgrade to Excel v3.0; 
Claris charges $30 per copy to upgrade MacDraw 
II; ACIUS charges $50 per site to upgrade its 4th 
Dimension database; and CE Software offered 
free upgrades for a limited time for its QuickMail 
electronic mail package. 

Apple's Infamous Compatibility Checker 

Apple supplies a HyperCard stack-Compatibili
ty Checker-that compares your installed soft
ware with a list of System 7 -compatible items 
and produces a compatibility report. 

The Compatibility Checker is an excellent idea, 
but the implementation is terrible. Applications 
that are fully compatible with System 7 are 
flagged as incompatible and vice versa. This will 
hopefully be addressed in the near future. 

The best approach to use with the Compatibility 
Checker stack is to take the report it provides 
with more than a few grains of salt. Use it as a 
starting point, and nothing more. 

Chances are that most everything will work fine, 
although there are several notable exceptions. 
Like Apple's own 8•24 GC video display card; its 
acceleration features were completely incompat
ible with System 7 until almost a year after the 
operating system software was initially released. 
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Hidden Costs 

The cost of installing System 7 tends to grow by 
orders of magnitude in direct proportion to the 
complexity of the site. Individual users can up
grade to System 7 in a few hours, but there are 
hidden costs to be considered and accounted for 
within larger organizations. 

Installing the new LaserWriter drivers alone 
within a 40-Macintosh site takes about two days. 
A typical site with between 40 and SO Macin
toshes should count on three full eight-hour 
days to install System 7 on all machines. 

Macintoshes running System 7 and System 6 can 
coexist on the same network, so all the comput
ers in an organization need not be upgraded at 
the same time. If you expect to continue to use 
System 6 on any of your Macs, however, you 
need to install new printer drivers on all ma
chines that will be sharing LaserWriter printers. 

In addition to the costs directly associated with 
physically updating Macintosh system software 
there are also training costs to be considered and 
budgeted for. 

Even though the Macintosh is much easier to 
learn and use than competing hardware plat
forms, all things Macintosh have gotten much 
more complicated. Sites upgrading to System 7 
should budget for about six hours of training for 
each user. 

Backup Before Installing 

When you have determined that you have the 
necessary hardware horsepower, schedule and 
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perform a complete backup. Everyone hates 
backing up, but it's something that will save you 
many hours of unnecessary work if something 
goes wrong during installation. 

Dantz Development Corp.'s Retrospect and Ret
rospect Remote are the best backup tools I've 
found. (Retrospect is for stand-alone Macs, and 
Retrospect Remote allows you to backup hard 
disk drives across a network.) The street prices for 
these software packages are about $150 and $250 
(for a 10-user pack), respectively. (Dantz Devel
opment Corp., 1400 Shattuck Avenue, Suite 1, 
Berkeley, CA 9470. Phone 415/849-0293; fax 
415/849-1708.) 
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CHAPTER TWO 

Installing System 7 

System 7 is available commercially in two forms: 
the Group Upgrade Kit and the Personal Upgrade 
Kit. Additionally, System 7 is available-without 
accompanying documentation-from many 
user groups and online services. This chapter will 
provide installation information for both Up
grade Kits. 

Apple states that there is no need to reformat 
your hard disk drive before installing System 7. 
Like the RAM issue, that's technically true, but 
my experience has been that things started to 
work much more smoothly when I reformatted 
my main drive, installed System 7, and restored 
my files from a backup. 

The Personal Upgrade Kit 

Apple's System 7 Personal Upgrade Kit is de
signed for individual users. The operating system 
upgrade is provided on 12- 800 KByte floppy 
disks, including HyperCard. 

Documentation consists of licensing agree
ments, support program registration materials, a 
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partial Compatibility List (about as useful as the 
Compatibility Checker stack discussed in Chap
ter One), a What's New in System 7 manual, the 
Macintosh Reference, the Macintosh Networking 
Reference, and HyperCard Basics. 

Purchase of the System 7 Personal Upgrade Kit 
entitles you to 90 days of toll-free telephone sup
port Monday through Friday from 6:00 a.m. to 
5:00p.m. Pacific time. The support clock starts 
with your first call, not when you register the 
software. 

The Group Upgrade Kit 

Page 10 

Apple's System 7 Group Upgrade Kit is designed 
for sites with multiple networked users. The op
erating system upgrade is provided on a CD-ROM 
as well as 13- 800 KByte floppy disks, including 
HyperCard. (The extra floppy disk contains the 
updated CD-ROM software required for use with 
System 7.) 

The CD-ROM comes with a customized installer 
that allows the network administrator or work
group members to install System 7 directly from 
the CD-ROM. In addition, the Macintosh Electronic 
Reference is also included on the CD-ROM. This is 
an electronic version of the System 7 documen
tation embodied in a series of HyperCard stacks. 

Various administration tools are also provided 
on the Group Upgrade Kit CD-ROM. The User In
structions folder contains a set of instructions for 
users accessing the upgrade software across a lo
cal area network. 

The Network Compatibility Listings folder con
tains a HyperCard stack that can be used to de
termine the level of System 7 compatibility of 
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various networking products. These are not as 
up-to-date as they could be, but they are still 
quite useful. 

The CD Setup folder contains the new System 7-
compatible CD-ROM drivers. This driver software 
is also provided on a floppy disk. 

The Inter• Poll folder contains a utility to moni
tor various system software versions across the 
network within an organization. 

The Basic Connectivity Set folder contains a 
group of communications tools for use with the 
Communications Toolbox. 

The Disk Images folder contains disk images that 
you can use to create installation disks for all op
erating system software from 6.0.2 through 7.0. 
The Disk Copy application is also included in 
this folder. 

The EtherTalk Phase 1 folder contains software 
and documentation for AppleTalk Phase 1-com
patible EtherTalk drivers. 

The Laser Writer Namer folder contains a utility 
that allows you to rename LaserWriter printers. 

The TrueType folder contains a version of Apple's 
font scaling software that can be used with Sys
tem 6.0.7. 

The System 7 Presentation folder contains an Al
dus Persuasion presentation that can be used to 
inform workgroup members of the capabilities 
and advantages of System 7. 

The HyperCard 2.1 folder contains HyperCard 
v2.1 used to run the Macintosh Electronic Reference 
and other HyperCard-based materials. 

The HyperCard 1.2.2 folder contains HyperCard 
v1.2.2 for those users who are upgrading from 
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System 6.0.4 or earlier. HyperCard v2.1 requires 
System 6.0.5 or later. 

Unfortunately, as of June 1992, the Group Up
grade Kit CD-ROM had not been updated to in
clude the two maintenance releases of System 7. 
Only the initial release of System 7, version 7.0 is 
included on the Group Upgrade Kit CD-ROM. 
Similarly, the utilities contained on the CD-ROM 
are also out of date. 

Documentation consists of licensing agree
ments, support program registration materials, a 
partial Compatibility List (about as useful as the 
Compatibility Checker stack discussed in Chap
ter One), the System 7 Group Upgrade Guide, a 
What's New in System 7 manual, the Macintosh 
Reference, the Macintosh Networking Reference, and 
HyperCard Basics. 

When you purchase of the System 7 Group Up
grade Kit CD-ROM, you are automatically entitled 
to 180 days of toll-free telephone support Mon
day through Friday from 6:00 a.m. to 5:00 p.m. 
Pacific time. 

The support clock starts with your first call, not 
when you register the software. A good strategy 
is to try to work out relatively minor initial prob
lems on your own. 

Installing on a Local Disk 
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System 7 is too big to fit on a floppy disk and 
must be installed on a hard disk drive. You'll 
need a minimum of about 4 MBytes of free space 
on your drive. 

This section assumes that you are familiar with 
the issues already covered in this chapter. You 
can use the following set of instructions to check 
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the contents of your drives for compatibility 
with System 7. 

1. Launch HyperCard on your present system 
configuration. 

2. Open the Before You Install stack. The open
ing screen will be displayed, as shown in Fig
ure!. 

-~-=--_---- -:- ~- ------ - ---~ ~ 

- --- - -- - - -

Before You Install system 7 0 
The contents of this disk will help prepare you for upgrading to System 7. 
You can look through new features, and you can use a special utility program 
to check your system's compatibility with the new software. 

To begin, click the title of your choice below. 

~ 

• 
What's New in system 7? 
Here :.re brief demons~ntioos of new fe1tutes. If you've never use<! the 
MuhiFinderprogrun, be sure to see the introduction to the new Finder . 

Compat:tmlity Checker 
This utility progrun c:heds your (urrent Mxinl06h system foe items 
reponed to be in<ompalible with System 7. Youanget1 printed report 

- --- ------ ----- ·~ -

Ctll\1('1\tS ' 
- --- 1 

Figure 1 Before You Install stack introduction. 

3. Click the What's New In System 7? button 
to explore System 7's new features. 

4. Click the Compatibility Checker button to 
generate a System 7 compatibility report for 
your particular system configuration. 

• An introductory screen will appear and 
will quickly be replaced by an instruction 
screen with buttons allowing you to Quit 
HyperCard, return to the Contents 
screen, or Set Up your particular system 
configuration. 
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SetUp 

5. Click the Set Up button. The Compatibility 
Checker's Set Up card will be displayed, as 
shown in Figure 2. 

I I ntroductlon I 
Here is a list of all the disks and network file serve~ connected to your Macintosh. 
Your startup disk is already selected; click to select any additional disks you want to 
check. (An X In the box means you want the disk to be checked.) 

When you're ready, click the Start Checking button. 

Your startup disk is: 181 Further 

Other available diskS: 
0 Intrepid 
ocassady 
osauannah 

Page 14 

Figure 2 Compatibility Checker's Set Up card. 

• The Set Up card contains a list of all 
available disks and network file servers 
connected to your Macintosh . 

6. Check each of the available disk's checkbox
es to select the disks to include. 

7. Click the Start Checking button. 

• Your selected disks will be checked and a 
report will be displayed on screen at the 
conclusion of the process. You will be 
presented with an option to save the re
port to disk or print it. 

8. Evaluate the results of the report. 

• Don't take the Compatibility Checker re
port too seriously. It's a great idea but no
toriously inaccurate. 
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When you have evaluated the Compatibility 
Checker's report of your installed software, you 
are ready to prepare your hard disk drive media 
for System 7. 

Most hard disk drive vendors have updated their 
formatting and driver software to be fully com
patible with System 7, although there are some 
exceptions. Contact your dealer or vendor for in
formation about your equipment. The most 
common case of driver incompatibility results in 
the inability to use virtual memory with the 
Macintosh models that support it. 

All hard disk drives are assembled from a handful 
of components from a shockingly small number 
of manufacturers. I've had mixed experiences 
with every hard drive vendor I've done business 
with. I wish I could recommend one, but I can't. 
If you find a great one, let me know. 

Apple maintains that it's unnecessary to refor
mat your hard disk drive for use with System 7, 
but my own experience is that it's a good idea, 
and certainly doesn't hurt. 

In any case, it's highly likely that you will have 
to at least update the driver for your hard disk 
drive. Follow the instructions that came with 
your drive to either reformat the media or update 
the driver software. Contact your dealer or ven
dor for specific information about the level of 
System 7 compatibility of your drive(s) . 

The best hard disk drive formatting software cur
rently available is FWB Inc.'s Hard Disk Toolkit. It 
will format virtually any hard disk drive with an 
embedded SCSI controller and offers an unprece
dented level of user control. FWB's Hard Disk 
Toolkit also supports the SCSI-2 standard. I ha-
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ven't had any experience with FWB's hard disk 
drives, but I know a lot of people that recom
mend them. (FWB Inc., 2040 Polk Street, Suite 
215, San Francisco, CA 94109. Phone 415/474-
8055; fax 415/775-2125.) 

Installing the System 7 Software 
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When you've prepared your hard disk drive for 
System 7, either by reformatting the media or 
updating the driver software, you're ready to ac
tually install the System 7 software. 

Make sure you check with your dealer or the ven
dor of your hard disk drive concerning the com
patibility of your driver software and any 
upgrading procedure that may be necessary. 
Many vendors had to update their driver soft
ware, and if you don't upgrade as required, you 
may lose data. If your vendor charges you for a 
System 7 -compatible driver upgrade, find anoth
er vendor. 

You can use the following set of instructions to 
install System 7 on your hard disk drive. 

1. Make a new folder to temporarily store Sys
tem Folder items you want to retain for use 
with System 7. 

• This folder can be named anything (ex
cept System Folder); it's temporary and 
you will delete it later. 

• If you've reformatted your hard disk 
drive you can skip this step-and the 
next-and start with step 3. 

2. Delete your existing System Folder. 

3. Insert the floppy disk named Installl in your 
floppy disk drive and restart your Macintosh. 
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• The Installer application will be 
launched automatically and the Wel
come to the Apple Installer screen will 
appear. This screen contains some basic 
information about the installation op
tions available to you. 

4. Click the OK button on the Welcome to the 
Apple Installer screen. 

• The Easy Install dialog box will be dis
played with suggested selections for your 
hardware configuration and a target hard 
disk drive specified as a default. Figure 3 
shows the default selections for a Macin
tosh Ilci. 

Easy Install 

3.2 

Click Install to update to Uerslon 7.0.1 of 
• Macintosh System Software 
• LaserWrlter Printing Software 
• File Sharing Software 

on the hard disk named 
c further 

Help 

H Install B 

( Eject Disk ) 

( Switch Disk J 

( Customize J 

Quit 

Figure 3 Installer default selections for 
Macintosh llci. 

5. Click the Install button to accept the sug
gested System software selections and begin 
the installation procedure. 

• If you select this option you can skip the 
next two steps-6 and 7-and advance to 
step 9. 
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6. Click the Switch Disk button to install Sys
tem 7 on another hard disk drive. 

7. Click the Customize button to customize 
the installation for your needs. Items can be 
selected from the scrolling list. 

8. Click the Install button to begin the actual 
installation of the System 7 files. 

9. Follow the instructions that appear on the 
screen and insert the appropriate floppy 
disks as they are needed. 

10. Click the Quit button when a dialog box ap
pears at the end of the installation process re
porting that the procedure was successful. 

• If the installation procedure was unsuc
cessful, you'll be notified and can begin 
the installation again. 

11. Click the Restart button in the dialog box 
that appears when you quit the Installer. 

• Your Macintosh will restart using the sys-
tem software you just installed. 

You can finish up the installation procedure by 
dragging the items from your temporary folder 
onto the new System Folder icon. 

Do not open the System Folder window to install 
the System Folder items you have retained; if you 
do so they will be placed loose within the System 
Folder and may not work properly. Instead, drag 
the items onto the System Folder icon. System 7 
has an intelligent System Folder that automati
cally places most items where they belong. In all 
but a very few cases, this intelligence really does 
its job well and items are almost always placed 
where they belong. 

For more information on System Folder items, 
refer to Chapter Three: The Intelligent System 
Folder, beginning on page 25. 
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Installing on a Network 

Installing System 7 within a networked environ
ment is somewhat different than updating a sin
gle Macintosh. The good news is that the System 
7 Group Upgrade Kit obviates the need for a lot 
of floppy disk swapping, and is accessible across 
a local area network. 

The bad news is that the System 7 Group Up
grade Kit CD-ROM hasn't been updated to in
clude any maintenance releases of System 7. 

The rest of this chapter will deal with installing 
System 7 within a workgroup setting. 

Begin the workgroup upgrade process by upgrad
ing your own Macintosh. You can do this in one 
of two ways: 

• You can follow the instructions in the previ
ous sections, using the floppy disks included 
in the System 7 Group Upgrade Kit. 

• You can use the CD-ROM included with the 
System 7 Group Upgrade Kit. 

It's highly recommended that you install System 
7 on your own Macintosh or a test machine be
fore upgrading your entire network. This will al
low you to get comfortable with both System 7 
and the actual installation process and enable 
you to answer inevitable questions posed by oth
er workgroup members. 

Upgrading Your Local Macintosh from the CD-ROM 

There are two precautions you may want to con
sider before installing System 7 on any Macin
tosh within a networked environment: 
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• If you're using EtherTalk on an AppleTalk 
Phase I network, you will not be able to use 
any network services until the entire work
group has been upgraded to System 7. 

• Be careful not to print to any LaserWriter 
shared by workgroup members. Doing so will 
prevent anyone from printing to that Laser
Writer under System 6. 

You can follow this set of instructions to upgrade 
your Macintosh from the CD-ROM supplied with 
the System 7 Group Upgrade Kit. 

1. Update your hard disk drive driver software 
as explained in the previous section (begin
ning on page 15). 

2. Insert the System 7 CD-ROM in your CD-ROM 
drive and wait for it to be mounted (appear) 
on the desktop. 

3. Open the System 7.0 Installer folder. 

4. Launch the Installer application. 

5. Click the Install button to accept the default 
Installer settings and begin the installation 
procedure. 

• If you select this option you can skip 
steps 6 and 7 and advance to step 9. 

6. Click the Switch Disk button to install Sys
tem 7 on another hard disk drive. 

7. Click the Customize button to customize 
the installation for your needs. Items can be 
selected from the scrolling list. 

8. Click the Install button to begin the actual 
installation of the System 7 files. 

9. Click the Quit button when a dialog box ap
pears at the end of the installation process re
porting that the procedure was successful. If 
the installation procedure was unsuccessful, 

System 7 Rapid Reference 



you'll be notified and can begin the installa
tion again. 

10. Click the Restart button in the dialog box 
that appears when you quit the Installer. 
Your Macintosh will restart using the system 
software you just installed. 

When you have successfully updated your Mac
intosh to System 7 you should immediately up
date your CD-ROM software to the version 
included with the System 7 Group Upgrade Kit 
by following these steps. 

1. Insert the Macintosh CD Setup floppy disk in 
your floppy disk drive. 

2. Launch the Installer application. 

3. Click the Install button. 

4. Click the Quit button when a dialog box ap
pears at the end of the installation process re
porting that the procedure was successful. 

• If the installation procedure was unsuc
cessful, you'll be notified and can begin 
the installation again. 

5. Click the Restart button in the dialog box 
that appears when you quit the Installer. 

Upgrading Networlt Maclntoshes from the CD-ROM 

Any number of Macintoshes can upgrade across 
the network. You can follow these steps to make 
the System 7 CD-ROM available to remote work
group members. 

1. Open the Sharing Setup control panel. 

2. Identify your Macintosh to the network. 

3. Set the Owner Password. 
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4. Click the File Sharing Start button. 

5. Insert the System 7 CD-ROM in your CD-ROM 
drive and wait for it to appear. 

6. Select the CD-ROM within the Finder. 

7. Select the Sharing ... command from the File 
menu. The Sharing window will appear, as 
shown in Figure 4. 

'Where: 

S stem 7.0 CD-ROM 

System 7.0 CD-ROM, CD-ROM Drive 
(SCSIID•4) 

18] Share this item and its contents 

See See Make 
Folders Files Changes 

Owner: I Michael Fraase.,... ~ [8J [8J r.-::."1 

User /Group : I Arts & Farces .,... ~ 18] 18] r.·.-.".'1 

Everyone 18] 18] f.".'.'.'l 

[8J Make all currently enclosed folders like this one 

Figure 4 Sharing window. 

8. Check the Share this item and its contents 
checkbox. 

9. Specify the access privileges for the remote 
workgroup members using the remaining 
settings as necessary. 

10. Close the Sharing window. 

• System 7's built-in file sharing capability 
is covered in-depth in Chapter Seven: 
File Sharing, beginning on page 53. 
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11. Provide the rest of the workgroup with in-
structions on how to perform the update. 

Remote workgroup members on the local area 
network can access the System 7 CD-ROM with the 
following set of steps. (Note: more complete in
formation about System 7's file sharing features 
and capability is provided in Chapter Seven: File 
Sharing, beginning on page 53.) 

1. Select the Chooser item from the Apple 
menu. The Chooser window will appear. 

2. Select the AppleShare icon within the 
Chooser window. 

3. Select the file server or shared disk you want 
to use from the scrolling list in the right pan
el of the Chooser window. 

4. Click the OK button. The User Identification 
dialog box will be displayed. 

5. Click the Guest radio button if you are not a 
registered user and proceed to step 7. 

• If the Guest radio button is dimmed, 
guests are not permitted access to this 
computer or server. 

6. Click Registered User radio button, enter 
your user name, and your password. 

7. Click the OK button. A list of available 
shared disks and file servers will appear. 

8. Select the System 7 CD-ROM item from the 
scrolling list. 

9. Click the OK button. The System 7 CD-ROM 
will be mounted and its icon will appear on 
your desktop. 

10. Follow steps 3 through 10 in the Upgrading 
Your Local Macintosh from the CD-ROM sec
tion beginning on page 19. 
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Licensing and Support 

Page24 

Purchase of the System 7 Group Upgrade Kit en
titles you to install System 7 on any number of 
machines at a single site. Apple defines a "single 
site" as any location in the same organization 
within a 25 mile radius. 

Although Apple supports any number of ma
chines with the System 7 Group Upgrade Kit, 
only two people can access Apple's telephone 
support per Group Upgrade Kit. 

Apple's System 7 telephone support group is sur
prisingly knowledgeable and very helpful. The 
level of support and information provided by the 
representatives is well worth the price of either 
upgrade kit. 
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CHAPTER THREE 

The Intelligent System Folder 

If you've been using a Macintosh for more than 
a year you probably have not-so-fond memories 
of the infamous rat-nest System Folder. Thank
fully, much of that clutter has finally been orga
nized with System 7's intelligent System Folder. 

Drag anything that belongs in the System Fold
er-fonts, sounds, desk accessories, system ex
tensions, etc.-onto the System Folder icon 
within a Finder window, and chances are it will 
be automatically placed where it belongs. Or at 
least where it can't do any harm. 

This is a much more powerful concept than it ap
pears on first thought. Once you see it work, 
you'll wonder why it wasn't always like this. Es
pecially for beginners, this is one of the best new 
features of System 7. 

This chapter offers a strategy for dealing with
and sometimes working around-System 7's in
telligent System Folder. 

Most of the time System 7 does the right thing 
and places items appropriately within the Sys
tem folder as long as you remember to drag the 
item to the System Folder icon, not the System 
Folder window. 
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Installing system extensions, sounds, and con
trol panels is completely automated and works 
flawlessly. Figure S shows a minimal System 
Folder with callout text indicating what goes 
where within the new operating system. 

10 ;terns 18.7MB in disk 

Applications, docu
ments, and folders 
contained in the --t---~ 
Apple menu App le(,;,;M.-e""'"n...,u ... ltems 

Contents of Clipboara-+----------fi~J::~t'@l 

Individual control panelst----f'!iir:w:• Clipboard 

Printer drivers, startup Contro 1 panels 
documents, PostScript +----------+~ 
fonts, network connect
ions, and other system 
extensions 

Extensions I ' 

Preferences and aux- Finder 
iliary files for individual-+--------~ 
applications 

~ 
Preferences 

Scrapbook File Applications, docu
ments, and folders 
to be automatically:----t-------~~.J::.l~s;J 
opened at startup 

Fonts, sounds, and 
miscellaneous syste 
resources 

Spooled documents 
waiting to be printed 
in the background 

Figure 5 

PrintMon;tor Documents ..!} 

System l's System Folder. 

You can override the System Folder's intelligence 
by opening the folder and manually placing 
items where you want them within the System 
Folder window. 
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System File 

The System file behaves differently than any oth
er Macintosh file. In addition to containing 
needed system resources for the operation of the 
Macintosh, it also acts as a sort of folder for fonts, 
sounds, and localized international system re
sources (keyboard layouts and language scripts). 
You can open the System File, like a folder, by 
double-clicking on it. 

Figure 6 shows a minimal System file that has 
been opened. 

Ll9 items 17.9 MB in disk 

~ 
~ 

~ 
Chioago Monaoo 

~ (i Geneva 

(i New York Indigo 

(i (i Droplet 

(i Quaok Wild Eep 

Sosumi .lJ 
¢ ¢ IIi 

Figure 6 Opened System File. 

When you drag fonts or sound files onto the Sys-
tem Folder icon, they are automatically placed 
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within the System file. Alternatively, you can 
drag fonts and sound files directly onto the Sys
tem File or window. To remove fonts and sounds 
from your System file, select them and drag them 
to the trash. 

The only limitation to opening the System file is 
that the Finder must be the only active applica
tion when you do so. System 7 prevents you 
from moving items into or out of the System file 
if other programs are open. In addition, fonts 
cannot be renamed. 

Like a set of interlocking boxes, fonts and sound 
files can also be opened by double-clicking on 
them. Opening a TrueType font displays a typog
raphy sample in a window like the one for Gene
va shown in Figure 7. 

'=IW ~ Geneuo 
, ... 9 point ........................................................................................... , 

! How razorback-jumping frogs can level six ! 
! piqued gymnasts ! i 
i._,,, .......... - ....... ,_ ........ -....... - ...... _________ , ..................................... i 
, ... 12 point ...... - ................ - ............................................. - ........ , 

I How razorback-jumping frogs can I 
! level six piqued gymnasts! ! 
!... ......................................................................................................... ...! 
r-· 1 8 point ..................................................................... ................... ) 

I How razorback-jumping i 
. I 

I frogs can level six ! 
I piqued gymnasts! I 
i i 
• I 
!.. ........................................................................................................... J 
To use this font, drag it into your S\jstem file. 

Figure 7 Open TrueType font. 

When fonts are installed in the System file they 
become available in all software applications 
that let you select fonts . 
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System 7 font issues are covered more complete
ly in Chapter Four: Fonts And System 7, begin
ning on page 33. 

Opening a sound file causes the sound to be 
played through the Macintosh speaker. When a 
sound is installed in the System file it becomes 
available as a system alert sound via the Sound 
control panel. These sounds are not the same for
mat as HyperCard sounds and cannot be used 
within that environment. 

Apple Menu Items Folder 

The Apple Menu Items folder is useful as a repos
itory for virtually any item you use often-appli
cations, documents, or folders. In addition, desk 
accessories also live in the Apple Menu Items 
folder, as shown in Figure 8. 

Folders 

Rapid Referentes 
0!1 Strapbook 

------j111fl TouthBRSE 
Applications CJ wort In Progress 

FigureS Apple menu. 

Items stored within this folder appear on the Ap
ple menu. You do not have to restart your Mac
intosh for the items to appear; the Apple menu is 
updated automatically whenever items are add
ed or removed. 
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Selecting an item from the Apple menu has the 
same effect as opening the item in the Finder. 

Control Panels Folder 

14 items 

¢1 
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The Control Panels folder, shown in Figure 9, 
serves as a container for items that give you con
trol over your system's appearance. 

Control Panels [II~ 
17.8MB in disk 101.6 MB available 

• . 

'4 

Keyboard 

• ' 

-
Monitors 

Startup Disk 

Views 

Figure 9 Control Panels folder. 

The Control Panels folder can also contain spe
cialized control panels that add functionality to 
the basic system software during startup. 
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Extensions Folder 

rl, 
lml 
L!:-:..1 

The Extensions folder contains system exten
sions that provide additional functionality. 
Printer drivers, PostScript printer fonts, the 
PrintMonitor program, network device drivers, 
and networking extensions are examples of the 
items found in the Extensions folder. 

To use an extension, you simply drag it onto the 
System Folder icon (not the System Folder win
dow) and restart your Macintosh. The extension 
will be automatically loaded or made available 
during the startup process. 

Adobe Type Manager and some applications can
not locate PostScript printer fonts in the Exten
sions folder. If you experience problems 
accessing PostScript printer fonts, take them out 
of the Extensions folder and place them loose in 
the System Folder. Better yet, get Suitcase II to 
manage your PostScript fontsi then you can put 
them anywhere. (Fifth Generation Systems Inc., 
10049 North Reiger Road, Baton Rouge, LA 
70809. Phone 800/873-4384 or 504/291-7221; 
fax 504/295-3268.) 

Startup Items Folder 

The Startup Items folder holds all the items that 
you want to be automatically opened when you 
start your Macintosh. Any application, docu
ment, desk accessory, or control panel that you 
put in the Startup Items folder will be opened 
when you start your Macintosh. 

Applications and documents (or their aliases) 
contained within the Startup Items folder are 
loaded in alphabetical order. They are followed 
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by desk accessories, control panels, and folders 
(or their aliases), again in alphabetical order. 

The key to managing memory effectively on the 
Macintosh is to load the items that you are likely 
to use the most first. This strategy allows you to 
quit lesser used applications or desk accessories 
and load new ones without having to constantly 
monitor memory fragmentation. 

You can alter the loading sequence of items in 
the Startup Items folder by renaming them or 
adding prefix characters, forcing certain items to 
load before others. 

Preferences Folder 

Page 32 

Preference settings from your applications are 
stored in the Preferences folder. When you in
stall System 7, four preference files are automati
cally placed in the Preferences folder: DAL 
Preferences (settings for Data Access Language
compliant databases); File Sharing Folder (access 
privilege information); Finder Preferences (set
tings for Finder attributes); and Users & Groups 
Data File (user name and privilege information 
for registered users and groups you have de
fined). 

Some applications may also store a Last Edition 
Used alias within the Preferences folder. This file 
is updated each time an edition is created or 
changed when using the Publish and Subscribe 
features of System 7. 
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CHAPTER FOUR 

fonts And System 7 

Typography is one of the most widely misunder
stood topics in the Macintosh community. Apple 
Computer has been of very little help in this 
matter, having consistently underestimated the 
importance of effective typography within the 
desktop computing environment. In the short 
history of the Macintosh and desktop publish
ing, Apple has almost single-handedly managed 
to cloud the issues beyond the point of chaos. 

In this book, the terms font and typeface are used 
interchangeably. I know it's wrong, but it's the 
way Apple started things. Changing now would 
only cause even more confusion. 

Adobe Type Manager 

Adobe Type Manager (ATM) allows PostScript 
Type 1 fonts to be rendered automatically for 
screen display. Installing any single size of any 
Type 1 PostScript font and ATM allows any type 
size to be rendered automatically. In September 
1991 Apple and Adobe announced that ATM 
would be folded into future versions of the Mac
intosh operating system. 
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PostScript Level 2 

True Type 
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In 1990, Adobe Systems released the specifica
tions for PostScript Level2. It incorporates ATM 
and features better color calibration between dis
play and output devices, and better screen angles 
for halftones and color separations. File com
pression and improved memory management 
are also built-in components of the latest version 
of PostScript. 

In 1987, Apple began work on a new font format 
that would be an extension to QuickDraw. This 
project evolved into what we now recognize as 
TrueType. At the same time Microsoft was work
ing on a new imaging model for Windows, 
known as Trueimage. In 1989, Apple and Mi
crosoft swapped technologies resulting in Ap
ple's release of True Type fonts. Microsoft threw 
in the towel on the Truelmage page description 
language in the late spring of 1991. 

The TrueType hinting techniques include all the 
information in the font outlines required to op
timize the font at any resolution. PostScript hint
ing, in comparison, is minimal because most of 
the optimizing is done in the printer's Raster Im
age Processor (RIP). 

TrueType allows the weight of any font to be ad
justed, making it legible at smaller sizes. Con
versely, as a larger size is specified, TrueType 
thins the weight, making it more elegant. This is 
known as optical scaling, and many believe Ado
be will add the feature to future versions of the 
PostScript font specification. 

\ 
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Adobe Multiple Master 

Adobe's answer to the optical scaling feature of 
TrueType is the Multiple Master series of type
faces. Due in the first quarter of 1992, Multiple 
Master typefaces will allow you to create virtual
ly instantaneous variations of a single typeface. 
The Multiple Master typefaces contain defini
tions for weight, width, style, and size. 

A Multiple Master font can be scaled along a 
specified axis, allowing faces in the same font 
family to be combined to create completely new 
typefaces. For example, a bold condensed face 
could be combined with a bold expanded face to 
create any weight in between. 

What You Need to Know 

If you already own a PostScript printer, or if your 
service bureau offers PostScript output on an im
agesetter, the best solution is to stay as far away 
from True Type as possible. If you're shopping for 
a printer, get PostScript. Even though most appli
cations fully support True Type, your best bet is to 
avoid it if you can use PostScript. 

A PostScript device will try desperately not to 
have to deal with True Type and the True Type ras
terizer is designed to be re-downloaded to the 
PostScript output device each time a new page is 
imaged. This results in dreadfully slow output on 
PostScript devices and as of early 1992, most ser
vice bureaus were refusing to run TrueType jobs. 
True Type may be free, but it's more trouble than 
it's worth. 

If you're running System 7 .0, remove the True
Type versions of any PostScript fonts in your Sys-
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tern file (usually Courier, Helvetica, Times, and 
Palatino) and replace them with the PostScript 
equivalents. Adobe Type Manager gives you all 
the advantages of first-generation True Type with 
none of the headaches. 

If you use a lot of fonts, one of the best purchases 
you can make is Fifth Generation's Suitcase II at 
a street price of about $50. Suitcase II allows you 
to control your font collection and place your 
screen fonts and printer fonts virtually anywhere 
on your hard disk drive. (Fifth Generation Sys
tems Inc., 10049 North Reiger Road, Baton 
Rouge, LA 70809. Phone 800/225-2775 or 504/ 
291-7221; fax 504/295-3268.) 

TrueType is quickly developing into little more 
than a nuisance in the Macintosh world. Apple 
chief executive john Sculley didn't even bother 
to mention the built-in TrueType rasterizer in the 
company's new printers when they were intro
duced in early October 1991. 
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CHAPTER FIVE 

The New finder 

The New Finder 

The Finder is the aspect of Macintosh System 
software that we most closely associate with 
11Macintosh-ness." Actually, the Finder is a Mac
intosh application, albeit a very specialized one. 
The Finder has come to embody what we call the 
Macintosh user interface with its familiar icons, 
windows, and menus. It's also the part of System 
7 that visually differentiates it from earlier ver
sions of System software. Until System 7 there 
were no major features added to the Finder since 
MultiFinder in 1987. 

System software versions prior to System 7 used 
an invisible Desktop file to keep track of icons 
and their positions. Because the Desktop file re
lied on the Resource Manager there were prob
lems with a large number of resources resulting 
in slow and unreliable operation. 

Finder 7.0 uses the same technology employed 
in AppleShare, dividing desktop management 
tasks between two files: Desktop DF and Desktop 
DB. Speed and reliability of file handling opera
tions is much improved. 

If you have a color monitor, one of the first 
things you'll notice about System 7 is support for 
color windows and icons on the desktop. 
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Custom Views 

~ 

I> 
I> 

I> 

~ 

() Clipboard 

The various list views available in the new Finder 
make it easier for you to see the hierarchical 
structure of your workspace. 

A triangle is displayed next to each folder in all 
list views. This triangle provides a visual cue as to 
the state of the outline view. It also acts as a tog
gle switch between the collapsed and expanded 
outline states. 

Figure 10 shows a Finder window in both col
lapsed a~d expanded outline views. 

Cl CD Remote Programs 

V Cl Claris 

[) Claris Fonts 

CJ Contro 1 Panels [) Claris Help System 

CJ DataViz 1> CJ Claris Translators 

() Day Maker Alarm Data ~ Cl FileMaker Temp 

CJ Day Maker Print Formats ... [) Clipboard 

() Disinfectant Prefs I> D Contro 1 Pane 1s 

Cl Encry ptors ~ Cl DataViz 

Figure 10 Collapsed (left) and expanded (right) 
outline views. 

To expand an outline view, click on the right
pointing triangle icon next to the folder you 
want to expand. To collapse an outline view, 
click on the down-pointing triangle icon. 

The most important aspect of the new outline 
view folder structure is that you can now select 
multiple items from several folders within the 
same window simultaneously. This makes work
ing with files in various sub-folders much easier. 
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Another new feature of System 7 is that a selec
tion rectangle can be used to select multiple 
items in any Finder view. 

The Views control panel, shown in Figure 11, can 
be used to customize how items are displayed 
within Finder windows. 

Uiews 

Font for views : ~G_en_e_u_a _______ •~l lmll~ 

ri;I; ~:.:;:;::;.::.ld ~~~~,~.,: :"~··~~~;·::! 
, .... List Vie'lll's ............................................................................................................................... , 

I ~ ~ ~ [8l Show size ~ 
~ ~ [8l Show kind ~ 
1 @ 0 0 [8l Show label 1 
l [8l Show date l 
l 0 Calculate folder sizes 0 Show version l 
1 0 Show disk info in header 0 Show comments 1 
~ ............................................................................................................................................................ 1 

The New Finder 

Figure 7 7 Views control panel. 

You can sort a Finder window's contents in any 
list view by clicking on the column head by 
which you want to sort. Clicking on the Type 
column head, for example, sorts the window's 
contents by file type. Similarly, clicking on the 
Size column head sorts the window's contents by 
size, listing the largest files at the top. 

In any of the icon views you can sort a Finder 
window by holding the Option key and selecting 
the Clean Up command from the Special menu. 
The Clean Up command will vary depending on 
which view you used last . 
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Finder Navigation 

=Ill 

When you Command-click on any window title 
within the Finder, a pop-up menu appears, dis
playing the path to that window. 

You can select any point in that path and the ap
propriate window will be opened. This powerful 
navigation feature is shown in Figure 12. 

-- e lllustrationsf 
N a QuarkHPress Rapid Reff 

l====t 
t5l Rapid Referencesf 
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a FrameMaker Files 
a FrameMakerf 
c:J Further 

Figure 12 Finder window navigation menu. 

When you click on any icon in the Finder, the 
window containing the icon will not be brought 
to the front until you release the mouse button. 

This allows you to copy or move multiple items 
from any number of overlapping windows with
in the Finder. 
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Clicking the zoom box of a Finder window caus
es the window to grow to the smallest size need
ed to display all the contents of that folder. In 
previous versions of the Finder, the window 
would grow to the full size of the screen. 

You can scroll any Finder window automatically 
by dragging an item contained within the win
dow to any edge of the window. You can also use 
the Home, End, PgUp, and PgDown keys on the 
extended keyboard to scroll any window within 
the Finder. 

If you have an extended keyboard, get QuicKeys. 
QuicKeys actually lets you use that top row of fif
teen function keys. And a whole lot more. (CE 
Software Inc., 1801 Industrial Circle, P.O. Box 
65580, West Des Moines, lA 50265. Phone 515/ 
224-1995; fax 515/224-4534.) 

You can navigate to and select specific files or 
folders within a Finder window by typing the 
first few letters of its name. Typing a single letter 
will select the first item in the active window 
that begins with that letter. Pressing the Tab key 
advances to the next item in alphabetical order, 
and pressing Shift-Tab selects the previous item 
in alphabetical order. 

The Applications Menu 

The New Finder 

The Application menu is displayed at the ex
treme right of the menu bar and is identified by 
its display of the small icon of the currently ac
tive application. This menu allows you to easily 
navigate between any application that is open 
within your workspace. When you launch an ap
plication its name and small icon are added to 
the Application menu. Figure 13 shows an exam
ple of the Application menu with callout text 
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providing information about its additional fea
tures. 

Hide windows of 
application 

Hide Finder 
Hide Others 

Show windows of all Show Rll 
applications 

• DayMakerTM 

Available app ../I Finder 
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0 FrameMaker 
TouchBRSE 

Figure 7 3 Application menu. 

Two keyboard shortcuts are also available for 
navigating through the Finder's windows: 

• You can hold the Option key as you select an 
available application from the Applications 
menu to automatically hide the windows of 
the current application. 

• You can hold the Option key and click any
where on the desktop to hide all open appli
cation windows. 

As an alternative to navigating through a some
times-complex hierarchy of folders within the 
Finder, you can drag a document on top of an ap
plication icon and it will be opened within that 
application if possible. 

Another alternative is to put aliases of your most 
commonly used documents and applications in
side of the Apple Menu Items folder which itself 
is found within the System Folder. Anything you 
put in this folder will appear on the Apple Menu 
when you pull it down. 

System 7 Rapid Reference 



You can leave your most commonly used appli
cations (or aliases of them; see Aliases beginning 
on page 46) on the desktop and drag document 
icons on top of them. This offers the additional 
benefit of opening documents that are native to 
applications you do not own. 

Dragging a MacWrite document on top of the 
Microsoft Word icon (or alias), for example, will 
automatically convert and open the document 
within Microsoft Word. 

File Finding 

Find: 

For the first time the Macintosh Finder incorpo
rates an integrated file-search function within 
the operating system that offers two levels of 
complexity. 

• The basic Find function looks for file names 
that match the text you specify. 

• The expanded Find function allows you to 
customize the search to include modification 
dates, creation dates, kind, version, label, 
and user comments. 

If you select the Find ... command from the File 
menu within the Finder, the basic Find dialog 
box, shown in Figure 14, will appear. 

( More Choices ) ( Cancel ) ( Find J 

Figure 14 Basic Find dialog box. 
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If you have a pretty good idea of what you're 
looking for, the basic Find dialog box is a quick 
way to locate items that are misplaced or that are 
buried inconveniently deep within the folder hi
erarchy. 

Typing a group of characters in the search field 
and pressing the Find button will search your 
hard disk drive for the first instance of whatever 
you typed. 

When a match is located, the Finder opens the 
window that contains the found item and high
lights it. 

You can click the More Choices button to ex
pand the Find dialog box to display additional 
options, as shown in Figure 15. 

Find find select Items whose 

.._n __ a __ m...;e ____ •_,ll contfllns ·1~------------~ 

Search I on all dlslcs 0 all at once 

----·-------------
(Fewer Choices) Cancel ) ([ Find B 
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Figure 15 Expanded Find dialog box. 

Three pop-up menus are available in the expand
ed Find dialog box to allow you to refine your 
search criteria. 

In addition, the all at once checkbox is avail
able. When checked, it presents all the located 
matches at once rather than one at a time. 

Figure 16 illustrates the three pop-up menus that 
are available within the expanded Find dialog 
box. The name, contains, and search menus are 
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../name 
size 
kind 
label 

shown in their relative position within the ex
panded Find dialog box . 

../contains 
starts with 
ends with 
is 

date created 
date modified 
uersion 
comments 
lock 

is not 
doesn't contain 

../on all disks 

on "Further" 
on "Intrepid" 
on "Cassady" 
on "Sauannah" 

on the desktop 
1 tu~ ~•~h~•~1 (~d U (~rni-

The New Finder 

Figure 16 Expanded Find dialog box pop-up 
menus. 

The file finding functionality built into System 7 
is exceptionally flexible and remarkably effi
cient. When matched items are displayed, you 
can move them as a group by dragging a single 
item (the selected group is a single item). You can 
return them to their original locations by select
ing the Put Away command on the File menu (or 
using the Command-Y keyboard shortcut) with
in the Finder. 
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Background File Copying 

Aliases 

Page46 

System 7 provides you with the ability to copy 
any number of files-in the background-while 
you continue to do other work on the computer. 
The only limitation to this capability is that you 
cannot open an application while the files are 
being copied. 

The key to working within this limitation is a 
simple four step process. 

1. Launch the application or applications that 
you want to use while the background file 
copying is taking place. 

2. Switch out to the Finder. 

3. Start the file copy operation. 

4. Switch back to your application. 

Aliases are simply stand-in icons that represent a 
volume, folder, application, or document. They 
are not copies of the items they represent, but 
rather an actively linked pointer to the actual 
item. Performing an operation on an alias-ex
cept for deleting it-performs the operation on 
the actual file, not the alias. A single file-or even 
an entire hard disk-can have any number of 
aliases located virtually anywhere. 

The biggest advantage of using aliases is that be
cause they take up a minimal amount of storage 
space (no more than 1-3 KBytes) you can keep 
multiple aliases in any number of locations. This 
can help you manage your hard disk drive much 
more efficiently. 
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The New Finder 

You can, for example, put aliases of your most 
commonly used applications in the Apple Menu 
Items folder or out on the desktop. If you have a 
core group of applications that you work with 
most of the time, you can place their aliases in 
the Startup Items folder and the items they rep
resent will be opened automatically each time 
you start your Macintosh. 

Aliases also work across a network. This allows 
you, for example, to double-click on an alias of a 
server to mount the server on your desktop. 

To create an alias, follow these steps. 

1. Select the item. 

2. Select the Make Alias command on the File 
menu within the Finder. 

An alias will be created, as shown in the file serv
er and folder examples shown in Figure 17. 

Figure 17 Alios of a file server. 

Note: the only apparent difference is the itali
cized name and the "alias" suffix. In all other 
ways, the alias works exactly the same as the 
item it represents. 

If you move the original item to another loca
tion, the link between it and the alias will be up
dated automatically. If you throw an alias away, 
only the alias is deleted, not the item the alias 
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represents. This can lead to one of the problems 
inherent in working with aliases: you have to re
member to manually delete any aliases for the 
files you delete. 

What~ Missing? 

Page4B 

As remarkable as System 7 is, there is room for 
improvement. 

1. The Undo command should be more intelli
gent. We should be able to undo renaming a 
file or emptying the trash. 

2. Any comments we create for our files disap
pear when the desktop is rebuilt. 

3. We should be able to drag the menu bar be
tween multiple monitors without having to 
restart. 

4. Typing keys in a Finder window should scroll 
the window with the selected file at the top 
of the list, not the bottom. 

Finally, here's a welcome addition: You can halt 
the execution of some processes by pressing 
Command-Option-Escape. In some cases this 
will let you to cancel a hung process, thereby al
lowing you to save information in other concur
rently running applications. It would be nice to 
see this standardized. 
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CHAPTER SIX 

Virtual Memory 

Virtual Memory 

System 7 supports virtual memory on most of 
the higher-end Madntosh models. You can use 
virtual memory on any Macintosh with a 68030 
processor or a 68020-based Macintosh that is 
also equipped with a Paged Memory Manage
ment unit {PMMU). 

Virtual memory acts to extend the amount of 
available memory by treating part of your hard 
disk drive as an extension to RAM. 

System 7's virtual memory feature works best 
with 4 MBytes or more of RAM, and requires hard 
disk space equivalent to the total memory speci
fied. In other words, a Macintosh with 8 MBytes 
of physical RAM and 8 MBytes of virtual memory 
would require 16 MBytes of hard disk drive 
space. It's a trade-off you may find appropriate; I 
can't afford to give up that much hard disk drive 
real estate. 

Although you can specify almost any amount of 
available hard disk space for use as virtual mem
ory on 32-bit clean Macintosh models, you 
shouldn't attempt more than twice the physical 
RAM you have installed in your Macintosh. Mac
intosh models that are not 32-bit clean are limit
ed to a total of 14 MBytes of virtual memory 
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minus 1 MByte for each installed NuBus card. For 
information on physical memory, refer to A 
Crash Course In Memory beginning on page 2. 

You can use the Memory control panel to man
age virtual memory with these steps. 

1. Select the Control Panels item from the Ap
ple menu. The Control Panels folder will be 
displayed. 

2. Double-click on the Memory control panel 
within the Control Panels folder to open it, 
as shown in Figure 18. 

Memory 

Ill[~. Disk Caeht 
~,;~ Always On 

Virtual Mtmory 

Oon 
®off 

St ltet Hard Disk : 

~11tH~r --;-1 
A nilab lt on disk : 1 25M 

Anilablt built-in momory : 20M 

-··-·--------·-·------- ---·---.. · .. -·-·---.. -

v7.0 .1 

."', lml 
1.!;_~ 
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32-Bit Addrtssing 

®en 
Qoff 

( Use Defaults ) 

Figure 7 8 Memory control panel. 

If your Macintosh does not support virtual mem
ory, the settings assodated with it will not ap
pear in the Memory control panel. In those 
Macintoshes that do not support virtual memo
ry, only the Disk Cache portion of the Memory 
control panel will appear. 

3. To turn on virtual memory click the Virtual 
Memory On radio button in the left-center 
portion of the Memory control panel. The 
control panel display will be updated to re-
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Hard disk drive 
to be used for 
virtual memory 

fleet the new setting, similar to the example 
shown in Figure 19. 

Memo 

C•cho Slzt 

Hard disk drive 
space available for 
v1rtual memory lr::--"Virl...u~tr.!L_] 

Available physicaL-J._!!!!.--ftt~--
RAM 

Total memory 
available 

Virtual Memory 

v7 .0 .1 
[ Use Defaults J 

Figure 19 Memory control panel with virtual 
memory enabled. 

4. Select the hard disk drive to be used for virtu
al memory from the pop-up menu. 

5. Adjust the total amount of memory to be 
available with the arrow buttons. 

• The total memory available-physical 
RAM plus virtual memory-cannot ex
ceed 14 MBytes unless you turn on the 
32-bit Addressing radio button. 

6. Close the Memory control panel. 

7. Restart your Macintosh. 

System 7's virtual memory feature is most appro
priately used only in circumstances that would 
cause you to run out of physical memory. If you 
find yourself using the maximum virtual memo
ry available most of the time, you would do well 
to invest in more physical RAM. 

You can see how much memory you are using by 
selecting the About This Macintosh command 
from the Apple menu from within the Finder. 
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~~~~ 

The About This Macintosh window, shown in 
Figure 20, will be displayed. 

Rbout This Macintosh 

Sgst~m Software 7 .0.1 • 

~ Macintosh llci ® Apple Computer 1 Inc. 1983-1991 

Total Memorg : 20 1480K Largest Unused Block: 10,632K 

8 Da~:JMaker'IM 11500K -'~4:'iiic'W! Q. 
0 FrameMaker S,OOOK i?~ 

~ System Software 3 1029K .. ~ 
!I TouchBASE 

if, 
lml 
1::-=.1 
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20K I ~ 
ml 

Figure 20 About This Macintosh window. 

Be careful using virtual memory. My experience 
has been that it can cause more problems than it 
is worth in many situations. Some software pro
grams, for example, create their own virtual 
memory disk files. Performance in these instanc
es can be degraded if these programs cannot cre
ate this virtual file because you have set System 
7's virtual memory too high. 

Try to use the fastest hard drive you can for the 
virtual memory swap file. Also, be aware that the 
drive space you allocate for virtual memory can
not be on a removable hard disk. 
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CHAPTER SEVEN 

File Sharing 

File Sharing 

The file sharing capabilities built into System 7 
allow you to share files, folders, and whole disks 
with other people whose computers are connect
ed with yours on a network. You can use System 
7's file sharing to share disks, a selection of files, 
or only the files in a particular folder with just 
one other person, a subset of your workgroup, or 
the entire workgroup. 

System 7's file sharing is not meant to be are
placement for AppleShare file service because of 
four basic deficiencies: 

• A total of only 10 users can be logged on at 
any one time. 

• A practical limit of 50 users can be defined. 

• Only 10 volumes or folders can be shared. 

• There is no way to remotely manage or alter 
access privileges. 

Many small workgroups, however, will find that 
System 7's file sharing capabilities are perfectly 
adequate for their needs. 

You use a number of control panels to initiate 
and manage file sharing on your Macintosh and 
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you access shared files on other Macintoshes 
through the Chooser. 

Starting File Sharing 

Before you can share your files with other mem
bers of your workgroup, you have to identify 
yourself and your Macintosh to the network and 
turn on File Sharing. 

1. Select the Control Panels item from the Ap
ple menu. The Control Panels folder will be 
displayed. 

2. Double-click on the Sharing Setup control 
panel within the Control Panels folder to 
open it, as shown in Figure 21. 

Sharin Setup 

11;1 Network Identity 

Owner Name: ~~~··~·~'~1111111111111 
Owner Pas sword : I••••• 

~====~------------~ Macintosh Name: IL..M.;.;;.ac.;;..;.in...;..;to.;;..;.s.;..h.;..llc..;..;.i _________ -J 

ffJ] File Sharing 
r···Status ................................................................................................ ~ 

( Start ) ! File sharing is off. Click Start to allow other users 1 

L~~ .. ~.?.~.~~.~ .. ~~-~~.~~ .. ~~-~~.~~.~: ........................................................... ..i 

~ Progr11m linking 
, .... status ................................................................................................ , 
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( Start ) j Program l_inking is off. Click Start to allow other j 
L~~~~ .. ~~ .. ~.~~~ .. ~~ .. ~.?.~.~ ... ~~.~~.~~ .. ~!.:~.~~~~~.:. ..... _. ... ._ ........... J 

Figure 21 Sharing Setup control panel. 

3. Enter the name you want to be identified to 
the network as in the Owner Name field. 
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4. Enter a unique password in the Owner Pass
word field. 

5. Enter a name for your Macintosh in the Mac-
intosh name field. 

6. Click the File Sharing Start button. 

7. Close the Sharing Setup control panel. 

Your Macintosh is now accessible to other work
group members on the network. 

At this point you can elect to share your files 
with anyone on the network, or you can define a 
set of users and groups to manage various levels 
of access to your files. Most workgroups will opt 
for the latter alternative. 

Defining Users & Groups 

File Sharing 

By defining a set of users and groups for file shar
ing activities, you retain control over access to 
the material you choose to share with the rest of 
your workgroup. 

Apple's file sharing features within System 7 offer 
very limited security. This may be a problem 
within some organizations. If the files on your 
Macintosh are confidential, you should seriously 
consider not using System 7's file sharing. It may 
look secure, but it's not. 

You manage access to your files by setting access 
privileges that control which workgroup mem
bers have access to which of your files, folders, 
and disk. 

You can define a set of users by repeating these 
steps for each user. 

1. Select the Control Panels item from the Ap
ple menu. 
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Registered user 

User's nam p 

2. Double-click on the Users & Groups control 
panel to open it, as shown in Figure 22. 

Figure 22 Users & Croups control panel. 

3. Select the New User command on the File 
menu to define a new user. 

4. Rename the new user icon appropriately. 

S. Double-click on the user icon to open it as 
shown in the example in Figure 23. 

F-r.r~ Karen Fraase 

User's conn ection passworrl Us•r Password : h illi I 

User conne ction control 
LJ File Sharing 
.~ 

~ Allow unr to oonnf'Ot 

ordcontro~ User passw 
!....--- 0 "11•" ustr to chon<)t puswor d 

Groups con 
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Groups: 

taining user 
"'u& Foreu 
Doeumtnl•llon 

~ 

~ 

~ Program linking 

0 Allo-w ustr lo lit* to progr oms 
on this Hoeintosh 

Figure 23 Opened user window. 

6. Assign a password for the user in the User 
Password field. 
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7. Check the Allow user to connect checkbox 
to allow the user to connect to your Macin
tosh. Uncheck the checkbox if you wish to 
restrict the user from all access. 

8. Check the Allow user to change password 
checkbox to allow the user to change his or 
her password. Uncheck the checkbox if you 
wish to prevent the user from changing the 
password. 

9. Close the user's window. 

10. Click the Save button to save the changes 
you made to this user. 

Defining Groups 

File Sharing 

If your organization is comprised of groups of 
people who work collaboratively and share a 
need for access to the same information, you can 
define a group of users with the same access priv
ileges for your shared files. 

You can define a set of groups by repeating these 
steps for each group you want to create. 

1. Select the Control Panels item from the Ap
ple menu. The Control Panels folder will be 
displayed. 

2. Double-dick on the Users & Groups control 
panel to open it, as shown in Figure 22 on 
page 56. 

3. Select the New Group command on the File 
menu to define a new group. 

4. Rename the new group icon appropriately. 

5. Drag the user icon of each workgroup mem
ber you want to include within the group to 
the group's icon. 
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6. Double-click on the group icon to open it as 
shown in the example in Figure 24. 

MichaelFraase ~ 

Figure 24 Opened group window. 

You can open any user icon within the opened 
group window by double-clicking on it. 

You don't need to add your own user icon to any 
group you define because as the Macintosh's 
owner, the entire contents of the computer are 
accessible to you from any point on the network. 
Similarly, you don't need to add the <Guest> user 
icon to any group you create. 

You can remove group members from any group 
at any time with these steps. 

1. Open the group icon within the Users & 
Groups control panel 

2. Drag the member icons to the trash. 

Setting Access Privileges 
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The idea of making volumes and files available to 
other workgroup members can be a little intimi
dating to some people. Specifying the access priv
ileges for your disks and folders allows you to 
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maintain control over which volumes, folders, 
and files are available to other workgroup mem
bers. 

Every folder on each volume can be assigned an 
Owner, a Group, and a collection of settings that 
allow the Owner to control which folders and 
files are available to other individuals or work
group members. 

Settings are available to prevent anyone from 
even seeing selected folders and their contents, 
let alone accessing them. 

Figure 25 illustrates the access privilege settings 
for the FrameMakerf folder residing on the Sa
vannah shared volume. 

FrameMakerf 

i;wJ Yben: Savannah: 

:~f~~Mt:~ Connected As: M;chael Fraase 

Privileges: See Folders, See FUes, Make Changes 

[."J Same as enc los;ng folder See See Make 
Folders Files Changes 

, .............................................. . 
Owner: ! Karen Fr aase ! t81 : ........................•..................... ., 

, .............................................. . 
User /Group : l.~:..~.~ .. ~ .. ~.~r.?.~.~ ............ J ~ 

Every one t81 
[."J Make all currently enclosed folders Uke this one 

[.] Can't be moved, renamed or deleted 

Figure 25 Access privileges for a shored folder. 

File Shoring 

To set the access privileges for your own volumes 
and folders, use these steps. 
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Shared 
name 

Shared 
location 

Access 
privin:::y•c;,_--1 
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1. Select the volume or folder that you want to 
share within the Finder. 

2. Select the Sharing ... command from the File 
menu. The Access Privileges window for the 
selected item, like the example shown in Fig
ure 26, will appear. 

-::::::-e~~iiini!Ctl!d As: Michael Fraase 
See Folders, See Files, Make Changes 

D Same as enclosing folder See See 
Folders Files 

Owner : 181 181 
User/Group : jArts & Farces I 181 181 

Everyone 181 D 
181 Make all currently enclosed folders like this one 

181 Can't be moved, renamed or deleted 

Figure 26 Access Privileges window. 

Make 
Changes 

181 
181 
181 

3. Check the Share this item and its contents 
checkbox. 

4. Select a user or a group from the User/Group 
pop-up menu. 

• the User/Group pop-up menu contains 
the names of each user and group you 
have created. 

• You can select only one of the items on 
the pop-up menu. 

• If you find that you need more flexibility, 
you can create more restrictive groups. 

5. Uncheck all three checkboxes in the bottom 
row (the Everyone privileges) if you want to 
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prevent anyone other than the user or group 
you have specified to have access to the item. 

• Refer to Figure 27-Figure 29 for informa
tion about the effects of the various ac
cess privilege settings. 

6. Close the Access Privileges window. 

7. Click the Save button to save the changes 
you made to this disk or folder. 

Access Privilege Effect 

See Folders 

See Files 

Make Changes 

Make all currently 
enclosed folders 
like this one 

Can't be moved, 
renamed or 
deleted 

Checked: shows folders 
Unchecked: hides folders 

Checked: shows files in folder 
Unchecked: hides files in folder 

Checked: designated user can copy, 
delete, or save files 
Unchecked: prevents designated users 
from copying, deleting, or saving files 

Checked: assigns the enclosing folder's 
access privileges to folders that have 
been moved into it 
Unchecked: retains the original access 
privilege settings assigned to the items 
within the enclosing folder 

Checked: prevents anyone from mov
ing, renaming, or deleting this folder 
Unchecked: allows anyone with a high 
enough access level to move, rename, 
or delete this folder and its contents 

Figure 2 7 Access privilege settings. 

File Sharing 

Once the access privileges have been set, they 
provide visual cues that are immediately appar
ent to everyone accessing the shared folders 
across the network. 
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The icons that represent the shared folders reflect 
the state of the access privileges that have been 
assigned to them. You can tell at a glance, for in
stance, which folders on someone else's disk you 
have access to and which folders are inaccessible 
to you (even though you can see them). 

The table in Figure 28 provides a quick reference 
to shared folder icons as they appear to a work
group member across the network. 

Icon Description 

D 
Tabbed folder 

[J 
Pla;n folder 

[I] 
Not access;b le 

(]j 
Drop folder 
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Seen by the owner of the folder who also 
controls access to it 

Seen by all workgroup members who have 
some level of access to this folder 

Seen by all workgroup members who can
not see files or make changes to this folder's 
contents 

Seen by all workgroup members who can
not open the folder but can copy files and 
folders into it 

Figure 28 Shared folder Icons. 

Figure 29 provides a quick visual reference to the 
access privilege settings required to obtain the re
sults shown the table in Figure 28. Each access 
privilege setting is accompanied by the folder 
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icon that appears to workgroup members across 
the network. 

D Same as enclosing folder See See Make 

D 
Folders Files Changes 

Owner: I Michael Fraase""' ~ 181 181 181 
Tabbed folder User /Group: I Arts & Farces ""' ~ 181 181 D 

Everyone D D D 

D Same as enclosing folder See See Make 

[J 
Folders Files Changes 

Owner: I Karen Fraase .... ~ 181 181 181 
Plain folder User /Group: I Michael Fraase""' ~ 181 181 181 

Everyone 181 D D 

D Same as enclosing folder See See Make 

[I] 
Folders Files Changes 

Owner: I Karen Fraast .... ~ 181 181 181 
Not acces:sib le User /Group: I Michael Fraase""' ~ D D D 

Everyone D D D 

(]j 
0 Same as enclosing folder See See Make 

Folders Files Changes 

Owner: I Karen Fraase .... ~ 181 181 181 
Drop folder User /Group: I Michael Fraase""' ~ D D 181 

Everyone D D D 

Flgure29 Access privilege settings for Figure 28. 

Access Privilege Examples 

File Shoring 

You can control network access to the files and 
folders on your Macintosh by granting specific 
access privileges to certain users within your 
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workgroup. Regardless of any access privileges 
you may grant to other workgroup members, 
you retain complete access to your computer and 
everything on it across the network. 

Drop Folder 

A drop folder is a private repository that other 
workgroup members can use to deposit files or 
folders within your workspace without being 
able to see, change, or delete the contents. 

Drop folders are useful within a workgroup envi
ronment and can even be used as a substitute for 
electronic mail in very small networks. 

The access privilege settings for a public drop 
folder (everyone on the network-including 
guests, if allowed-can deposit files or folders 
within it but are prevented from seeing the fold
er's contents) are shown in Figure 30. 

D Same as enc los;ng folder See See Make 
Folders Fnes Changes 

Owner: I Karen Fr aase ... ~ 181 181 181 
User /Group: I Arts & Farces ,.. I D D r8l 
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Everyone D D 181 

Figure 30 Public drop folder access privileges. 

Private Folder 

If you're sharing one or more folders on your 
hard disk drive across the network, you may find 
a need for a private folder-one that is accessible 
only to you. 
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The access privilege settings shown in Figure 31 
can be used to prevent anyone else on the net
work from opening or even seeing the folder or 
its contents. 

D Same as enclosing folder See See Make 
Folders Files Changes 

Owner: I Karen Fraase ·~ 181 181 181 
User /Group: I Michae 1 Fr aase • ~ D D D 

File Sharing 

Everyone D D D 

Figure 31 Private folder access privileges. 

Bulletin Board 

You can define the access privileges for a folder 
(or several folders) to create a bulletin board on 
your network. Setting up a bulletin board folder 
allows anyone with access to the network to 
open and read any file placed within the folder, 
but prevents anyone except the owner from 
changing any of the files. 

Potentially useful variations of the bulletin 
board access privileges are easy to implement. 

• You can, for example, define several folders 
with different topic or project headings for 
specialized uses. 

• Another variation might be to limit access to 
a workgroup-based bulletin board folder to 
only those workgroup members who have a 
direct need for the information contained in 
the folder. 

Figure 32 shows the access privileges for a public 
bulletin board folder. Everyone on the network 
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can open and read any file within the folder, but 
only the owner can make changes. 

D Same as eno losing folder See See Make 
Folders Files Changes 

Owner: I Karen Fr aase ... I 181 181 181 
User /Group: I <None> ... I 181 181 D 

Everyone 181 181 D 

Figure 32 Public bulletin board access privileges. 

Figure 33 shows the access privileges for a bulle
tin board folder that is available only to regis
tered users of the "Arts & Farces" group. 

D Same as eno losing folder See See Make 
Folders Files Changes 

Owner: I Michael Fraase ..-~ 181 181 181 
User /Group : I Arts & F aroes ..- ~ 181 181 D 
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Everyone D D D 

Figure 33 Workgroup bulletin board folder access 
privileges. 

Workgroup Folder 

You may find it appropriate to share certain fold
ers on your hard disk drive with the members of 
a single registered group. You can accomplish 
this by creating a workgroup folder. 

Figure 34 shows the access privilege settings for a 
folder that is completely accessible to registered 
users of the "Arts & Farces" group and invisible 
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and completely inaccessible to anyone else on 
the network. 

D Same as enclosing folder See See Make 
Folders FHes Changes 

Owner: I Karen Fraase ..,~ 181 181 181 
User /Group: I Arts & Farces .., ~ [8] [8] [8] 

Everyone D D D 

Figure 34 Workgroup folder access privileges. 

Accessing Shared Folders 

File Sharing 

System 7's file sharing capabilities allow you to 
access shared folders and volumes across a net
work. These shared resources can belong to any 
workgroup member who has granted you access 
to their workspace. 

Network etiquette demands that you use com
mon sense when accessing shared folders and 
volumes on a remote computer's hard disk drive. 
It is not polite, for example, to transfer huge 
amounts of files when the owner of the shared 
resources is attempting to get work done. 

It's a good idea to ask permission from the owner 
if you need to grab an abnormally large file (or a 
lot of relatively smaller ones). Both network and 
computer performance can be severely degraded 
if everyone's copying big files back and forth. 

You can follow these steps to connect to a shared 
disk across an AppleTalk network. 

1. Select the Chooser item from the Apple 
menu. The Chooser window will be opened 
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Printer 
icon 

Selectio 
list 

and will appear similar to the example 
shown in Figure 35. 

Figure 35 Chooser window. 

2. Select the AppleShare icon. A scrolling list of 
available computers will appear in the right 
panel of the Chooser window, as shown in 
Figure 36. 

~ 
Select 11 file server: 

L•strWrl\tr 

t-::- A lTlk @Active 
L--_________ ___L<;~ PP e 11 0 lmscti ve 

7.1 

Figure 36 Available computers. 
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3. Select the name of the computer with the 
shared folders or disks you want to use from 
the scrolling list in the right panel of the 
Chooser window. 

4. Click the OK button. The User Identification 
dialog box, similar to the one shown in Fig
ure 3 7, will be displayed. 

Connect to the file seruer "Macintosh SE/30" 
as: 

File Sharing 

0 Guest 
® Registered User 

Nome: I Michael Froose 

Password: 1••••••••1 (Two-way Scrambled) 

Cancel (Set Password] n OK D 
v7.0 

Figure 37 User Identification dialog box. 

5. Click the Guest radio button if you are not a 
registered user and proceed to step 7. 

• If the Guest radio button is dimmed, 
guests are not permitted access to this 
computer or server. 

6. Click Registered User radio button. 

7. Enter the name with which you are regis
tered on the remote Macintosh in the Name 
field. This may vary from Mac to Mac. 

8. Enter your password for use with this com
puter in the Password field. 
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9. Click the OK button. A list of available 
shared folders and disks will appear, similar 
to the example shown in Figure 38. 

~ Mlltintosh SE/30 

Select the items you want to use: 

Checked items ( 181 ) will be opened at 
system startup time. 

Cancel OK 

Figure 38 Available shared disks. 

J) 
v7.0 

10. Select the name of the shared folder or disk 
you want to use from the scrolling list. You 
can select multiple items. 

• If an item in the list appears dimmed, 
you are already connected to the disk or 
it is not available to you. 

11. Click the OK button. The selected disk will 
be mounted and its icon will appear on your 
desktop. 

Automatic Access 
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You can use either of the following methods of 
automatically connecting to another computer. 
Either technique is especially useful if you use 
specific disks on a regular basis. 
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Automatic Connection at Startup 

You can automatically connect to any available 
remote volume on the network each time you 
start your Macintosh by performing this set of 
steps. 

1. Connect to the remote computer and select 
the items you want to use as explained in 
steps 1 through 10 in the previous section, 
Accessing Shared Folders, beginning on page 
67. 

2. Check the available disk's checkboxes to se
lect the disks you want to mount automati
cally each time you start your Macintosh, as 
shown in Figure 39. 

~ Mntintg&b SE/30 

Select the items you want to use: 

Checked items ( 181 ) will be opened at 
system startup time. 

0 Saue My Name Only 
® Saue My Name and Password 

Cancel ([ OK )) 
v7.0 

Figure 39 Automatic connection items. 

When you check a shared disk's checkbox in the 
scrolling list, two radio buttons will appear. 

• Check the Save My Name Only check
box to be prompted to enter your pass
word each time you connect to the 
shared disk. 
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• Check the Save My Name and Password 
checkbox to completely automate the 
connection process each time you access 
the shared disk. 

Automatic Connection with an Alias 

A potential problem with System 7's file sharing 
is the potential for users to create a mess of net
worked folders that is virtually unmanageable. 

If you have access to a folder on a machine that 
is several zones away and nested several layers 
deep, you can make an alias for it and leave it on 
your desktop. 

When you double-click the alias you will be au
tomatically connected to the remote volume. 

You can automatically connect to any available 
remote volume on the network via an alias with 
this set of steps. 

1. Connect to the remote computer as ex
plained in steps 1 through 11 in the section 
named Accessing Shared Folders, beginning 
on page 67. 

2. Select the Finder icon of the shared disk that 
you will want to connect to later. 

3. Select the Make Alias command from the File 
menu. An alias icon will be created and will 
appear next to the shared disk's icon. The 
alias icon will have an italicized name and 
the "alias" suffix. 

4. Rename the alias if you like and locate it any-
where that you find convenient. 

You can automatically connect to the volume 
represented by the alias at any time by double
clicking the alias icon. 

System 7 Rapid Reference 



i~, 
lml 
1::-=.1 

Note: if you were connected to the volume as a 
registered user at the time you created the alias, 
you will be prompted for your password each 
time you connect to the remote volume. There is 
no way to connect to and automatically mount 
a remote volume on the desktop without being 
prompted for your password. 

Disconnecting 

You can disconnect from any remote volume by 
selecting the volume's icon within the Finder 
and dragging it to the trash icon. Alternatively, 
you can disconnect by selecting the volume's 
icon and selecting the Put Away command on 
the File menu. 

You can disconnect any user from your shared 
volumes with these steps. 

1. Open the File Sharing Monitor control panel 
by double-clicking on its icon. 

2. Select the user you want to disconnect from 
the Connected Users scrolling list. 

3. Click the Disconnect button. 

4. Specify the number of minutes before dis
connecting the user. The remote user will be 
alerted to the pending disconnection. 

• Specifying 0 minutes results in an imme
diate disconnection with no alert given 
to the remote user. 

Network Follies 

• When you turn on file sharing, you can no 
longer eject removable media such as CD-
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ROMs, optical discs, or SyQuest cartridges. 
This is a 11feature" built into System 7 that 
ensures that the Macintosh's owner can get 
remote access to all drives, even those that 
have not been explicitly shared. The solution 
is to start up with all removable media re
moved from all devices. Doing so will pre
clude the removable media from being 
accessed remotely unless it is specifically 
shared after start up. 

• If you leave your Mac on, an interloper can 
come in your office, alias your hard disk 
drive, place the alias in a shared folder, and 
root through your disk from any point on 
the network without your knowledge or your 
control. 

• Changing the master file-sharing password 
does not require you to enter the previous 
password. All an interloper needs to do is 
change the password and root through the 
disk from any point on the network. 
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CHAPTER EIGHT 

Publish & Subscribe 

Publish and Subscribe is a logical extension to 
the information transfer capabilities inherent in 
the Clipboard, automating the exchange of in
formation between documents. It's easiest to 
think of System 7's Create Publisher and Sub
scribe To commands as a live Copy and Paste. 

To initiate Publish and Subscribe you publish a 
document (or a section of a document), resulting 
in the creation of an edition file. You (or other 
workgroup members with access to the edition 
file) subscribe to the edition, inserting its infor
mation into other documents. 

When the linking has been completed, changes 
to the original document are propagated to the 
subscribing documents automatically. 

Documents do not have to be open in order to 
receive edition updates. Edition updates are for
warded automatically when the document is 
opened. System 7's Publish and Subscribe capa
bilities also work in a seamless manner across a 
network. Edition updates are stored on non
shared disks and are automatically forwarded to 
the appropriate subscribers the next time you 
share the volume or folder. 
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Both the publisher and subscriber have some 
control over when the updating takes place, but 
the subscriber generally cannot modify the 
source published information. 

It's easiest to remember that edition information 
always flows from the publisher to the subscrib
er. Subscribers can request edition updates, but 
they flow from the publisher. 

Creating a Publisher 

Page 76 

At the time of this writing, relatively few Macin
tosh applications support System 7's Publish and 
Subscribe capabilities. This is sure to change in 
the very near future. 

This section and the next will use Deneba Soft
ware's Canvas as an example as it follows Apple's 
interface guidelines relatively closely. 

Although the following two sections use Deneba 
Software's Canvas drawing program as an exam
ple, the Publish and Subscribe processes are very 
much the same in most applications. 

You can use the following set of steps to create a 
Publisher within Canvas. 

1. Launch Canvas. 

2. Open the document containing the object 
you want to publish. 

3. Select the object you want to publish within 
the Canvas window. 

• The Create Publisher ... command on the 
Edit menu will be enabled. 

4. Select the Create Publisher ... command on 
the Edit menu. The Canvas Edit menu, com-
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plete with the Edition Options submenu, is 
shown in Figure 40. 

Undo Create KZ 
Paste Again 00= 

Cut KH 
Copy KC 
Paste KU 
Clear OO~H 

Edit Special ~ 

Create Publisher ••• 
Subscribe To ••• 
Edition Options ~ 

Select Hll • Selection ••• sg~ 

Duplicate X 
Duplication ••• -~ 
Mana ers ~ 

Send Hll Now 
H<~t fUl NOUJ 

Cancel Huto Send 
Cancel Huto Get 

Figure 40 Canvas Edit menu and Edition Options 
submenu. 

• Note: the Create Publisher ... command is 
always disabled until you select an object 
or group of objects within a Canvas win
dow. This is true for most programs, al
though some-Claris MacWrite Pro, for 
example-allow you to publish an entire 
document as well as sections. 

5. Select the Create Publisher ... command on 
the Edit menu. The Edition Preview dialog 
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(]j 
Dr-op folder 
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box, similar to the one shown in Figure 41, 
will be displayed. 

I= Further •I =Further 

Cl Boolclceeplngf 

' 
Ej er t 

Cl DoyMolcerf 
Cl FlleMolcer Prof Desktop 
CJ FromeMalcert 

New CJ J Cl Graphicst 
Cl HyperCordf li 
Name of new edition: ( Cancel l 
I Drop Folder.pict Edition #1 I (( Publish J] 

Figure 4 7 Edition Preview dialog box. 

• Note: a thumbnail Preview image of the 
publisher material is available in the left 
panel of the dialog box. 

6. Enter a name for the new edition. 

• When you create a publisher, you also 
create an edition at the same time. An 
edition is the separate file that you 
named in step 6; it can be located any
where on your hard disk drive. 

7. Click the Publish button. The selected object 
in the Canvas window becomes a publisher, 
and the edition file is saved to the location 
on disk that you specified. 

The Canvas window is updated to display a light 
gray box surrounding the borders of the publish
er you have successfully created. 

The edition file that is saved to disk when you 
create a publisher has a unique icon and can be 
opened but not edited. 

You can edit the material contained in the edi
tion by changing the publisher in the original 
file. Double-clicking on the Drop Folder.pict Edi-
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Preview of 

tion #1 edition file icon opens its Edition win
dow, shown in Figure 42, displaying the Preview 
of the publisher. 

publisher. ___ _. ____ _ (]j 
Drop folder 

( Open Publisher D 

Figure 42 Edition window. 

The publisher (in this case the Canvas file named 
Drop Folder.pict) is linked to the edition file 
(Drop Folder.pict Edition #1, in this example). 
The edition file is automatically updated each 
time you change the publisher. 

A document can contain any number of publish
ers that are independent of each other. Some 
software applications let publishers overlap, al
lowing one publisher to include all or part of the 
information contained within another publish
er. 

• A nested publisher contains all the informa
tion contained within another publisher. 

• An overlapped publisher contains only part of 
another publisher. 

Apple's interface guidelines call for word proces
sors to permit nested publishers, but not over
lapped publishers. A drawing application, on the 
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other hand, should permit both nested and over
lapped publishers. 

Creating a Subscriber 

PageBO 

You can use System 7's subscribe capability to use 
any edition file that you have created or to which 
you have access. You can even subscribe to edi
tion files across a local area network. 

The biggest advantage of using Publish and Sub
scribe to subscribe to an edition file-especially 
within networked workgroup situations-is con
sistency. Every workgroup member can be as
sured of using the same information. 

A single edition file can be used-subscribed to
by any number of subscribers. 

The following sequence explains the use of the 
edition file created in the previous section, Cre
ating a Publisher, beginning on page 76. 

This set of steps is non-application specific, but 
uses an edition file that contains only Pier-for
mat information. 

You can use the following set of steps to create a 
Subscriber within any application that supports 
System 7's Publish & Subscribe feature. 

1. Launch the application you want to use. 

2. Open the document in which you want to 
insert the edition. This document will con
tain the subscriber. 

3. Set an insertion point where you want the 
edition to be placed. 

4. Select the Subscribe To ... command on the 
Edit menu. The Edition Preview dialog box, 
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Preulew 

CiJ 
Drop foldtr 

similar to the one shown in Figure 43, will be 
displayed. 

I= Further •I =Further 

Cl Bookkeeplngf i Cl oayMokert 
Eject 

Desktop 
CJ flleMalcer Prof 
Cl FromeMekert 
Cl Grophlcsf Cancel 
CJ HyperCIIrdf 

~ CJ MOREt l Subscribe J 

Figure 43 Edition Preview dialog box. 

5. Navigate within the dialog box to locate the 
edition file you want to use. 

6. Select the edition file you want to use. 

• Note: a Preview of the edition file is avail
able in the left panel of the Edition Pre
view dialog box. 

7. Click the Subscribe button. The edition file's 
contents are placed within your document at 
the insertion point. 

The document window is updated to display a 
dark gray box surrounding the borders of the edi
tion to which you have subscribed. You can repo
sition the subscriber anywhere within your 
document with the Cut and Paste commands on 
the Edit menu. The subscriber remains in the 
document until you cancel it or the publisher to 
which it subscribes. 

The subscriber is linked to the edition file (Drop 
Folder.pict Edition #1 in this example). The edi
tion file is automatically updated each time you 
change the publisher. 

A document can contain any number of sub
scribers that are independent of each other. 
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Controlling Editions 
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System 7 provides you with various options for 
controlling your publishers and subscribers. The 
specific set of options available varies between 
programs, but most software products will pro
vide this core group of control options. 

• The option to cancel the publisher or sub
scriber, resulting in the edition no longer be
ing automatically updated 

• The option to see the date and time of the 
last edition update 

• The option to open the publisher of any se
lected edition 

• The option to see the disk location of the cur-
rent publisher or subscriber 

• The option to automatically update editions 

• The option to manually update editions 

For specific information about the various op
tions available for controlling publishers and 
subscribers within your application programs, 
refer to the documentation that came with your 
specific software. 
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CHAPTER NINE 

System 7 Tips 

At about 100 pages, this book can only cover the 
major aspects of System 7; those things that you 
really need to know to become productive quick
ly. Important parts of System 7-Data Access 
Language (DAL), AppleEvents, and others-have 
not been covered in this book, because they are 
not yet of critical importance to most System 7 
users. Others, such as Balloon Help, have not 
been covered because they are next to useless. 

This chapter serves as a sort of collection area for 
important information that doesn't fit in any of 
the other chapters and yet doesn't warrant its 
own chapter. 

Desk Accessories 

System 7 Tips 

Macintosh desk accessories have always been 
small application programs with a single menu. 
In System 7 desk accessories are treated just like 
any other application, and there is no need to in
stall them in the System file. Many desk accesso
ries were created for use before the advent of 
System 7, however, so there are some caveats to 
be aware of. 
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Older-style desk accessories are easily identified 
by their familiar suitcase icon. Before they can be 
used with System 7, they must be removed from 
the suitcase. You can accomplish this with a sim
ple three-step procedure. 

1. Double-click on the suitcase icon to open the 
suitcase file. 

2. Drag the desk accessory out of the window 
and place it anywhere on your disk that you 
find convenient. 

• Note: if you drag the desk accessory to the 
System Folder icon, it will automatically 
be placed in the Apple Menu Items fold
er. This is not a requirement; desk acces
sories can reside anywhere on your disk. 

3. Discard the empty suitcase file by dragging it 
to the trash. 

Fortunately, most desk accessories that have 
been created since System 7 was released come 
with two versions: one for System 6.x users and 
one for System 7 .x users. The System 7 versions 
are usually identical, but not "packed" in a desk 
accessory suitcase. They also usually have a 
unique icon. 

Stationery Pads 

Page84 

A stationery pad is a template of a document that 
you can use an unlimited number of times as a 
master template or format pattern. 

Many new applications, designed specifically for 
use with System 7, offer a stationery button in 
the Save As dialog box. 

Here's how you can create a stationery pad from 
any existing document. 
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1. Select the document within the Finder. 

2. Select the Get Info command from the File 
menu. The Info window for the document 
will be displayed, as shown in Figure 44. 

~~~§ FrameMaker Chap. 02 Info 

I ~ Fr ameMaker Chap. 02 

Kind : Fr ameMaker document 
Size : 299K on disk (294 ,.338 bytes used) 

Yhere: Further: FrameMakerf: 
Fr ameMaker Files : Fr ameMaker 
Bookf: 

Created : Fri,. Oct 19 .. 1990,. 2 :33 PM 
Modified : 'w'ed .. Dec 18 .. 1991 ,. 12 :20 PM 
Version : n I a 

Comments: 

D Locked D Stationery pad 
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Figure 44 Document Info window. 

3. Check the Stationery pad checkbox. 

4. Click the close box in the Info window to 
save the document as a stationery pad. 

You can open a stationery pad like any other doc
ument. If the application you're using supports 
stationery, a new, untitled document will be 
opened. If the application does not support sta
tionery, you will be prompted to supply a name 
for the new document. 
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Memory Management 

Most software applications work significantly 
better if you can give them a larger memory par
tition. The best rule of thumb is to give the appli
cations you use most often the largest memory 
partition you can. 

You can increase any inactive application's mem
ory partition with these steps. 

1. Select the application within the Finder. 

2. Select the Get Info command from the File 
menu. The Info window for the selected ap
plication will be appear, as shown in the ex
ample in Figure 45. 

~1!1 Frame Maker Info 

A FrameMaker 
V FrameMaker Version 3.0 

Kind: application program 
Siz~ : 631 K on disk (635 ,.962 bytes used) 

Vh~re: Further: FrameMaked: 

Cr~at~d: Wed,. Ju13 .. 1991 .. 11 :00 AM 
Hodifi~d: Mon,. Oct 14,. 1991,. 4:32PM 
Y~rsion: 3.0 .. @ 1986-1991 Frame 

Techno logy Corporation. 
Comments: 

Suggested memory 

partition size ---~-------r··:::.: .. ·~H~~~m~o~r~g;, .... : ... : .... : .... =: ............................ : 
Current memory 
partition size 

0Locked 
! Suggestea S1N.4! ,.000 K ! 
! Current size : !'s'o'o'o""j K ! 
: ••••••••••••••••••••••••••••••••••••••.••• :::::.:·:::::.:·::.= •••••••••• J 

Figure 45 Application Info window. 
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Total memory 
available 

3. Enter a number larger than the Suggested 
size in the Current size field. 

4. Click the close box in the Info window to 
save your changes. 

You can check the amount of memory your ap
plications are using by selecting the About This 
Macintosh command from the Apple menu 
within the Finder. 

The About This Macintosh window will be dis
played with a graphic representation of the 
amount of memory used and available for each 
application that is currently open. 

The more white space showing in each applica
tion's memory partition display, the better. Too 
much white space, indicates a waste of resources. 

An example About This Macintosh window is 
shown in Figure 46. 

System software 
version number 

Largest memory 
block available 

~Macintosh 

Total Hemorv: 

Da\IMaker.,.. 

Application 
name 

Memory 
partition 

I 

Memory used 
in partition 

Memory available 
in partition 

Figure 46 About this Macintosh window. 
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A Hidden Bug 

PageBB 

For the most part, System 7 is the most stable and 
reliable system software release in Apple Com
puter's history. Given the immensity of a system 
software development project, Apple is to be 
highly commended for the hardiness of the most 
significant system software release in the com
pany's history. 

There is, however, one very significant bug in 
System 7 that can cause no end of grief if you 
don't understand what is happening. Frank Van 
Alstine, the patient soul who has output the 
camera-ready mechanicals for several of my 
books, found this bug. 

System 7's disk-to-disk copy mechanism in the 
Finder doesn't copy invisible files. If you copy a 
master floppy disk that contains invisible files by 
dragging its icon to your hard disk drive icon, the 
invisible files will not be copied. The solution is to 
use the installer application that came with the 
master floppy disk or to move only complete 
folders that you suspect contain invisible files. 
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CHAPTER TEN 

System 7 Tune-Up 

Instead of issuing full incremental updates to 
System 7, which would require nine or more 800 
I<Byte floppy disks, Apple Computer has begun 
to release System 7 Tune-Up disks. 

The good news is that so far the Tune-Up disks 
have been distributed on a single 800 I<Byte flop
py disk. This makes the software easily obtain
able from the online services and user groups. 

The bad news is that the Tune-Up adds one more 
potentially troublesome INIT (startup document) 
to the System soup. 

The worst news is that the first System 7 Tune-Up 
could cause more problems than it solved in 
some drcumstances. 

As of june 1992, the current System 7 Tune-Up is 
version 1.1.1. The community consensus is that 
it is quite stable and addresses these issues: 

• Printing is faster and less problematic. The 
version 1.1.1 Tune-Up disk contains a new 
LaserWriter driver. This is still a PostScript 
Levell driver; we're still waiting for the 
promised Level 2 drivers for the LaserWriter 
Ilf and Ilg. 
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• You can tum off AppleTalk to free up memo
ry on computers that are not connected to a 
local area network. This is espedally useful 
for the Power Book notebook Madntoshes. 

• Overall, memory is managed much better 
and fewer 11 out of memory" conditions will 
be encountered. 

• A bug in the initial releases of System 7 
caused files and folders to disappear in cer
tain circumstances, with some hardware 
configurations. This has been fixed. 

The Tune-Up software is installed using Apple's 
Installer utility, although you can simply drag 
the software components to their proper loca
tions. Information on using Apple's Installer is 
provided in the Installing System 7 chapter be
ginning on page 9. 

If you have installed an earlier version of the 
Tune-Up software than version 1.1.1, you must 
run the Disk First Aid program (found on the 
Disk Tools disk) before installing the new Tune
Up software. If Disk First Aid reports a problem 
with your hard disk that it cannot repair, some 
files and folders on the disk may appear to be 
lost. Use these steps to repair your disk. 

1. Use the Finder's Find command to locate lost 
files and folders. 

2. Copy these items to a floppy disk. 

3. Back up your hard disk drive. 

4. Reformat your hard disk using the software 
that came with your drive. 

5. Install System 7.0.1. 

6. Install System 7 Tune-Up version 1.1.1. 

7. Restore the contents of your hard disk from 
your backup. 
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CHAPTER ELEVEN 

How a LaserWriter Works 

All laser printers work by combining light, elec
tric charges, and plastic particles to produce a 
printed page, and the Apple LaserWriters are no 
exception. 

All laser printers use the following sequence to 
produce a printed page. 

1. The printer receives an image. 

2. Inside the printer, a series of laser beams 
strike a drum that carries a negative electrical 
charge, creating areas of positive charge on · 
the drum. 

3. Negatively charged bits of black-plastic toner 
are attracted to the areas where the light 
beams have drawn an image. 

4. Positively charged paper is passed through 
the roller, attracting the particles of toner 
from the drum. 

5. The paper passes between two or more heat
ed fusing rollers, causing the toner to bond 
to the paper. 

All of the members of the Apple LaserWriter II 
family use similar imaging controllers and en
gines and identical paper paths. 
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The paper path for the LaserWriter II family is 
shown in Figure 47. 

Figure 47 LaserWriter II paper path. 

Printer performance is directly attributable to 
two components. 

• The printer's engine 

• The printer's controller 

The Engine 

Page92 

The Laser Writer's engine is the part of the printer 
that actually marks and creates the printed page. 
Apple's LaserWriters are built around either the 
Canon LBP-LX or LBP-SX engine. 

A laser printer's engine is usually rated in the 
number of pages per minute it can produce. In· 
dividuals or organizations that produce moder· 
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ately large amounts of documents need a printer 
with an engine that is capable of printing be
tween 6-10 pages per minute. 

The good news is that laser printer engines are 
getting faster and sharper. It is important to bear 
in mind, however, that most laser printers-es
pecially those in the Macintosh environment
do not reach their rated speed except on the 
most simple documents. 

The Resolution Issue 

Most laser printers offer 300 dot-per-inch (dpi) 
resolution. Printers that offer higher resolution 
output produce documents that are sharper be
cause the stair-stepped jagged edges are reduced. 
In addition, a higher resolution printer makes it 
possible to output halftone screens with more 
lines per inch. 

There are three generally recognized ways, all 
currently in use, to increase the resolution of a 
laser printer engine. 

• Shorten the pulse of the printer engine's laser to 
apply more horizontal dots. Printers that use 
this method are usually easy to recognize be
cause they offer a horizontal resolution that 
is twice as high as the vertical resolution. 
Printers that shorten the laser pulse offer 
smoother characters and vertical lines, but 
produce landscape-format documents that 
are of lower quality. 

• Use software resolution enhancement tricks. 
Some manufacturers, most notably Apple 
and Hewlett-Packard, increase a given print
er engine's resolution by adjusting the size of 
the dots the printer prints, rather than in
creasing the number of dots that are output. 
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• Use an engine that offers a higher resolution. 
Some printers are a sort of hybrid. These 
printers are built around engines capable of 
producing higher resolution output com
bined with shortened laser pulses. 

All of the Apple LaserWriters use a standard 300-
dpi engine. The high-end LaserWriter Ilf and 
LaserWriter Ilg have additional proprietary cir
cuitry that enhance resolution (covered in the 
FinePrint and PhotoGrade chapters). 

The Controller 
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The Laser Writer's controller is the part of the 
printer that processes all print jobs and tells the 
printer's engine where to apply toner on the 
printed page. 

Apple's Laser Writers use controllers based on the 
same Motorola processors that are used in the 
company's personal computers. In fact, the con
troller for the Laser Writer Ilg is essentially a Mac
intosh Ilci motherboard with added print
specific and networking features. 

How well the printer can handle complex pages 
is a direct result of the printer's controller. A gen
eral rule of thumb for Macintosh printers is that 
a printer with a fast controller and a relatively 
slow engine is faster than a printer with a slow 
controller and a fast engine. 

Controllers are getting faster and smarter. Only a 
few years ago, state of the art controllers were 
based on the Motorola 68020 processor. Now, 
most engines use fast 68030s or RISC (reduced in
struction set computing) chip sets. 

In some cases, most or all of the processing relat
ed to a print job takes place in the computer that 
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is connected to the laser printer. In these cases, 
the host computer is actually the laser printer 
controller. 

A Hard Disk Connection 

A Small Computer System Interface (SCSI)hard 
disk drive connection on the laser printer can be 
quite important if you work with a lot of down
loadable fonts. Both the Laser Writer Ilf and 
Laser Writer Ilg offer a SCSI port. 

A hard disk drive connected to your printer and 
loaded with fonts can speed most print jobs con
siderably, especially those documents that use 
fonts other than the ones included in the print
er's ROM. 

Using a hard disk drive connected to the laser 
printer eliminates the need to download fonts 
over the local area network. Fonts generally take 
about 30 seconds each to download across a Lo
calTalk network, and take less than a second 
when downloaded from a hard disk drive con
nected to the LaserWriter. 

Laser Printer Classes 

Laser printers can be classified as fitting into one 
of five broad categories. 

• Personal Printers are non-PostScript printers 
that use a 4- to 6-page-per-minute engine. 
They cannot be shared across a network, and 
generally use the host computer to control 
the print engine. These printers use inexpen
sive print engines that are slow and rated for 
a relatively light duty cycle. 
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• Personal PostScript Printers use the same type 
of 4- to 6-page-per-minute print engine 
found in personal printers, but add Post
Script to the equation. These printers some
times have network ports, but their slow 
print engines preclude their use across a local 
area network. 

• Light-Duty PostScript Printers are usually built 
around an 8-page-per-minute engine, and 
employ a controller based on a 68000 proces
sor. These printers are inexpensive enough to 
be distributed among small workgroup 
members on a single network. 

• Medium-Duty PostScript Printers are based on 
an 8- to 12-page-per-minute engine, and use 
a 68020-, 68030-, or RISC-based controller. 
They are appropriate for a five to ten-mem
ber workgroup. 

• Heavy-Duty PostScript Printers use 12- to 22-
page-per-minute engines coupled with 
68030- or RISC-based controller. They usual
ly have large or multiple paper trays and are 
capable of large volume printing. 
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CHAPTER TWELVE 

The LaserWriter family 

Apple Computer's Laser Writer family of printers 
all fall within the Laser Printer Classes presented 
on page 95, with the exception of the heavy
duty PostScript category. At this time, Apple does 
not market a printer with large enough paper 
trays to be appropriate for heavy-duty use. 

Apple's Laser Writers can be categorized as either 
personal printers or workgroup printers. The cat
egories are based on the capabilities of the print 
engines and controllers they use and their ability 
to be shared by workgroup members across a lo
cal area network. 

Personal LaserWriters 

The personal LaserWriters (Personal LaserWriter 
LS and Personal LaserWriter NT) are designed for 
use by an individual, even though the Personal 
Laser Writer NT has a built-in LocalTalk port. 

The personal LaserWriters are built around an 
engine-the Canon LBP-LX-that is too slow for 
use by most workgroups. The engine is rated at 
an output capacity of 4 pages per minute. In a 
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real-world setting, the actual throughput of 
printed pages is significantly less. 

Either of Apple's Personal LaserWriters are appro
priate for use by a single user and a good choice 
if your printing needs are moderate and not like
ly to grow in the foreseeable future. 

Personal LaserWriter LS 
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Apple's Personal LaserWriter LS is positioned as 
an inexpensive, entry-level, non-PostScript laser 
printer offering modest performance and no ex
pandability. The Personal LaserWriter LS cannot 
be upgraded to PostScript. 

The closest competitor to this printer is the 
Hewlett-Packard Laserjet liP, a printer that can be 
upgraded to PostScript and used on a network for 
less money. 

The Personal LaserWriter LS is truly a personal 
printer; it cannot be shared across a local area 
network, and instead is connected to the serial 
port of any Macintosh. 

The Personal Laser Writer LS, like the other mem
bers of Apple's Personal LaserWriter family, is 
built around the Canon LBP-LX engine. The Can
on LBP-LX engine is rated at 4 pages per minute. 
You can expect output speed at about one page 
per minute when the Personal LaserWriter LS is 
attached to a low-end Macintosh such as the LC 
or Classic and about two pages per minute with 
68030-based Macintosh models such as the Ilsi 
or Ilci. 

The output capability of the Personal Laser Writer 
LS-because it is a "dumb" printer (relying on 
the processing power of the computer to which 
it is attached to rasterize a page)-is dependent 
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on the host Macintosh's processing power. Ac
cording to Apple, the minimum configuration 
would be a 1 MByte Macintosh with a hard disk 
drive running System 6.0.7. 

The Canon LBP-LX engine has a rated life cycle of 
150,000 pages over five years with no monthly 
maximum, and each toner cartridge is rated for 
about 3,500 pages. 

The print controller used in the Personal Laser
Writer LS is based on a Motorola 68000 processor 
running at 8 MHz. 

The Personal LaserWriter LS comes with 512 
KBytes of RAM installed, and there is no provi
sion for adding more memory. 

According to Apple, the printer incorporates pro
prietary data compression/decompression tech
nology that allows the Personal Laser Writer LS to 
work as if it had 2.5 MBytes of RAM installed. 
This appears to be a valid claim. 

A 50-page paper tray is built into the printer. You 
can adjust the paper tray to accommodate letter, 
legal-, A4-, and BS-size paper. The Personal Laser
Writer LS paper tray can also be used to feed en
velopes to the printer. 

A 250-sheet paper cassette is available for $79, 
but requires the addition of a paper feeder, avail
able for an additional $120. A legal-sized paper 
tray costs $79, and an envelope cassette that 
holds 15 envelopes costs $89. 

Apple has always been fairly competitive with its 
laser printer pricing, and the Personal Laser
Writer LS is an indication of Apple's renewed in
terest in the lower end of the market. 

The Personal LaserWriter LS carries a suggested 
retail price of $1299-$700 less than its Laser
Writer IISC predecessor. 
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Instead of attaching to the SCSI port, like the Per
sonal LaserWriter SC does, the LS attaches to any 
Macintosh's serial port. 

This isn't nearly as bad as it sounds, because the 
printer externally clocks the Macintosh's serial 
port to achieve a transfer rate of 909 I<Bits per 
second; almost four times the speed LocalTalk 
can accomplish. 

QuickDraw vs. PostScript 

Apple's Personal LaserWriter LS is the only mem
ber of the LaserWriter family that uses Apple's 
proprietary QuickDraw to image a page instead 
of Adobe Systems Inc.'s PostScript page descrip
tion language. 

QuickDraw is a set of graphic routines stored 
within the Macintosh ROM and system software. 
The routines are used by all Macintosh applica
tions-including PostScript applications-to dis
play images on the screen. 

A QuickDraw printer works in basically the same 
way. The printer's driver software takes the 72-
dpi QuickDraw screen image and converts it into 
a 300-dpi bit map image that is then sent to the 
printer. 

The standard rule of thumb for QuickDraw print
ers is that the faster the Macintosh used, the fast
er the printing results. 

QuickDraw is appropriate for many business 
tasks, especially those that are text-based. Quick
Draw printers are incapable of printing Post
Script images, however, so they are inappropriate 
for most desktop publishing and graphic design 
tasks. If you print mostly spreadsheets and let
ters, a QuickDraw printer will serve you well. If 
your work entails printing any other sort of doc-
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uments, however, you would do well to consider 
a PostScript printer. 

QuickDraw printers like the Personal Laser Writer 
LS are less expensive than PostScript printers for 
two reasons. 

• Adobe PostScript licenses are avoided 

• The Macintosh is used to rasterize images in-
stead of the printer 

Apple's Personal LaserWriter LS comes with a 
TrueType startup document for use under System 
6.x, and the printer utilizes the TrueType tech
nology built into System 7. Four True Type fonts 
are also included with the Personal LaserWriter 
LS: Courier, Helvetica, Times, and Symbol; the 
original LaserWriter font set. 

Adobe Systems Inc.'s Adobe Type Manager can 
also be used with the Personal LaserWriter LS 
with no problem, giving you access to the entire 
PostScript Type 1 font library. 

For more information on TrueType and Post
Script Type 1 fonts, refer to TrueType vs. Type 1 
Fonts beginning on page 131. 

Personal LaserWrlter NT 

Apple's Personal LaserWriter NT is positioned as 
an entry-level PostScript laser printer offering 
modest performance and limited expandability. 

The Personal Laser Writer NT is a PostScript Level 
1 printer, and carries a retail price of $2599, 
about double that of the Personal Laser Writer LS. 

The extra money is well spent, however, since 
you get a true PostScript printer and a little room 
for growth. 
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Built around the Canon LBP-LX engine, rated at 4 
pages per minute, the Personal Laser Writer NT is 
Apple's least expensive PostScript printer. The 
Canon LBP-LX engine has a rated life cycle of 
150,000 pages over five years with no monthly 
maximum, and each toner cartridge is rated for 
about 3,500 pages. 

The controller used in the Personal Laser Writer 
NT is based on a Motorola 68000 running at 12 
MHz and PostScript vS 1.8. The ROMs in the 
printer are mounted on removable SIMMs. 

Because the version of PostScript in the Personal 
Laser Writer NT includes the type-rasterizing 
code developed for Adobe Type Manager, the 
printer actually outperforms earlier Apple Post
Script LaserWriter models in some areas. 

The printer also offers Diablo 630 and Hewlett
Packard Laserjet Plus emulation. 

When printing pages composed of all text, how
ever, the Personal Laser Writer NT quickly bumps 
into the limitations of its 4-page-per-minute en
gine. In fact, the printer is able to image text pag
es faster than the Canon LBP-LX engine is capable 
of keeping up with. 

The Personal Laser Writer NT is networkable with 
a built-in LocalTalk port. The LocalTalk connec
tion is accomplished with a special co-processor, 
the Peripheral Interface Controller (PIC} chip. 
The PIC chip off-loads all LocalTalk traffic han
dling from the printer's main processor, resulting 
in faster throughput than competing printers 
with faster controllers. 

A 25-pin RS-422 serial port is also provided. This 
port can be used to connect to computers with
out LocalTalk. The serial port settings and emula
tion modes are selected with a push-wheel 
switch on the back of the printer. 
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A 250-sheet paper cassette is standard. A legal 
cassette is available for $79, and an envelope cas
sette costs $89. 

Apple's Personal LaserWriter NT comes standard 
with 2 MBytes of RAM which is barely adequate 
for a PostScript printer. 

The Personal LaserWriter NT's RAM limitation is 
especially apparent when working with a lot of 
downloadable fonts. When a PostScript font is 
downloaded from the computer to the printer, it 
is sent as an outline. The printer then creates a 
bit map from the outline description. 

The bit maps are stored in the printer's memory 
for as long as possible, but they are relatively 
large and when memory is needed for another 
task, the bit maps are flushed from the printer's 
memory. When the font is needed again, the 
printer has to create the bit map from scratch. 

A simple rule of thumb is that the more RAM a 
PostScript printer has, the less likely font bit 
maps will be flushed, resulting in significantly 
faster printing times. 

The good news is that the Personal Laser Writer 
NT uses standard SIMM slots for both RAM and 
ROM. You can upgrade the printer's RAM by re
placing the two 1 MByte RAM SIMMs with 4 
MByte SIMMs, bringing the RAM capacity up to a 
very respectable 8 MBytes. Future versions of 
PostScript would only require a ROM swap, al
though anything that even remotely resembles a 
ROM upgrade is something Apple historically 
has been very hesitant to provide. 

Apple's Personal Laser Writer NT is best suited for 
the individual that works alone and needs Post
Script output. Because it has a LocalTalk port, it 
can be shared between two or three users with 
very light-duty printing needs. 
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Workgroup LaserWriters 
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Apple's workgroup Laser Writers (the LaserWriter 
Ilf and LaserWriter Ilg) are designed for use by 
networked members of workgroups. Both mod
els come with built-in networking (the Laser
Writer Ilg offers Ethernet support) and relatively 
fast engines and controllers. 

The Laser Writer Ilf and Laser Writer Ilg represent 
Apple Computer's initial entry into the resolu
tion enhancement laser printer market. Al
though both printers use the standard 300-dpi 
Canon LBP-SX engine-the same engine used in 
their predecessors-software enhancements are 
provided to boost the quality level of text, line 
art, and gray scale images. 

Both printers use FinePrint to perform anti-alias
ing on text. This significantly reduces the jagged 
edge effect that is common with 300-dpi laser 
printers. Apple claims that FinePrint has no im
pact on printing performance, and tests bear this 
out. For more information on Apple's FinePrint 
technology, refer to the information beginning 
on page 115. 

PhotoGrade provides almost 70 shades of gray, 
allowing you to create artwork that previously 
was available only on printers that offered reso
lutions of 1000 dpi or higher. PhotoGrade is 
standard on the LaserWriter Ilg and optional on 
the Laser Writer Ilf with a RAM upgrade. For more 
information on PhotoGrade, refer to the infor
mation beginning on page 117. 

The workgroup Laser Writers are built around the 
Canon LBP-SX engine, rated at 8 pages-per
minute. Although based on the same engine as 
the discontinued LaserWriter liNT and Laser
Writer IINTX, a new toner cartridge has been de
signed for use with the newer models. 
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The new toner cartridge design addresses four 
problems with the original cartridge design. 

• Toner leakage on the right edge of the page 

• Horizontal banding and streaking as the ton-
er cartridge ages 

• Ghosting effects on filled areas of the page 

• Insufficient black density 

Because banding and streaking is more apparent 
on the LaserWriter Ilg, the newly designed toner 
cartridge is required on that printer. Its use is op
tional on other Laser Writer II-family printers, al
though strongly recommended for the 
LaserWriter Ilf. 

The LaserWriter Ilf and Laser Writer Ilg are appro
priate for all but the largest workgroups. 

LaserWrlter llf 

The Laser Writer Ilf provides full PostScript Level 
2 support and uses a controller based on a Motor
ola 68030 processor running at 20 MHz-the 
same processor used in the Macintosh Ilsi. This is 
a significantly faster controller than those used 
in earlier LaserWriter models. 

For more information about Adobe Systems 
Inc.'s PostScript Level2, refer to the PostScript 
Level2 chapter beginning on page 125. 

The LaserWriter Ilf performs at about the same 
speed as the LaserWriter IINTX on text-intensive 
documents, but about 25% faster on graphics-in
tensive pages. 

Two MBytes of RAM is standard on the Laser
Writer Ilf, and you can upgrade to a total of 32 
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MBytes of memory using 4 MByte SIMMs. There 
are eight standard SIMM slots on the LaserWriter 
Ilf motherboard, and standard configuration 80 
ns SIMMs can be used. 

Because of the increased efficiency of PostScript 
Level 2, Apple claims that the standard 2 MBytes 
of RAM on the Laser Writer Ilf should allow most 
users to download more fonts than was possible 
with the LaserWriter IINTX. Preliminary testing 
validates this claim. 

Apple's LaserWriter Ilf supports memory config
urations of 2, 4, 5, 8, 16, 17, and 32 MBytes. 

The LaserWriter Ilf does not come with enough 
installed RAM to support Apple's PhotoGrade 
technology. You must upgrade to a total of at 
least 4 MBytes of memory in order to use the en
hanced gray scale technology offered by Apple's 
PhotoGrade. 

Both the LaserWriter Ilf and LaserWriter Ilg offer 
a built-in TrueType rasterizer, although very little 
mention of this was made when the printers 
were introduced. TrueType versions of the stan
dard LaserWriter Plus font set-Avant Garde, 
Bookman, Courier, Helvetica, Helvetica Narrow, 
New Century Schoolbook, Palatino, Symbol, 
Times, Zapf Chancery, and Zapf Dingbats-are 
included on floppy disk. 

For more information on TrueType and Adobe 
Type 1 PostScript fonts, refer to TrueType vs. 
Type 1 Fonts, beginning on page 131. 

Both the LaserWriter Ilf and the LaserWriter Ilg 
automatically arbitrate connections between the 
available communications ports (serial and Lo
calTalk on the LaserWriter Ilf; serial, LocalTalk, 
and Ethernet on the Laser Writer Ilg). This allows 
each port to be physically connected to a differ
ent source. This feature is called All Ports Active 
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and more information is provided in the Laser
Writer Ilg section, beginning on page 108. 

The LaserWriter IIf features 2 MBytes of ROM 
and a SCSI port for hard disk drives. 

Because ROM space is severely limited in the 
LaserWriter IIf and LaserWriter IIg, the ITC Zapf 
Dingbats PostScript Type 1 font was removed 
from the ROM of both printers. The font is in
cluded-on the font disk-as a downloadable 
font. 

LaserWriter llf/1/g Driver 

As of late 1991, the LaserWriter driver that ships 
with the Laser Writer IIf and Laser Writer Ilg is the 
System 7.0 Laser Writer driver. This driver does 
not support any of the PostScript Level 2 fea
tures. A new driver is being developed by Adobe 
that is scheduled to be available in the first quar
ter of 1992. 

The new Adobe printer driver will take full ad
vantage of the PostScript Level 2 features and 
will be made available to LaserWriter IIf and 
LaserWriter Ilg owners free of charge. When it 
becomes available, the Adobe driver will become 
the standard LaserWriter driver and will be dis
tributed by Apple. 

For more information on PostScript Level 2 and 
its advantages, refer to the information begin
ning on page 125. 

The LaserWriter IIf and Laser Writer Ilg each offer 
a minimum duty cycle of 300,000 pages, with no 
monthly page limit. This is the rough equivalent 
of printing 200 pages per day, five days a week, 
for more than five years. The toner cartridge is 
rated to produce 4,000 pages at a five percent 
print density. 
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LaserWriter llf/llg Utility Software 

You can use the utility software provided with 
the LaserWriter Ilf and LaserWriter Ilg to control 
these functions: 

• Disable Start Disable/enable startup page 
each time the LaserWriter is turned on. 

• Calibrate: Download an alternate hardware 
gray-scale enhanced calibration table and 
print a test page. 

• Select Halftone: Set the PostScript screen inter
preter to use a specific halftone screen and 
print a test page. 

• Enable: Enable/disable the FinePrint text and 
line anti-aliasing feature. 

• Configuration: Set the parameters for user de
fined switch settings (emulation, baud rate, 
data length, handshaking, port, and cut 
sheet feeder). Also provides a way to set 
Ethernet network addresses. 

• Naming: Change the name of the printer. 

• Download Fonts: Download PostScript and 
TrueType fonts to the printer's memory or 
hard disk drive. 

LaserWrlter llg 
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The Apple LaserWriter Ilg offers all of the fea
tures of the LaserWriter Ilf and adds more stan
dard memory, standard PhotoGrade, a faster 
processor, and support for Ethernet. 

The Laser Writer Ilg uses a controller built around 
the Motorola 68030 processor running at 25 
MHz-the same processor and speed used in the 
Macintosh Ilci. 
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In fact, the LaserWriter Ilg's motherboard is for 
all practical purposes identical to the Madntosh 
lid motherboard with additional chips for print
ing-specific tasks. 

The standard configuration allows the Laser
Writer Ilg to perform at about the same speed as 
the LaserWriter IINTX on text-intensive docu
ments, but about 25% faster on graphics-inten
sive pages. When the Ethernet port is used, 
performance is about 35% faster than the Laser
Writer IINTX and about 10% faster than the 
LaserWriter Ilf. 

5 MBytes of memory is standard on the Laser
Writer Ilg. You can upgrade the printer to a total 
of 32 MBytes (using 4 MByte SIMMs). There are 8 
standard SIMM slots, and standard 80 ns SIMMs 
can be used. 

Although the LaserWriter Ilg ships with more 
than twice as much RAM as the LaserWriter Ilf, 
it's important to note that the PhotoGrade gray 
scale printing offered by the Laser Writer Ilg re
quires four times more memory to store a full 
page of text and graphics. 

The LaserWriter Ilg supports memory configura
tions of 4, 5, 8, 16, 17, and 32 MBytes. 

Apple's LaserWriter Ilg supports both TrueType 
and PostScript outline fonts, and includes a 
built-in TrueType rasterizer. 

For more information on TrueType and Adobe 
Type 1 PostScript fonts, refer to TrueType vs. 
Type 1 Fonts, beginning on page 131. 

EtherTalk Port 
, 

The Laser Writer Ilg uses the National SONIC chip 
running at 25 MHz to provide EtherTalk support. 
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The EtherTalk implementation on the Laser
Writer Ilg is identical as on Apple's original 
Ethernet NB card. 

The Laser Writer Ilg offers a feature Apple calls All 
Ports Active, that allows the printer to be con
nected simultaneously to a LocalTalk and an 
EtherTalk network as well as to a PC via the serial 
port. All Ports Active monitors the ports and 
switches automatically between the ports based 
on incoming traffic. (The LaserWriter Ilf can 
switch automatically between its LocalTalk and 
serial ports.) 

Because Adobe's PostScript language is limited to 
processing only one job at a time, all ports are 
polled in turn until activity is sensed on one of 
the ports. Port polling is then terminated as the 
job begins. When the print job finishes, polling 
of all ports resumes. 

Paper Handling 

Both workgroup LaserWriters share identical pa
per handling characteristics. Apple recommends 
16- to 20-lb. paper in normal mode, and up to 
36-lb. paper stock in manual mode with the face
up tray open. I've been running 24-lb. bond pa
per stock through my Laser Writer II for over four 
years with no problems. 

The LaserWriter Ilf and LaserWriter Ilg each 
come with a 200-sheet capacity paper cassette, 
and an optional! 5-envelope cassette is available. 
An adjustable manual feed is also standard for 
use with single pages and envelopes. All standard 
envelope sizes are supported, with a 3.5- by 7-
inch minimum. 

All of the Apple Laser Writers are incapable of 
printing to the edge of a page, making bleeds im-
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possible. The minimum margins on all four 
sides-top, bottom, left, and right-is 0.197 
inches (5.0 mm). 

Power Consumption 

Laser printers require a lot of power to generate 
enough heat to fuse the toner to the paper. This 
can be a concern if you live in a building with 
older wiring. 

The Laser Writer IIf and Laser Writer Ilg are typical 
of most laser printers in their electridty con
sumption. In North America, either model re
quires about 170 watts in standby mode and 
about 900 watts while printing. 

This is a lot of electricity consumption. Turn 
your Laser Writer off if you're not going to use it 
for the next couple of hours. The LaserWriters 
generate a lot of heat as well, and your workspace 
will be more comfortable with the printer off. 

Surge suppression devices become very impor
tant if you are using laser printers in your work 
environment. They provide protection for the 
printer as well as your computer and peripheral 
devices. 

LaserWriter II Upgrades 

Apple markets the LaserWriter Ilf and Laser
Writer IIg controllers as upgrade products for 
owners of discontinued LaserWriter II-family 
printers (Laser Writer IISC, LaserWriter liNT, and 
LaserWriter IINTX). 

The LaserWriter Ilf upgrade is an especially at
tractive bargain for most owners of older Laser
Writer II models. 
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LaserWrlter Family Comparlson 

Retail price 

Engine 

Engine 
speed 

Memory 

Monthly 
duty cycle 

Engine life 

Network 
support 

PostScript 

Outline 
fonts 

Toner 
copies 

Cost per 
page 
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Figure 48 shows a table comparing the various 
members of Apple's LaserWriter family. 

Personal PPrson.JI L1~erVVnter l aserWnl<'r 
LaserWriter LaserWntPr Ill llq 

LS NT 

$1,299 $2,599 $3,599 $4,599 

Canon Canon Canon Canon 
LBP-LX LBP-LX LBP-SX LBP-SX 

4ppm 4ppm 8ppm 8ppm 

512 KB 2MB 2MB 5MB 

2,500 2,500 Unlimited Unlimited 
pages pages 

150,000 150,000 300,000 300,000 
pages pages pages pages 

No LocalTalk Local Talk Local Talk 
Ethernet 

No Yes Yes Yes 

13 35 35 35 
True Type PostScript PostScript PostScript 

$99 $99 $129 $129 
3,500 3,500 4,000 4,000 

$0.02 $0.02 $0.03 $0.03 

Figure 48 LaserWriter family comparison. 
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Selecting a LaserWriter 

If you work by yourself, print only basic text and 
graphics, and print less than 100 pages per day, 
the Personal LaserWriter LS is an appropriate 
choice and will meet your printing needs. 

If you work with one or two other people and 
produce more complex documents that still total 
less than 100 pages per day, the Personal Laser
Writer NT is your best choice. 

If you are part of a small workgroup or if you pro
duce longer documents that contain sophisticat
ed text and graphics, the LaserWriter llf with at 
least 5 MBytes of RAM is your best option. The 
Laser Writer llf is the most appropriate choice for 
most Madntosh users. 

If you are part of a workgroup of moderate size, 
producing documents with complex text and 
graphic elements, you will need the Ethernet ca
pabilities offered only by the LaserWriter Ilg. 

The Apple LaserWriter family compares favor
ably with competing printers from other ven
dors. Hewlett-Packard's Laserjet III, for example, 
enjoys approximately an 80 percent market 
share in the IBM PC and compatible market. 

The Laser]et III was the first laser printer on the 
market to offer edge smoothing (Hewlett-Pack
ard's proprietary Resolution Enhancement Tech
nology) for improved text quality. 

The Laser]et III is designed primarily as a PCL 
printer, however, and when PostScript is added 
to the Hewlett-Packard printer, performance suf
fers. In addition, when used in a mixed comput
ing platform environment, the Hewlett-Packard 
Laserjet III must be restarted to switch between 
PostScript and its native PCL. 
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For most Macintosh users, the Laser Writer Ilf is a 
significantly better choice than the Hewlett
Packard Laserjet III. The LaserWriter llf was de
signed as a high-speed shared printer offering 
roughly seven times the performance of the 
Hewlett-Packard Laserjet III. Additionally, Ap
ple's LaserWriter Ilf offers PostScript Level 2 and 
much better support for mixed computing plat
form environments. 

Problems with Legal Size Printing 

·~, lml 
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Note that the standard LaserWriter llf and Laser
Writer Ilg do not support full legal size printing. 
At the standard RAM configuration of 2 MBytes 
the LaserWriter Ilf is incapable of printing a full 
legal page. Similarly, the LaserWriter Ilg is inca
pable of printing a full gray-scale legal page with 
its standard RAM configuration of 5 MBytes. 

In order to print full legal pages, the LaserWriter 
llf must be upgraded to at least 5 MBytes and the 
LaserWriter Ilg must be upgraded to at least 8 
MBytes of RAM. 
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CHAPTER THIRTEEN 

finePrint 

FinePrint is Apple's proprietary text-smoothing 
algorithm that images type in a more pleasing 
manner. The technology is standard on both the 
LaserWriter Ilf and LaserWriter Ilg. 

Apple claims its FinePrint technology is better 
than Hewlett-Packard's Resolution Enhance
ment Technology (RET), and this seems to be an 
accurate claim, except at small point sizes. 

FinePrint output on a LaserWriter Ilf or Laser
Writer Ilg looks significantly better than output 
from previous Laser Writer models, but it doesn't 
improve legibility of type at less then 8 points. 
Hewlett-Packard's competing Resolution En
hancement Technology produces better looking 
type at small point sizes. 

Even though Hewlett-Packard's Resolution En
hancement Technology producers better small
size type, FinePrint offers three distinct advan
tages over Hewlett-Packard's RET: 

• FinePrint works on any kind of text or line; 
RET operates only on a fixed set of patterns. 
Letterforms or lines that fall outside of the 
specific patterns are not enhanced by the 
Hewlett-Packard technology. 
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• FinePrint maintains the integrity of letter
forms to a significantly greater degree than 
RET. Hewlett-Packard's RET enhances serif 
type, for example, by actually extending the 
serif of the letterform. 

• FinePrint smooths edges at more than 2400 
dpi; Hewlett-Packard's RET smooths edges at 
up to 900 dpi. 

Apple's FinePrint technology works by expand
ing or contracting the pixels of a letterform to 
create smoother edges, using the logic shown in 
Figure 49. 

Find the edges of 
the letterform 

Calculate the ideal 
edge for the letterform 

Simulate the ideal 
edgefortheletterform 

•••• •••••• ····-// . ••••• •••••• • • •• • • .... 
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Figure 49 FinePrint typographic logic. 

Apple claims that FinePrint is capable of altering 
individual pixels at a horizontal resolution of 
more than 2400 dpi. 

FinePrint manipulates existing dots rather than 
using smaller individual dots because Apple be
lieves that currently available printer engines 
and toner are incapable of translating smaller 
theoretical dots to the page. 

LaserWriter Rapid Reference 



CHAPTER FOURTEEN 

Photo Grade 
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Photo Grade 

Apple Computer's proprietary gray-scale en
hancement technology-PhotoGrade-is one of 
the most impressive features of the LaserWriter 
Ilf and LaserWriter Ilg. PhotoGrade is a standard 
feature of the Laser Writer Ilg and is available as a 
user-installable option (with a simple memory 
upgrade) on the LaserWriter Ilf. 

To upgrade a Laser Writer Ilf to support Apple's 
PhotoGrade gray-scale enhancement technolo
gy, you need only add at least 3 additional 
MBytes of memory. PhotoGrade technology is 
built into both the LaserWriter Ilf and Laser
Writer Ilg, but requires a minimum of 5 Mbytes 
of memory. 

A memory upgrade to support PhotoGrade is the 
most important addition you can make to the 
Laser Writer Ilf. In fact, if you do not need the 
faster networking offered by the LaserWriter Ilg, 
the LaserWriter Ilf may be a better choice. The 5 
MHz difference in the processor's clock speed is 
all but unnoticeable, and the printers are other
wise identical. 

Even though the LaserWriter Ilf and LaserWriter 
Ilg are based on the same Canon LBP-SX engine 
as Apple's earlier printers, PhotoGrade doubles 
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the LaserWriter II family's default screen fre
quency from 53-lines-per inch (lpi) to 106-lpi. 

PhotoGrade also more than doubles the range of 
achievable gray shades from 33 to 6 7 -twice the 
number of gray shades that a standard 600-dpi 
printer can image at the same line frequency. 
Also impressive is that PhotoGrade accomplishes 
this in only 5 MBytes of RAM; a standard 600-dpi 
printer requires 8 MBytes to image the same 
page. 

PhotoGrade significantly improves the appear
ance of gray scale images. A standard 300-dpi 
printer's optimum halftone screen is from 50-60-
lpi, allowing for about 30 levels of gray. Photo
Grade is capable of screens up to 106 lpi, allow
ing for 6 7 shades of gray. 

Apple's PhotoGrade technology is theoretically 
capable of dividing a single 300-dpi pixel into 16 
discrete pixel sizes. The practical capability is 
limited to about 8 discrete pixel sizes, however, 
because charged toner particles tend to attract 
more toner particles. 

Gray Scale Printing 
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Face the fact that regardless of the laser printer 
you are using, it cannot match the quality of the 
gray scale image you can display on your screen. 
Gray scale monitors are capable of produdng up 
to 256 shades of gray. Laser printers are incapable 
of producing anything other than black (or other 
colored toner) dots on paper. Laser printers use a 
process called half-toning to simulate gray shades 
by using dots of varying sizes. 

The printer combines the smallest dots it can cre
ate into clusters called cells. The printer then 
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turns on different numbers of dots within each 
cell. The number of cells per square inch corre
sponds to the screen frequency, and is usually 
measured in lines per inch (lpi). 

As dots are combined into cells, resolution drops 
drastically: 

• A 300-dpi laser printer's optimal halftone 
screen frequency is about 53-lpi. 

• Newspapers generally use an 85-lpi halftone 
screen. 

• Magazines use 133- to 150-line screens. 

To create halftones with higher screens, the 
printer is forced to use fewer dots per cell. The 
fewer the dots available, the fewer the grays each 
cell can represent. At 53-lpi, for example, a 300-
dpi printer is capable of producing only 30 gray 
levels. At 100-lpi, the same printer is limited to 
producing only 9 gray levels. 

As the resolution of the printer is increased, half
tone screen capability also increases: 

• A 600-dpi printer is capable of producing 85-
lpi halftones. 

• PhotoGrade allows the LaserWriter Ilg to 
produce 106-lpi halftones. 

• Imagesetters produce 120-lpi halftones. 

Screens and Halftones 

PhotoG rode 

A laser printer is capable of printing only black 
and white, not shades of gray. A PostScript print
er simulates gray shades by a process known as 
screening. A screen is comprised of a group of pix
els grouped together, called a halftone cell. 
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The illustration in Figure SO shows two simple 
halftone cells. The upper-most example is a 1 x 1 
halftone cell; the lower-most example is a 2 x 2 
halftone cell. 

D 
1 x 1 halftone cell 

2 x 2 halftone cell 

Figure 50 Simple halftone cells. 

As Figure SO clearly illustrates, the total possible 
number of gray shades increases as the number 
of pixels in the halftone cell is increased. 

The size of the halftone cell determines what is 
called the screen frequency. The screen frequency 
is the effective resolution available for a halftone 
cell of a given size. 

Because PhotoGrade employs multiple pixels to 
simulate shades of gray in an image, the effective 
resolution decreases as the size of the halftone 
cell increases. 

Screening then, is a trade-off between resolution 
and the number of shades of gray that can be im
aged. The higher the resolution, the more grays 
that can be imaged. 

A standard 300-dpi printer that uses a 1 x 1 half
tone cell provides a 300-line screen and two 
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PhotoGrade 

shades of gray. An enhanced 300-dpi printer 
such as the LaserWriter Ilg-using a 2 x 2 half
tone cell-is capable of producing a 150-line 
screen and five shades of gray. 

The result is that the Laser Writer Ilg is capable of 
providing a significantly wider range of gray 
scales than typical 600-dpi printers, as illustrated 
in Figure 51. 

600-dpi x 1 bits/pixel (5 levels) 

EB~~~~· 
300-dpi x 4 bits/pixel (16 levels) 

QJ0[D[I]~0[2]~ 
~§]@]§]@]~@]§] 

Figure 51 Available gray levels. 

Because laser printers can only print black dots 
on the page, the key to getting better quality gray 
scale images is to exert more control over the size 
of the dots laid down on the page. 

PhotoGrade is theoretically capable of providing 
16 gray shades for each 300-dpi pixel, although 
this is not attainable with currently available 
print engines. 

Using the Canon LBP-SX engine found in the 
LaserWriter Ilf and LaserWriter Ilg, PhotoGrade 
is capable of attaining a maximum of about eight 
distinct levels of gray for each pixel. This figure is 
significantly more impressive than it sounds. 

According to Apple, the eight-level gray scale is 
roughly equivalent to the gray levels provided by 
a standard 800 x 800 dpi (toner on paper) printer 
with an 8 MByte page buffer. 
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600-dpi 

PhotoGrade 

The LaserWriter Ilg's default halftone cell, as de
fined by the PhotoGrade technology, has eight 
elements, as shown in Figure 52. 

[[] [JJ [(][IJ 
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Figure 52 LaserWrlter llg default halftone cell. 

Each LaserWriter Ilg halftone cell can deliver 
about eight levels of saturation. This results in a 
106line screen with 67 gray levels. 

A 106 line screen is appropriate for just about 
any application short of offset printing. The 
printing company that printed this book, for ex
ample, recommends using 110 to 150 line 
screens, depending on the type of paper that will 
be used. As a general rule of thumb, you can get 
by with a coarser screen when using lower grade 
ground wood and magazine papers although 
higher grade book and coated papers require the 
use of a finer screen. 

An Application Specific Integrated Circuit (ASIC) 
in the LaserWriter Ilf and LaserWriter Ilg (avail
able in the LaserWriter Ilf, but accessible only 
with the memory upgrade mentioned on page 
117) controls the timing of the laser pulse in the 
printer engine. 

The Laser Writer Ilf and Laser Writer Ilg ASIC is ca
pable of pulsing the laser at a fraction of the time 
needed for a single pixel. This allows a smaller 
area of the drum in the toner cartridge to be ex-
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300 dpi 
laser pulses 

Images on drum 

PhotoGrade 
laser pulses 

Images on drum 

posed, resulting in more control of the dot on 
the page, as illustrated in Figure 53. 

Figure 53 PhotoGrade laser pulse control. 

Hype or Substance 

PhotoGrade 

Apple's PhotoGrade technology is very good. So 
good, in fact, that you have to see it to believe it. 
If you own-or are considering the purchase of
a Laser Writer Ilf, the memory upgrade required 
to utilize PhotoGrade is one of the best computer 
bargains available. 

Nevertheless, toner on paper cannot rival the 
quality of output available from even the lowli
est imagesetter. The technologies involved are 
different and given the current technology, 
printers that put bits of plastic on pieces of paper 
will always be inferior to the chemical photo
graphic process involved with imagesetters. 

Apple's claims of equivalency with 600- and even 
800-dpi printers is potentially misleading. Reso-
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lution is resolution, and the higher the better. 
Apple's LaserWriters are all built around 300-dpi 
print engines. PhotoGrade's gray scale output 
may look like the equivalent of 800-dpi resolu
tion, but it's still 300 dots wide by 300 dots tall. 
Most people will be pleased with the benefits of
fered by Apple's new technology, however. 

PhotoGrade is a powerful addition to the Apple 
LaserWriter family and individuals and business
es will find many applications for it. It is most ap
propriate for proofing pages that will be output 
on an imagesetter and for those applications that 
don't require the quality of imagesetter output. 

Perhaps what's most remarkable about Photo
Grade is that it is capable of even better results 
with a higher-resolution print engine. The out
put achieved with PhotoGrade-even with the 
aging Canon LBP-SX engine-is nothing short of 
remarkable. 
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CHAPTER FIFTEEN 

PostScript Level 2 

PostScript Level2 is the first major enhancement 
to Adobe's page description language since its re
lease in 1985. The new release does not render 
PostScript Level 1 obsolete, however. Any docu
ment that will print on a PostScript Level2 print
er will also print on a PostScript Level 1 device. 

Most benefits of PostScript Level 2 will be avail
able only after software applications and printer 
drivers have been updated to take advantage of 
the new features. 

For the first time, Adobe is developing its own 
printer drivers for use with PostScript Level 2. 
The driver for Windows is currently available; 
the Macintosh driver is expected before the end 
of 1991; and a UNIX driver is scheduled for re
lease sometime in 1992. 

The Macintosh drivers, when released, will be 
made available free of charge to the installed user 
base. Apple will include the Adobe drivers with 
the LaserWriter Ilf and Laser Writer Ilg. 

It's important to note that most of PostScript's 
Level2 improvements will be unavailable until 
the new drivers are used. In addition, even Post
Script Levell printers should benefit from the 
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new Adobe drivers. Finally, most mainstream 
PostScript applications will have to be updated 
to take advantage of the new features in Post
Script Level 2. 

What~ New In Level 2 

There are seven general areas in which PostScript 
Level2 offers significant advantages over Post
Script Level 1: 

• Faster printing 

• Improved color support 

• Dynamic memory allocation 

• Improved support for device-specific features 

• Improved Display PostScript 

• Composite font technology 

• Forms and forms caching 

Each of these improvements are covered in the 
following sections. 

Faster Printing 
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PostScript Level 2 offers significant speed en
hancements over PostScript Level 1. Documents 
print noticeably faster with the PostScript Level 
2 driver. PostScript Level 2 printers can use the 
older printer drivers, but their performance is 
comparable to that of PostScript Level 1 printers. 

The older version of PostScript used ASCII encod
ing that allowed transportability at the expense 
of compactness and speed. Display PostScript 
and PostScript Level 2 use a binary encoding sys-
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tern that trades limited transportability for in
creased speed. 

Adobe's PostScript Level2 printer drivers use bi
nary encoding when printing to a PostScript Lev
el 2 printer, but use ASCII encoding when 
printing a PostScript file to disk. 

This seems to offer the best of both worlds, en
suring both speed and transportability across dis
parate computer hardware platforms. 

Improved Color Support 

The Cyan, Magenta, Yellow, and Black ( CMYK) 
color model that was available only in color Post
Script printers in Level 1 is now included in Post
Script Level 2. 

In addition, color support for the Red, Green, 
and Blue (RGB) color model has been added. 

Like the PostScript page description language it
self, all supported color models are device inde
pendent. Device independent color provides a 
standardized way of specifying colors completely 
independent of the variations and discrepancies 
between different scanners, monitors, printers, 
or other output devices. 

C/E 7 931 (XYZ) Color Space 

The color model used in PostScript Level 2 is 
based on the CIE 1931 (XYZ) color space, original
ly developed by the Commission Internationale 
de l'Eclairage, an international standards organi
zation. A color space is a way of representing col
ors by describing their positions in a three
dimensional space. 
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The CIE color space provides a way to specify col
or that is related to human perception rather 
than the mechanics of how a particular device 
reproduces color. 

Since almost all other CIE color spaces are based 
on the CIE 1931 (XYZ) color space, it was an ap
propriate choice. 

A potential drawback to the CIE 1931 (XYZ) color 
space, however, is that there are problems using 
the color model on screen displays. The color 
values must be converted from the XYZ color 
space into RGB color values, and the conversion 
process requires relatively complex mathemati
cal computations. 

Accurate Screen Algorithms 

The halftone algorithms for color separations 
have been dramatically improved in PostScript 
Level2. 

The new algorithms, called Accurate Screen algo
rithms, reduce undesirable moire patterns in col
or separations by providing a much more 
accurate simulation of traditional screen angles 
and frequencies. 

Dynamic Memory Allocation 
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PostScript Level2's improved memory allocation 
results in smaller PostScript files. 

In PostScript Level 1, fixed amounts of memory 
were allocated to various tasks-page imaging, 
font caching, and executing PostScript code, for 
example. PostScript Level2 offers dynamic mem
ory allocation, where the total available memory 

LaserWriter Rapid Reference 



is treated as a common resource that is available 
for any use. Memory that is used for one task can 
be reclaimed when that task is finished and the 
memory is no longer needed. 

The result is that printing documents with very 
complex graphics and a large number of fonts 
should not pose the problems that were some
times encountered with PostScript Levell. Spe
cifically, the dreaded 11VM_error" message should 
become much less common. 

Improved Support for Devlce-Speclllc Features 

Printer-specific features such as automated du
plex printing and multiple paper bins are now 
directly supported. 

Improved Display PostScript 

All of the PostScript Level 1 Display PostScript 
extensions are now part of PostScript Level2 and 
the text and graphics operators have been opti
mized for greater speed. 

Macintosh users will not see any benefit of the 
Display PostScript improvements. 

Composite Font Technology 

Under PostScript Levell, composite font tech
nology-instructions that allow very large char
acter sets-was available only on Japanese
language printers. Composite font technology is 
now part of PostScript Level 2. 
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forms and Forms Caching 
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PostScript Level 1 offered only a font cache; Lev
el2 offers additional caches for forms, paths, and 
patterns. 

The forms cache was designed primarily for tra
ditional forms, but any graphic or text elements 
can be defined as a form and cached. The cached 
material is retained in the printer's memory or 
hard disk, and only the information that chang
es from page to page has to be interpreted by the 
printer. 

Patterned fills, such as the ones created in soft
ware applications like Adobe Illustrator and Al
dus FreeHand, can also be cached. 

The end result is that ranges of pages that use 
cached information will print much faster than 
they did under PostScript Level 1. 
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CHAPTER SIXTEEN 

TrueType vs. Type 1 Fonts 

Typography is one of the most widely misunder
stood topics in the Macintosh community. Apple 
Computer has been of very little help in this 
matter, having consistently underestimated the 
importance of effective typography within the 
desktop computing environment. In the short 
history of the Macintosh and desktop publish
ing, Apple has almost single-handedly managed 
to cloud the issues beyond the point of chaos. 

Adobe Type Manager 

Adobe Type Manager (ATM) allows PostScript 
fonts to be rendered automatically for screen dis
play and non-PostScript output. 

Installing any single size of any Type 1 PostScript 
font and ATM allows any type size to be rendered 
automatically. Screen display is markedly im
proved, as is output from non-PostScript printers 
like the Personal LaserWriter LS. 

In September 1991 Apple and Adobe announced 
that ATM would be folded into future versions of 
the Macintosh operating system. 
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True Type 
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In October 1991 Adobe quietly announced that 
it was making a special version of its ATM avail
able to Apple customers for the price of shipping 
and handling. The package is comprised of Ado
be Type Manager v2.0.3 and four Adobe Gara
mond typefaces. 

Coupons are included with the sale of new Ma
cintoshes as well as the Laser Writer Ilf and Laser
Writer Ilg. Current Macintosh owners can order 
the ATM package by calling 800/521-1976, exten
sion 4400 and charging the $7.50 shipping and 
handling fee to a credit card. 

In 1987, Apple began work on a new font format 
that would be an extension to QuickDraw. This 
project evolved into what we now recognize as 
TrueType. At the same time Microsoft was work
ing on a new imaging model for Windows, 
known as Trueimage. 

In 1989, Apple and Microsoft swapped technolo
gies resulting in Apple's release of TrueType 
fonts. Microsoft threw in the towel on the True
Image page description language in the late 
spring of 1991. 

The TrueType hinting techniques include all the 
information in the font outlines required to op
timize the font at any resolution. PostScript hint
ing, in comparison, is minimal because most of 
the optimizing is done in the printer's Raster Im
age Processor (RIP). 

TrueType allows the weight of any font to be ad
justed, making it legible at smaller sizes. Con
versely, as a larger size is specified, TrueType 
thins the weight, making it more elegant. This is 
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known as optical scaling, and many believe Ado
be will add the feature to future versions of the 
PostScript font specification. 

Adobe Multiple Master 

Adobe's answer to the optical scaling feature of 
TrueType is the Multiple Master series of type
faces. Due in the first quarter of 1992, Multiple 
Master typefaces will allow you to create virtual
ly instantaneous variations of a single typeface. 
The Multiple Master typefaces contain defini
tions for weight, width, style, and size. 

A Multiple Master font can be scaled along a 
specified axis, allowing faces in the same font 
family to be combined to create completely new 
typefaces. For example, a bold condensed face 
could be combined with a bold expanded face to 
create any weight in between. 

What You Need to Know 

If you already own a PostScript printer, or if your 
service bureau offers PostScript output on an im
agesetter, the best solution is to stay as far away 
from True Type as possible. If you're shopping for 
a printer, get PostScript. Even though most appli
cations fully support TrueType, your best bet is to 
avoid it if you can use PostScript. 

A PostScript device will try desperately not to 
have to deal with TrueType and the True Type ras
terizer is designed to be re-downloaded to the 
PostScript output device each time a new page is 
imaged. This results in dreadfully slow output on 
PostScript devices and as of early 1992, most ser
vice bureaus were refusing to run TrueType jobs. 
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TrueType may be free, but it's more trouble than 
it's worth. 

If you're running System 7.0, remove the True
Type versions of any PostScript fonts in your Sys
tem file (usually Courier, Helvetica, Times, and 
Palatine) and replace them with the PostScript 
equivalents. Adobe Type Manager gives you all 
the advantages of first-generation TrueType with 
none of the headaches. 

Keep the TrueType versions of Chicago, Geneva, 
and Monaco in your System 7.0 System file; they 
improve the screen legibility of these System 
fonts considerably. 

If you use a lot of fonts, one of the best purchases 
you can make is Fifth Generation's Suitcase II at 
a street price of about $50. Suitcase II allows you 
to control your font collection and place your 
screen fonts and printer fonts virtually anywhere 
on your hard disk drive. (Fifth Generation Sys
tems Inc., 10049 North Reiger Road, Baton 
Rouge, LA 70809. Phone 800/225-2775 or 504/ 
291-7221; fax 504/295-3268.) 

TrueType is quickly developing into little more 
than a nuisance in the Macintosh world. 

Apple chief executive john Sculley didn't even 
bother to mention the built-in TrueType rasteriz
er in the company's new printers when they were 
introduced in early October 1991. 

Managing Fonts 
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TrueType fonts are easily installed and managed. 
just drag their icons to your closed System Folder 
icon and they will automatically be installed in 
your System file. 
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PostScript Type 1 fonts pose more of a challenge. 
Commercial PostScript fonts are generally dis
tributed as three files: 

• A font suitcase containing the screen fonts. 
The screen fonts contain the font's character 
width table, kerning pairs, and other font
specific information as well as bitmap ver
sions of the font. This bitmap is used for dis
play on the screen if Adobe Type Manager is 
not installed. 

• A series of printer fonts containing the actual 
PostScript instructions for imaging the font 
on the output device. The printer fonts are 
the files that are actually used by a PostScript 
printer. 

• A series of Adobe Font Metrics (AFM) text files. 
The AFM files contain a text version of the 
same font-specific information contained in 
the font suitcase. For most applications ex
cept type creation, the AFM files serve no pur
pose and can be deleted. 

Suitcase II allows you to access your font suitcase 
files without installing them in your System file. 
This allows you to load only those fonts for 
which you have an immediate need, resulting in 
significantly better performance in some situa
tions. It also makes your font menu much easier 
to navigate. 

You can use these instructions to install and 
manage your Type 1 font library. 

1. Install Adobe Type Manager and Suitcase II 
using the manuals that came with them. 

2. Open your System file and remove all of the 
TrueType versions of any PostScript fonts in 
your System file (usually Courier, Helvetica, 
Times, and Palatino ). 

3. Place all of your printer fonts in a folder. 
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• This folder can be named anything, and 
can reside anywhere. For now, leave it on 
the top level of your hard disk drive. 

4. Launch Font/DA Mover v4.1 or later. 

• System 7 users can obtain Font/DA Mov
er v 4.1 or later free of charge from online 
services or user groups. 

5. Remove all but the 10- and 12-point screen 
fonts from your various font suitcase files. 

6. Combine font families into a single font suit
case file. 

• All the Helvetica screen fonts, for exam
ple, can be combined into a single font 
suitcase file. 

• Alternatively, you can group several fam
ilies in a single file by frequency of use or 
numbering system. 

7. [Optional, see below] Merge the font families 
that comprise your screen font library using 
the Font Harmony utility and instructions 
that came with Suitcase II. 

• This is an optional step and may not be 
appropriate for everyone. 

• Merged fonts appear in font menus as a 
single entry such as 11Bookman," and you 
obtain the other weights by applying the 
11italic" or ,,bold" font styles within an 
application. 

• Unmerged fonts display each weight as a 
separate entry, so Bookman would show 
up as four entries: Bookman, I Bookman 
Italic, B Bookman Bold, and BI Bookman 
Bold Italic. 

• The problem with using merged fonts is 
that the Macintosh operating system 

Page 136 LaserWrlter Rapid Reference 



only thinks about fonts in terms of a ba
sic four-weight font family (plain, italic, 
bold, and bold italic). Merged fonts don't 
work w~ll with font families that contain 
more than the four basic weights. 

• Note that the font family merging pro
cess is irreversible. You should only 
merge duplicates of the original font 
suitcase, keeping a backup copy in case 
you want to go back to using the un
merged screen fonts. 

8. Using Font/DA Mover v4.1 or later, remove 
the italic, bold, and bold italic screen fonts. 

• With Adobe Type Manager you need 
only the plain (roman) version of any 
typeface in order to display and print the 
entire font properly. 

9. Place your font suitcase files in the folder 
containing your printer fonts. 

10. Open the font suitcase files you want to use 
with Suitcase II. 

Font Conflicts 

Even though font conflicts are no longer the 
problem they once were, you can still experience 
conflicts where the fonts displayed on the screen 
are not the ones you specified. 

The easiest way to resolve font conflicts is to 
close any Suitcase files you do not need. A more 
permanent solution is to use the Font Harmony 
utility that is included with Suitcase II to harmo
nize your font set. 

Most modem software programs refer to fonts by 
name rather than font ID number. This elimi-
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Kerning 

Page 738 

nates most of the problems with font conflicts, 
although problems can still occur when sending 
files to a service bureau who may or may not 
have the same font from the same vendor. Ado
be's Futura family, for example, is significantly 
different from those marketed by Bitstream. 

If you're serious about typography, you'll proba
bly want to adjust the default kerning pairs that 
are provided with the fonts you purchase. Kern
ing is the act of adjusting the amount of white 
space between two adjacent letters. 

Several commercial kerning utilities are avail
able. The one that seems to have the broadest ap
peal is Pairs Software's KernEdit. (Pairs Software, 
160 Vanderhoof Avenue, Suite 201, Toronto, On
tario, Canada M4G 4B8. Phone 416/467-8784.) 
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CHAPTER SEVENTEEN 

Paper Selection 

Color, texture, weight, opacity, ink holdout, and 
brightness all impact the effectiveness of any 
printed communication. 

These factors-especially a paper's texture and 
weight-are even more important with laser 
printers due to the nature of the laser imaging 
process. 

Paper Categories 

Bond 

Paper Selection 

Paper appropriate for use in a LaserWriter falls in 
one of three basic categories, each of which are 
covered in the following sections. 

Bond paper is also referred to as 11writing" paper. 
If the paper has cotton fibers mixed in with the 
wood pulp, it is called 11rag" paper. Bond paper is 
most often used for stationery, forms, and other 
workaday documents that are usually printed on 
only one side. 
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Text 

Cover 
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Most grades of bond paper have matching enve
lopes, cover stock, and several card stocks for 
business cards. 

Text paper is often referred to as 11book" or 110ft

set" paper. This is the kind of paper that is most 
commonly used in most commercial printing 
jobs and comes in a wide variety of colors and 
surface textures. 

Text paper is generally more opaque than bond 
and is available in both coated and uncoated va
rieties. Text paper is widely used in annual re
ports, brochures, product manuals, newsletters, 
magazines, and books. 

Cover paper is stiffer than either bond or text pa
per and is most commonly used for covers of 
brochures and reports. 

Cover paper should not be run through any of 
the LaserWriter models. Apple Computer specifi
cally recommends 16- to 20-lb. paper in normal 
mode, and up to 36-lb. paper stock in manual 
mode with the face-up tray open. Most cover pa
per is too bulky and stiff to run through the 
LaserWriter and can damage the printer's paper 
path or toner cartridge. If you're in doubt, don't 
risk it; Laser Writer repairs are expensive. 

For most uses, bond and text papers are the most 
appropriate paper choices for use with any laser 
printer, including the members of the Apple 
LaserWriter family. 
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Paper Texture 

1111, 
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Paper Selection 

The three broad paper categories-bond, text, 
and cover stocks-are also available in a wide as
sortment of textures. There are five common pa
per textures in wide use: 

• Smooth. Smooth paper stocks are usually the 
least expensive. 

• Laid. Laid paper stocks have a pattern and are 
popular for use as stationery. Laid papers are 
not often used for two-sided printing be
cause one side of the paper usually has a 
more pronounced pattern than the other 
side. 

• Felt. Felt paper stocks have a deep texture 
and are most often used for covers and other 
special purposes. 

• OffSet. Offset paper stocks are a type of 
smooth paper stocks that have been made 
even smoother by running the paper 
through pressure rollers. The process of run
ning the paper through pressure rollers is 
called calendering. 

• Coated. Coated paper stocks are usually cal
endered papers that have a thin coating layer 
to provide an even smoother surface. Coated 
papers are usually rated in terms of their 
shininess, ranging from a super-gloss to a 
suede or dull finish. 

Heavily textured papers are not appropriate for 
use with the Laser Writer. The toner particles 
don't fuse to the pattern on the paper very well, 
and results in toner flaking off the page if it ad
heres at all. As a general rule of thumb, smoother 
papers work the best with LaserWriters. The 
smoother the texture of the paper, the better the 
laser printed output. 
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Paper Weight 

Paper manufacturers all measure paper weights 
differently. Bond, for example, is based on the 
weight of a ream (500 sheets) of 17- by 22-inch 
sheets. 500 sheets of 20-lb. bond paper stock, for 
example, would weigh 20 pounds in 17- by 22-
inch sheets. This is also referred to as the paper's 
basis weight. 

Text stock has a basis weight dimension of 25- by 
38-inches, and cover stock has a basis weight size 
of 20- by 26-inches. 

Bond paper stock usually comes in 12, 16, 20, 24, 
and 28 lb. weights. Most stationery is 20 lb. 

Uncoated text stock usually is available in 50, 60, 
70, and 80 lb. weights. In most cases, 60 lb. text 
stock is the minimum weight that should be 
used. 

Coated text stock usually is available in 60, 70, 
80, and 100 lb. weights. 

Cover stock is usually available in 65, 80, and 
100 lb. weights. 

Other Paper Qualities 
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A paper stock's ink holdout is a measurement of 
how well the surface of a sheet of paper resists 
the absorption of ink. Coated papers have the 
greatest ink holdout, absorbing less ink and tak
ing longer to dry. Ink holdout has a minimal ef
fect on how well toner adheres to paper. 

A paper's opacity is a measurement of its translu
cency. Coated papers are generally less opaque 
than uncoated papers. 
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A paper's brightness is a measurement of its abili
ty to reflect light. 

A paper's grain direction is usually only of concern 
to the pressman. You may, however, want to pay 
attention to a paper's grain direction when out
putting pieces that will be folded. It's harder to 
fold ·a piece of paper against its grain. 

LaserWrlter Paper 

Paper designed for laser printers is manufactured 
to withstand higher heat than normal copier pa
per. In addition, most laser papers are smoother 
than other papers and are also brighter, provid
ing a higher level of contrast. 

Hammermlll Laser Plus 

One side of this paper, designed specifically for 
laser printers, is extremely smooth and bright. 
The other side is treated with a wax-resistant bar
rier to prevent wax from bleeding through to the 
image side. Laser Plus is also a surprisingly 
''tough" paper, resistant to tearing. 

This paper is especially useful if you will be past
ing your pages on boards. If not, you won't need 
the wax holdout capabilities and would be better 
served by a different paper. 

Hammermlll Laser Print 

Paper Selection 

Hammermill's Laser Print is an excellent choice 
if you don't need the wax holdout capabilities of 
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the Hammermill Laser Plus paper. It has all the 
characteristics of the Laser Plus paper except for 
the wax-resistant barrier on the back side of each 
sheet of the paper. 

Recycled Paper 
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Many paper mills claim to produce recycled pa
per, and there is no standard definition or set of 
criteria to determine the accuracy of the claims. 

The Environmental Protection Agency considers 
paper to be "recycled" if it contains SO percent or 
more recycled content. You can judge recycled 
paper with two general criteria: 

• The kind of waste materials that were used to 
produce the paper 

• The amount of the paper that started as 
waste material 

Paper that is produced with the scraps left over 
from the process of making other paper is re
ferred to as being made from pre-consumer waste. 
Most vendors call it recycled paper, although it 
isn't really recycled at all, since it has never been 
sold or used. 

Paper that is produced from post-consumer waste 
is paper that has actually been recycled; that is, 
the paper was sold, used, thrown away, and recy
cled for sale again. 

Even though the Environmental Protection 
Agency considers paper to be "recycled" if it con
tains at least fifty percent recycled content, it 
doesn't set a criteria for post-consumer waste 
content. In other words, paper that is labeled as 
recycled may contain only ten percent post-con
sumer waste. 
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The most environmentally-conscious papers are 
those with the highest post-consumer waste con
tent. Unfortunately, paper with a high post-con
sumer waste content is of noticeably lower 
quality than a virgin paper. 

Recycled papers that contain higher percentages 
of post-consumer waste are on the horizon and 
will eventually offer quality as good as virgin pa
per. The best source is Conservatree Paper Com
pany, 250 Lombard Street, San Francisco, CA 
94111. Phone 800/522-9200. 

Paper Recommendations 

Paper Selection 

For workaday use, standard 18- to 24- pound 
bond is your best bet. You'll get good results at 
the lowest possible cost. Paper lighter than 18lb. 
should be avoided. The lighter paper is prone to 
mis-feeds and is more sensitive to humidity 
changes. Conservatree markets a range of good
quality recycled papers. 

The best everyday laser paper I've found is a 24-
pound bond called "LaserPro" that offers a 
brightness measurement of 91. Unfortunately, I 
haven't been able to find this paper in the last 
few months, and it may be discontinued. If you 
can find it, it's inexpensive and attractive. 

For stationery, I use Neenah Paper's Classic Crest 
Solar White and matching envelopes. It's a 24-lb. 
paper of medium quality that is widely available 
at about $10 a ream. 

For the best possible laser printer output, use a 
coated paper that is specifically manufactured 
for laser printers. Most paper vendors offer at 
least one type of this paper, and many offer sev
eral different varieties. 
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Conservatree offers a complete range of recycled 
papers for use with Laser Writers. 

• The Conservatree Premium Rag Bond series 
is quite attractive for stationery use. It is 
available in 20- and 24-lb. weights (with an 
80-lb. cover stock available) and contains 15 
percent post-consumer waste. 

• The Conservatree Premium Xerographic 3HP 
is a general purpose 20-lb. paper that con
tains 10 percent post-consumer waste. 

Specialty papers are also available. Specialty pa
pers include color gradations, artistic border de
signs, vellum, certificate borders, foils, self
mailers, and labels. The best source for specialty 
papers is Paper Direct, 205 Chubb Ave., 
Lyndhurst, NJ 07071. Phone 800/272-7377; Fax 
201/507-0817. 

Avoid heavily textured papers. The laser printing 
process requires pressure from hot rollers to fuse 
the toner to the paper and textured paper pre
vents the pressure from being applied evenly. 
Textured papers also leave more paper particles 
called paper dust inside the printer. 
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CHAPTER EIGHTEEN 

Using the LaserWriter 

Before you can print to the LaserWriter, the 
printer driver must be installed in your System 
Folder. You install the printer driver by dragging 
its icon to your System Folder. Under System 7, 
the printer driver will automatically be placed in 
the Extensions folder. 

If you're working within a networked workgroup 
environment, it's important that everyone use 
the same versions of the printer driver. It's a good 
idea to get in the habit of updating all the ma
chines at the same time, avoiding the use of out
dated software. 

Next, the LaserWriter has to be connected to a lo
cal area network (or a Macintosh serial port in 
the case of the Personal LaserWriter LS). 

The rest of this chapter assumes at least a single 
LaserWriter II attached to a local area network, 
although some examples also apply to the Per
sonal LaserWriter LS. 

If your network includes more than one Laser
Writer, you will find it convenient to name each 
one of them. If you give each printer a unique 
name, they will be easier to distinguish by work
group members. 
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You can rename any number of LaserWriters 
with either the Namer utility or the newer Laser
Writer utility by following the instructions that 
came with your printer. 

Using the Chooser 

~· 
~ 

AppleShare 

~ 
Lanr..,rittr 

Before you can print to a LaserWriter for the first 
time you have to select the target printer within 
the Chooser. You can follow these steps to select 
a LaserWriter. 

1. Select the Chooser from the Apple menu. 
The Chooser window, shown in Figure 54, 
will be displayed. 

Chooser 

~ ±I ~ 

DiskP aper Maker 

~ 
L inkS•v•r 6 .1 

Q AppleTalk 
@Active 
0 Inactive 7. 1 

Figure 54 Chooser window. 

2. Select the appropriate Laser Writer icon in the 
left panel of the Chooser window. 

• A list of available printers of the type se
lected will be displayed in the scrolling 
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• 
list in the right panel of the Chooser win
dow, as shown in Figure 55 . 

.: --- --- -- --- ---:::=----..:---- ----- Chooser 

~ 
Select e LeserWriter: 

DtskP ~p•r M~ktr 

~ 
LinkS•v•r 6 .1 

Beckground Printing: ®On 0 Off 

®Active 
"I? AppleTelk 0 lnective 

7.1 

Figure 55 Chooser window with LaserWriter liNT 
selected. 

• Note that a scrolling list of any available 
network zones will appear in the bottom 
portion of the left panel of the Chooser 
window. Be sure to select the appropriate 
zone before selecting a printer. 

3. Select the printer you want to use from the 
scrolling list. Note that the AppleTalk Ac
tive radio button must be selected in order to 
select printers available on the network. 

4. Click the Background Printing On radio 
button if you want to use the print spooler 
that is built into the System software. 

5. Close the Chooser window. 

• The Laser Writer you selected will remain 
active until you select another printer in 
the Chooser window. 
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Page Setup and Print 

One of the benefits offered by the Macintosh 
over competing hardware platforms is a user in
terface that remains consistent regardless of the 
software application being used. 

Most Macintosh software applications print in 
the same way, with two commands on the File 
menu: Page Setup ... and Print .... 

The following examples will use Frame Technol
ogy's FrameMaker for illustrative purposes. 
FrameMaker's printing options are representa
tive of the varied level of printing control offered 
by high-end Macintosh applications. 

Simpler software applications will have fewer 
available printing options. 

Page Setup ... Command 
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You can use the Page Setup ... command to set 
the page size, orientation, reduction or enlarge
ment, and standard printer effects for the docu
ments you print. 

The Page Setup options are specific to the printer 
you have selected in the Chooser. 

The Page Setup options are retained within each 
document once it has been printed. It's a good 
practice, however, to check the document's Page 
Setup settings before beginning any print job. 

You can use these steps to customize the Page 
Setup for your document. 

1. Select the Page Setup ... command from the 
File menu. The Page Setup dialog box, like 
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the FrameMaker example shown in Figure 
56, will be displayed. 

LaserWriter Page Setup 1.1.1 H OK D 
Paper: ® US Letter 0 R4 Letter 

0 US Legal 0 B5 Letter 0 ._1 _Ta_b_lo_id ___ ~ ..... l ( Cancel ) 

Reduce or 11111111% 
Enlarge: 

Orientation 

-~ 
0 Custom Paper Size ••• 

Printer Effects: (Options ) 
D Font Substitution? 
D TeHt Smoothing? 
D Graphics Smoothing? 
D Faster Bitmap Printing? 

Figure 56 Page Setup dialog box. 

2. Specify the appropriate paper size using one 
of the available radio buttons. 

• The right-most radio button has a pop
up menu associated with it. You can use 
this pop-up menu to select other stan
dard paper sizes-such as envelopes and 
tabloids-that are more specialized. 

LaserWrlter Page Setup 1.1.1 

Paper: ® US Letter 0 R4 Letter 
0 US Legal 0 B5 Letter 0 
Reduce or 11111111% 
Enlarge: 

Print 
OFo 

Orientation 

-~ 
0 Custom Paper Size ••• 

Ole 
O&r·~~~~mmwr---

0 Faster Bitmap Printing? 

Figure 57 Page Setup dialog box with paper size 
pop-up menu. 

3. Specify the percentage by which to reduce or 
enlarge the print job by entering a numeric 
value in the Reduce or Enlarge field. 
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4. Select the page orientation-portrait or land
scape-by clicking on the appropriate Orien
tation button. 

5. Specify the appropriate printer effects from 
the group of available checkboxes. 

• Font Substitution, when checked, sub
stitutes the resident Macintosh font set
Geneva, New York, and Monaco-with 
the PostScript Helvetica, Times, and Cou
rier. Note that the letter spacing, line 
endings, and pagination of your docu
ment may be altered if you use this op
tion. If you want to print using the 
resident Macintosh font set, make sure 
Font Substitution is unchecked. 

• Text Smoothing, when checked, 
smooths the LaserWriter output of bit
mapped fonts. 

• Graphics Smoothing, when checked, 
minimizes the jagged edges of some 
types of graphic images. 

• Faster Bitmap Printing, if checked, im
proves the printing speed of bitmapped 
graphic images. Note that some docu
ments will not print if this option is 
checked. If you have problems printing 
documents with bitmapped graphic im
ages, try turning this option off. 

6. Set any other application-specific printing 
options that may be available. 

• These custom features are explained in 
the documentation that accompanied 
your software application. 

• In the FrameMaker example used here, a 
Custom Paper Size ... radio button is 
available, as shown in Figures 56 and 57. 
Clicking this button displays a special 
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Imagesetter paper configuration dialog 
box, shown in Figure 58. 

Custom Paper Size for PostScript lmagesetters (l OK B 
Width: 1&63.0 pt I Height: 1648.0 pt I Margin: 1,...-o-.o-p-t ____, (Cancel ) 

Figure 58 FrameMaker Custom Paper Size for 
PostScript lmagesetters dialog box. 

• The Width, Height, and Margin settings 
are values for PostScript imagesetter page 
size parameters. 

7. Click the Options button in the Page Setup 
dialog box. The Laser Writer Options dialog 
box, shown in Figure 59, will be displayed. 

=La=s=e=rW=r=it=e=r=O=pt=io=n=s===========7=.1=.1~ (( OK J 

[B. 
0 Flip Horizontal ( cancel ] 
D Flip Uertical 
D I nuert I mage 
D Precision Bitmap Alignment (4% reduction) 
D Larger Print Rrea (Fewer Downloadable Fonts) 
D Unlimited Downloadable Fonts In a Document 

Figure 59 LaserWriter Options dialog box. 

8. Specify the appropriate options from the 
group of available checkboxes. 

• Flip Horizontal, when checked, reverses 
the page from left to right, printing a 
mirror image of the document. 

• Flip Vertical, when checked, reverses the 
page from top to bottom, printing the 
document upside down. 

• Invert Image, when checked, prints a 
negative image of the document. 
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• Precision Bitmap Alignment, when 
checked, reduces the size of the printed 
page by 4 percent, resulting in more pre
cise bitmapped graphics that are also less 
distorted. 

• Larger Print Area, when checked, ex
tends the imaging area of the printer by 
reducing the minimum margins. Note 
that selecting this option may prevent 
you from using more than a few down
loadable fonts for the document. Because 
the printer is using more of its memory 
to create the page instead of download
able fonts, some documents may print 
more slowly, and documents with many 
downloadable fonts may not print at all. 

• Unlimited Downloadable Fonts, if 
checked, allows more fonts to be used in 
the document. Selecting this option can 
result in slower printing. 

9. Click the OK button in the LaserWriter Op
tions dialog box. The original Page Setup di
alog box will still be displayed. 

10. Click the OK button in the Page Setup dialog 
box to complete the process. 

The Page Setup settings have now been config
ured for your document. They will be saved with 
your document after you initiate the Print com
mand covered in the next section. 

Print... Command 
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Selecting the Print ... command from the File 
menu allows you to print the current document 
to the printer you have selected in the Chooser, 
using the settings and options you specified with 
the Page Setup ... command. 
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You can initiate the actual printing sequence 
with these steps. 

1. Select the Print ... command from the File 
menu. The Print dialog box, similar to the 
FrameMaker example shown in Figure 60, 
will be displayed. 

LaserWrlter "LaserWrlter II NT" 7.1.1 H Print ~ 

Copies:IIMI Pages: ® Rll 0 From: D To: D ( Cantel ) 

Couer Page: ® No 0 First Page 0 Last Page 

Paper Source:® Paper Cassette 0 Manual Feed 

Print: ®Black & White 0 Color/Grayscale 

Destination: ® Printer 0 PostScript® File 

181 Odd-Numbered Pages 181 Euen-Numbered Pages 

181 Registration Marks D Collate D Skip Blank Pages 

D Last Sheet First D Thumbnails - Rows: ~ Cols: ~ 

Figure 60 Print dialog box. 

2. Enter the number of copies you wish to print 
in the Copies field. 

3. Check the All Pages radio button, or specify 
a range of pages to print in the appropriate 
From: and To: fields. 

4. Check the appropriate radio button to print 
or suppress a cover page. 

• The cover page identifies the document. 
It contains the user name, application 
name, document name, and the date and 
time of the print job. 

5. Check the appropriate radio button for the 
correct paper source. 

6. Check the appropriate radio button for ei
ther black and white or color/grayscale out
put printing. Be careful; color/grayscale 
printing is very slow. 
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• If you print a color document on a black 
and white printer like the LaserWriter, a 
halftone format will be used. 

7. Check the appropriate radio button for the 
destination for the printed document. 

• The Printer option directs the output to 
the printer or output device you have se
lected in the Chooser. 

• The PostScript® File option directs the 
output to a PostScript file on disk rather 
than the selected printer. 

8. The remaining options are specific to the ap
plication from which you are printing. In the 
FrameMaker example used here: 

• Odd- and Even-Numbered Pages, prints 
(checked) or suppresses (unchecked) the 
printing of left- and right-hand pages. 
This is useful for printing on both sides 
of the page. 

• Registration marks, when checked, 
prints crop and color registration marks 
outside of the live text area. This is useful 
when preparing camera-ready mechani
cals for offset printing. 

• Collate, when checked, prints one com
plete copy of the document before start
ing the next copy when more than one is 
specified in the Copies field. This results 
in completely collated output, but slower 
printing times. 

• Skip Blank Pages, when checked, pre
vents blank pages in the document from 
being printed. 

• Last Sheet First, when checked, reverses 
the order in which the pages are printed. 
This is useful when you are printing with 
the face-up tray open. 
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• Thumbnails, when checked and a set of 
dimensions specified in the associated 
fields, prints multiple reduced images of 
the document-called thumbnails-on a 
single page. This is useful for seeing the 
overall layout of several pages at a single 
glance in the early stages of designing a 
document or publication. 

9. Click the Print button. 

Managing Print Jobs 

Various options are available that allow you to 
manage the actual printing process, including 
face-up or face-down page delivery, background 
printing, and print job monitoring. 

Page Delivery Options 

You can control how the pages are delivered 
from the LaserWriter with the face-up tray. 

Most Macintosh software applications print the 
first page first, delivering the pages face-down so 
that the document is properly collated. Some ap
plications print first page last, however, requir
ing face-up page delivery for proper collation. 

To configure the LaserWriter for face-up page de
livery, open the face-up tray. 

Be careful to never open the face-up tray when 
printing is in process. Also, the face-up tray 
should always be open when printing envelopes, 
transparencies, or paper stock heavier than 24-
lb. With the face-up tray open, the LaserWriter 
can use paper stock up to 36-lb. 
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Background Printing 

r.t, 
lml 
1!:-=..1 
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Apple's PrintMonitor, included as part of the 
Macintosh System software, allows you to print 
on a Laser Writer in the background while con
tinuing to work with one or more software appli
cations. This process is known as spooling, or 
background printing. The pages are spooled to disk 
and then printed in the background. 

The PrintMonitor file is automatically put in the 
Extensions folder inside your System Folder 
when you install System 7. 

Under System 6, the PrintMonitor is automati
cally installed in the System Folder only if you 
have also installed MultiFinder. 

If you didn't install the Laser Writer with Apple's 
Installer utility, the PrintMonitor file can be 
found on the Printing disk. 

PrintMonitor and background printing works 
seamlessly with System 7. Background printing 
with System 6 is available only under MultiFind
er, Apple's first-generation multi-tasking imple
mentation. The rest of this section assumes you 
are .using System 7. 

You can turn on background printing by select
ing a LaserWriter in the Chooser and selecting 
the Background Printing On radio button. 
Once you have turned on background printing, 
it stays in effect until you tum it off. 

Turning background printing on prints your doc
ument to a file on disk and returns control of 
your Macintosh to you sooner. 

When you select the Print ... command and ini
tiate the printing process, the Printing Status di
alog box appears on the screen while the print 
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job is written to your hard disk drive, as shown 
in Figure 61. 

Printing in progress .... 

Type command-period (3€.) to cancel. 

Figure 61 Printing Status dialog box. 

As soon as the Printing Status dialog box disap
pears, control of your Macintosh is returned and 
you can continue other work. 

PrintMonitor controls the actual printing job, 
and offers you several levels of control. When 
the print job begins, the PrintMonitor applica
tion is automatically launched and its icon can 
be located in the Application menu. 

The version of PrintMonitor supplied with Sys
tem 7 is notorious for being unable to handle 
large or complex print jobs without reporting an 
error condition. 

It is common for the PrintMonitor application to 
report that it cannot complete the print job be
cause of insufficient memory. When this hap
pens, a dialog box is displayed, reporting the 
condition and suggesting that the size of the 
memory partition allocated to the PrintMonitor 
application be increased. 

If you click the OK button, PrintMonitor will 
perform this action automatically, although the 
current print job will be flushed from the print
er's memory and automatically restarted. 

You can avoid this situation by manually adjust
ing the size of the memory partition allocated to 
the PrintMonitor application. Instructions for 
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increasing the allocated memory partition of an 
application is provided in the Macintosh Reference 
manual and in my System 7 Rapid Reference. 

When you select the PrintMonitor item from the 
Application menu during a print job, its main 
window is displayed on your screen, as shown in 
Figure 62. 

~-=------------~w~a~i~ti~ng, ________________ ~ 
1 ~ System 7 Rapid Ref Chap Book ; System 7 R ... .Q 

Set Print Time ... 

Pages To Print: 10 
status: initializing printer 
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Figure 62 PrintMonitor main window. 

PrintMonitor's main window provides the name 
of the document currently being printed and the 
printer in use as well as a scrolling list of docu
ments waiting to be printed. 

The lower portion of the window displays infor
mation concerning the status of the document 
currently being printed. 

In the middle portion of the window, two but
tons are provided that allow you to control the 
background printing process. 
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• You can cancel the printing of the current 
document by clicking Cancel Printing. 

• You can remove a spooled document from 
the waiting list by selecting it from the list 
and clicking the Remove From List button 
(the Cancel Printing button changes into 
the Remove From List button when a docu
ment in the waiting list is selected). 

• You can set the printing time of any waiting 
document by selecting it from the scrolling 
list and clicking the Set Print Time ... but
ton. Doing so causes the Set Print Time dia
log box, shown in Figure 63, to be displayed. 

Set Print Time: 

® 2:13:31 PM ( Cancel ) 
6/ 1/92 

0 Postpone Indefinitely 

Figure 63 Set Print Time dialog box. 

• You can assign any time and date you 
like using the Set Print Time radio but
ton and its associated time and date 
fields. Alternatively, you can postpone 
the print job indefinitely without cancel
ling it by clicking the Postpone Indefi
nitely radio button. 

PrintMonitor has a menu that allows you to set 
the preferences of the background printing op
tions offered by the Macintosh System software 
and LaserWriter printer drivers. You can also use 
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this menu to stop all printing activity. The Print
Monitor menu is shown in Figure 64. 

Preferences ... 

Stop Printin 

Figure 64 PrintMonitor menu. 

The Open and Close commands are self explana
tory and reproduce the action of selecting the 
PrintMonitor item from the System 7 Applica
tion menu and the PrintMonitor main window 
close box respectively. 

Selecting the Preferences ... command displays 
the PrintMonitor Preferences dialog box, shown 
in Figure 65. 

Preferences ••• 

Show the PrintMonitor window when printing: 
@No QYes 

When a printing error needs to be reported: 

• 0 Only display • in Application menu m + 0 Also display Icon In menu bar 
ICJI m • ® Rlso display alert 

When a manual feed job starts: 

0 Giue no notification 
m + 0 Display Icon In menu bar 

~ m + @ Rlso display alert 

( Cancel ) ([ OK JJ 

Figure 65 PrintMonitor Preferences dialog box. 
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The PrintMonitor dialog box allows you to con
trol the following aspects of the background 
printing process. 

• Whether or not the PrintMonitor window is 
displayed automatically during printing. 

• The level of feedback and form of alert pro
vided when an error condition occurs. 

• The level of feedback provided when a man-
ual feed print job begins. 

You can use the Stop Printing command on the 
PrintMonitor menu to temporarily halt the back
ground printing process. When you select this 
command, the command automatically changes 
to the Resume Printing command, allowing you 
to restart the printing process. 

Downloading Fonts 

Downloading fonts to a LaserWriter-or to a 
hard disk drive attached to the SCSI port of a 
LaserWriter Ilf or LaserWriter Ilg-results in sig
nificantly faster printing times. 

To download fonts to the printer or its hard disk 
drive, use the LaserWriter Font Utility. 

In addition to downloading fonts, the Laser
Writer Font Utility also allows you to: 

• Download a PostScript file 

• List the fonts available on the LaserWriter 

• Print a sample of available fonts 

• Initialize the printer's hard disk drive 

You can follow these steps to download fonts to 
a LaserWriter. 
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1. Tum on the LaserWriter. 

2. Launch the LaserWriter Font Utility. 

• The program will automatically search 
for the characteristics of the LaserWriter 
selected in the Chooser. 

3. Select the Download Fonts ... command from 
the File menu. The Font Download dialog 
box will be displayed, as shown in Figure 66. 

-Download to------, 
(j) Printer 
0 Prinh~r's di~k(~) 

Fonts to download: 
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Add •.• 

Figure 66 LaserWriter Font Utility Font Download 
dialog box. 

4. Click the Add ... button. A standard file dia
log box will appear. 

5. Select the fonts you want to download and 
click the Add button for each font. 

6. When you have selected all the fonts you 
want to download, click the Done button. 
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The Font Download dialog box will appear 
like the example shown in Figure 67. 

Download to-----, 
@ Printer 
0 PrintN's di~kh) 

Fonts to download: 
StoneSans 
StoneSans-Bold 
StoneSans-Bold Italic 
StoneSans-1 talic 
StoneSans-Semibold 
StoneSans- Semibold Italic 
StoneSerif 
stoneS e ri f-B o I d 

Rdd... ) 

Cancel n Download l 
Figure 67 LaserWriter Font Utility Font Download 

dialog box with selected fonts ready to 
download. 

7. Click the Printer radio button to download 
the selected fonts to the LaserWriter's mem
ory or click the Printer's disk(s) radio button 
to download to the printer's hard disk drive. 

8. Click the Download button. The fonts you 
added to the Fonts to download scrolling list 
will be downloaded to the printer's memory 
or hard disk drive. 

• The downloading process can take a 
while depending on the number of fonts 
you selected. During the download, a di
alog box similar to the one shown in Fig-
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ure 68 will be displayed, reporting the 
status of the download. 

LaserWriter: LaserWriter II NT 

Downloading to the printer. 

Font File: StoneSanBol 
Font Name: StoneSans-Bold 

Remaining fonts to download: ..... 11_1_ ..... 
lb-J Downloading ... 

( Cancel ) 

Figure 68 Font Download Status dialog box. 

• When the download process is complete, 
the Download Completed dialog box, 
shown in Figure 69, will appear. 

Download completed. 

Successful downloads: 12 

Download failures: 0 
n OK )J 
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Figure 69 Download Completed dialog box. 

9. Click the OK button. 

The selected fonts are now resident in the print
er. If you downloaded them to the printer, they 
will remain resident until you restart the printer 
or tum its power off. If you downloaded the 
fonts to the printer's hard disk, they will remain 
resident until you reformat the disk. 
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Listing Available Fonts 

You can also use the LaserWriter Font Utility to 
list the fonts available on the LaserWriter. 

1. Select the Display Available Fonts ... com
mand from the File menu. 

• The Available Fonts window, shown in 
Figure 70, will be displayed. 

- • Auailable Fonts 

LaserWriter: LaserWriter II NT 

Fonts in rinter: 
AuantGarde-Book 
R u ant Garde-Book 0 b I i Que 
AuantGarde-Demi 
RuantGard e- Demi Obi ique 
Bookman-Demi 
Bookman-Demi Italic 
Bookman-Light 
Bookman- Light Italic 
Courier 

®Printer 

Figure 70 Available Fonts window. 

2. Click the Printer radio button to display the 
available fonts in the LaserWriter's memory 
(both RAM and ROM). 

3. Click the Printer's Hard Disk(s) radio but
ton to display the fonts available on the hard 
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disk. (This option is available only if a hard 
disk is attached to the printer.) 

4. Click the Printer's Font Expansion Card(s) 
radio button to display the available fonts 
contained on any expansion card that may 
be installed in the printer. (This option will 
be available only if there is a font expansion 
card installed.) 

Tumlng Off the Sample Page 

The LaserWriter prints a sample page each time it 
is turned on or restarted. You can use the Laser
Writer Font Utility to turn off the LaserWriter's 
sample page. 

1. Select the Start Page Options ... command 
from the Utilities menu. The Printer Start 
Page dialog box, shown in Figure 71, will be 
displayed. 

Set startup page: 

oon 
® Of'f' 

[ Use Def'ault ) ( Cancel ) (( OK JJ 
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Figure 71 Printer Start Page dialog box. 

2. Click the Off radio button to suppress the 
printing of the sample page. 

3. Click the On radio button to restore the 
printing of the sample page. 
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Downloading a PostScript File 

You can use the Laser Writer Font Utility to 
download a PostScript file directly to the Laser
Writer selected in the Chooser. 

1. Select the Download PostScript File ... com
mand from the Utilities menu. A standard 
file dialog box will be displayed. 

2. Navigate to the folder containing your Post
Script file and open it. 

• You will be prompted to name and save a 
PostScript Log file to disk. This log file 
contains any errors reported by the Post
Script interpreter in the Laser Writer. The 
file can be named anything and stored 
anywhere on disk. If no errors are en
countered or messages received from the 
PostScript interpreter, the log file will not 
be created. 

Restarting the LaserWrlter 

From time to time the LaserWriter may encoun
ter an error from which it cannot recover. This 
can result from a PostScript error, an especially 
severe paper jam, or a problem with the local 
area network connection. 

If you encounter such a problem, you can either 
cycle the powe~ on the Laser Writer or you can 
use the LaserWriter Font Utility to restart any 
LaserWriter with these steps. 

1. Launch the LaserWriter Font Utility. 

2. Choose the Restart Printer ... command from 
the Utilities menu. An alert dialog box, warn
ing that restarting the printer will erase all 
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downloaded fonts in the printer's memory, 
will be displayed. 

3. Click the Restart button. 

Note that using the LaserWriter Font Utility's Re
start Printer ... command will erase all download
ed fonts currently stored in the LaserWriter's 
memory. This action will have no effect on the 
fonts contained in the LaserWriter's ROM or 
hard disk drive. 
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CHAPTER NINETEEN 

Camera-Ready Copy 

Laser Writer output can best be described as near
typeset-quality. While many printing applica
tions will require high-resolution output from an 
imagesetter, the LaserWriter Ilf and LaserWriter 
Ilg can be used to produce camera-ready me
chanicals for many applications. The proper pa
per and settings can help. 

An appropriate paper specification is important 
when you are producing camera-ready copy 
from your LaserWriter. 

• Use the smoothest texture paper you can 
find. The smoother the better. 

• Paper brightness doesn't seem to have much 
of an impact when the material is repro
duced by the printer. There is, however, a 
perceptual difference. Use the brightest pa
per possible when presenting material to cli
ents. 

Even more important than an appropriate paper, 
however, is the density setting you use in your 
Laser Writer. 

• Keep the LaserWriter's density setting a step 
or two lighter than normal for the best re
sults when producing camera-ready mechan-
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icals. The contrast will be compensated for 
when the film is shot for the print job. 

• A setting of about 117" on the green wheel in
side of the Laser Writer II series seems to work 
the best. (A setting of 115" is normal on the 
same printer series.) 

Be aware that toner cartridges can vary. I've had 
cartridges that insist on printing a wide black 
band down the side of every sheet of paper, for 
example. You may want to keep a cartridge that 
you find to be especially good for use only when 
printing camera-ready material. 

High humidity and static electricity can weaken 
the toner's adherence to the paper. Try to main
tain as consistent an environment as possible for 
crucial printing tasks. 
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CHAPTER TWENTY 

LaserWriter Maintenance 

The LaserWriter family is designed to require a 
minimum of maintenance. The only user main
tenance required is to replace the toner cartridge 
every 4,000 pages or so. Apple recommends that 
an authorized dealer service the LaserWriter ev
ery 100,000 pages. Every time you replace the La
ser Writer's toner cartridge, it's a good idea to also 
clean the internal areas of the printer where pa
per dust and toner particles are likely to collect. 

Carefulllt~ Hotl 

The fixing rollers in the LaserWriter get very hot 
when the printer is in operation. One of the rea
sons the LaserWriter uses so much electricity is 
that the fixing rollers must be kept at a tempera
ture of about 400 degrees. The best strategy is to 
let the fixing rollers cool before performing any 
maintenance on the printer. 

There are other internal parts of the LaserWriter 
that are quite sensitive and should be considered 
off-limits for general maintenance activities. All 
of the exposed gears and electrical contacts in
side of the LaserWriter, for example, should not 
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Optional position 
for output 

Fuser 
(fixing) 

roller 

Pinch 
roller 

be touched, as indicated by the dark shaded areas 
in Figure 72. 

Figure 72 LaserWriter internal view (top). 

An internal view of the LaserWriter is provided 
in Figure 73. 

Output tray 

Controller 
board 

Toner cartridge 

Photosensetive 
drum 

Transfer corona 

Paper 
registration 
roners 

Figure 73 LaserWriter internal view (side). 

Page 114 LaserWriter Rapid Reference 



Toner Cartridge Replacement 

Green 

The LaserWriter toner cartridge is designed to 
yield about 4,000 pages. The actual number of 
pages you can expect from a toner cartridge will 
vary depending on the kind of pages you print. 
If your pages start to look too light, or if you can 
see thin white lines in dark graphic images, it's 
time to replace the toner cartridge and perform 
routine maintenance. 

If the Low Toner Level light-shown in Figure 
7 4-comes on, the cartridge may not need re
placement. Instead, try removing the toner car
tridge and redistributing the toner powder. 

Orange Red Red 

Ready/ In Use Low Toner Level Paper Out Paper jam 

Figure 7 4 LaserWriter indicator lights. 

You can redistribute the toner powder by remov
ing the toner cartridge and rocking it gently back 
and forth while holding it level horizontally. If 
the Low Toner Level light comes in the middle of 
a print job, there is no need to cancel the print
ing unless the output is unsatisfactory. You can't 
harm the LaserWriter by continuing to print 
when the Low Toner Level light is on. 

You can use the following steps to replace the 
toner cartridge. 
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1. Remove the old toner cartridge by opening 
the Laser Writer cover and pulling out the 
cartridge as shown in Figure 75. 

Figure 75 Removing the toner cartridge. 

2. Open the green cover that protects the fixing 
rollers and the fixing roller assembly. 

If the printer has not had sufficient time to cool, 
the green cover that protects the fixing rollers 
and the fixing roller assembly may be hot, and 
the fixing rollers themselves will be very hot. The 
operating temperature of the Laser Writer fixing 
rollers is about 400 degrees. 

3. Remove the used cleaning pad from the fix
ing roller assembly. 

4. Throw the used cleaning pad away, it is of no 
further use. 

5. Unwrap the new cleaning pad that came 
packaged with the new toner cartridge. 

6. Use the white felt tip attached to the new 
cleaning pad to clean the fixing rollers. 

7. Remove the white felt tip from the new 
cleaning pad, and throw it away. 
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8. Insert the new cleaning pad into the fixing 
roller assembly. 

9. Close the green cover that protects the print
er's fixing rollers. 

• The cover is not designed to close tightly 
over the cleaning pad. Pressure from the 
LaserWriter's lid will hold it in place. 

10. Clean the discharge pins, as shown in Figure 
76, with the green plastic cleaning brush 
stored inside of the LaserWriter. 

Figure 76 Cleaning the discharge pins. 

Take extreme care during all internal cleaning 
operations not to break any of the fine wires in
side of the Laser Writer. These wires are extremely 
fragile and not designed to withstand rough han
dling. These fine wires-the transfer corona wire 
and the transfer guide wires-are illustrated in 
Figure 77 and Figure 78. 
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11. Replace the green plastic cleaning brush in 
its storage clip when you're finished. 

12. Carefully clean the transfer corona wire with 
the cotton swab packaged with the new ton
er cartridge, as shown in Figure 77. 

Figure 77 Cleaning the transfer corona wire. 

• The transfer corona wire is the fine wire 
that runs across the middle of the Laser
Writer. Clean it and the diagonal wires 
that run above it very gently with the 
cotton swap that is packaged with the 
new toner cartridge. Take your time; it's a 
tedious job, but must be done carefully. 

Take extreme care during all internal cleaning 
operations not to break any of the fine wires in
side of the Laser Writer. They are very fragile and 
not designed to withstand rough handling. 
These fine wires are illustrated in Figure 77 and 
Figure 78. 
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13. Clean the transfer guide with a damp cloth, 
as shown in Figure 78. 

Figure 78 Cleaning the transfer guide. 

14. Unwrap the new toner cartridge from it's 
packaging, keeping the cartridge level. 

15. Place the used toner cartridge in the carton 
used to ship the new toner cartridge. 

• Some toner cartridge manufacturers
such as Hewlett-Packard-offer a recy
cling program for their used cartridges. 
They will provide you with a special 
shipping-paid mailer to return your ex
pended toner cartridges to them for recy
cling. Contact your dealer or toner 
cartridge vendor for more information. 

16. Holding the cartridge horizontally level, gen
tly rock it back and forth several times to re
distribute the toner powder that may have 
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settled during shipping and storage. The pro
cess is illustrated in Figure 79. 

Figure 79 Rocking toner cartridge. 

Toner Cartridge Recharging 
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Some toner rechargers are now offering special 
long-life drum components that they claim are 
good for six or seven refills, or about 30,000 cop
ies. As a comparison, most rechargers agree that 
standard Laser Writer II toner cartridges can be re
filled only two or three times. 

I don't recommend using recharged toner car
tridges. Toner cartridges are relatively inexpen
sive compared to the repair cost associated with 
cleaning up after a defective cartridge. 
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CHAPTER TWENTY-ONE 

What's New in Word 5.0? 

If you're responsible for a large number of 
Macs-most or all of which are running previous 
versions of Microsoft Word-the first thing 
you'll notice about Word 5.0 is the upgrade 
price. Microsoft charges $129 per copy for the 
upgrade. The early consensus in the community, 
though, is that it's money well spent. 

If the $129 upgrade fee seems a little stiff, consid
er that Word 5.0 is the first major upgrade to the 
most popular Macintosh word processing pro
gram in almost three years. That's only $43 a 
year for the three years that you've been without 
it, if you're keeping score and using twisted logic. 

The second thing you'll notice about Word 5.0 is 
that it's a resource pig, especially under System 7. 
The program requires at least 4 MBytes of RAM if 
you want to use the new grammar checker. For
get about using it on a standard PowerBook. 

Surprisingly, these are the only two complaints 
echoing throughout the community concerning 
the latest release of the word processor Mac users 
love to hate from the company many Mac users 
love to hate.To Microsoft's credit, the initial re
lease of Word 5.0 is remarkably stable and offers 
a wide range of useful new features. 
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Microsoft expended considerable effort and re
sources to make sure Word 5.0 simplifies the pro
cess of everyday word processing tasks. 

Interviews and focus groups with existing users 
were conducted throughout the development 
cycle, and the new Ribbon tool (discussed in the 
next section) is a good example of the results of 
that commitment. 

Ribbon Tool 

Page 182 

Word S.O's Ribbon tool, shown in Figure 80, 
when used in conjunction with the Ruler shown 
in Figure 81, provides ready access to the most 
frequently used word processing tasks. 

Character formatting controls 
Column 
buttons 

Show/Hide Paragraph button 

Figure 80 Ribbon tool. 

You can use the Ribbon tool to format text, insert 
graphics, and specify the number of text col
umns in the word processing document. 

Using the Ribbon tool, you can change the type
face and styling attributes of any range of select
ed text by clicking any of the character 
formatting control buttons. 

You can change the number of text columns on 
the page by clicking one of the three available 
column control buttons. 
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You can insert a picture, and display the Picture 
dialog box wherein you can create a graphic im
age, by clicking the Picture control button. 

Finally, you can click the Paragraph control but
ton to toggle the display of paragraph characters 
and other non-printing characters. 

Using the Ruler, shown in Figure 81, you can 
change the formatting characteristics of para
graphs within your document, your document's 
margins, and the widths of table columns. 

Alignment 
Paragraph Style controls 

I I 
I I 

First line indent controls 

Figure 81 

Line Para9raph Display 
spacing spac1ng Tabs controls 

~~-~-;11 ij:1 !,:pi,\ :tffi':,~,;: I 
Right indent control 

Ruler. 

Microsoft Word's Ribbon and Ruler are best 
thought of as a sort of combination tool. Both 
tools control overlapping aspects of the word 
processing document within the Word environ
ment. Paragraph- and document-level controls 
are both found within each tool, for example. 

Ideally, one tool would control document-level 
aspects, another tool would control paragraph
level aspects, and yet another tool would control 
character-level aspects. 

The Ribbon and Ruler are displayed by default in 
every new word processing document. If you 
prefer them to be hidden, you can change the 
specification in the View options of the Prefer
ences dialog box. More information about Mi
crosoft Word 5.0's new Preferences controls is 
provided beginning on page 186. 
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Find File 

File Nome: 

Title: 

Any TeHt: 

Subject: 

Author: 

Uersion: 

Keywords: 

Word S.O's Find File ... command allows you to 
search for the name and even the contents of 
any Word or supported file. You can combine 
any number of search criteria including author, 
date, title, version, keywords, or actual text con
tained within the document. Selecting the Find 
File ... command from the File menu displays 
Word's Search dialog box, as shown in Figure 82. 

Search 

~ OK l) 
(cancel ) 

Driues: 
I Further 1..,.1 
File Types: 
I Readable Files 1""1 
Search Options: 

Finder Comments: f I Creote New List 1 ... 1 
~Created 
_® On Any Day 0 From: i;/ ':•:· ·· [ID To· '· :J_ 0 • f:/ 1 /;;J2 !ID By: I II 
f<Lost Saued 
® On Any Day 0 From: 6/ '., .. ·· [ID T • ... :J •• 0 o. 6/ 1 /S12 !ID By: I II 
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Figure 82 Search dialog box. 

The contents of a wide variety of fi le types can be 
searched, including Edition files, Excel, Word, 
Text, Apple File Exchange binary files, MacWrite, 
MacWrite II, Graphics, EPS, PICT, TIFF, and Mi
crosoft Works. Any available disk drive can be 
searched, and similarly, any drive can be exempt
ed from the search. 

As indicated in Figure 82, any combination of 
search criteria can be compiled, and once files 
have been located, they can be added to the 
Search Options list. 
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For many users, Word's Find File ... function 
alone will be well worth the upgrade price. As I 
use the feature more and more, I miss it's absence 
in my other software tools. 

A variety of third-party search filters should soon 
be available that will allow you to search the con
tents of virtually any type of file. 

Summary Info 

Word automatically displays the Summary Info 
dialog box whenever you save a file for the first 
time. The entries you make within the Summary 
Info dialog box, shown in Figure 83, are closely 
related to some of the search criteria used by the 
Find File ... command. 

Summar Info 

Title: ~ OK ~ 
Subject: [cancel) 

Author: I Michael Fraase 

Uersion: 

Keywords: 

Figure 83 Summary Info dialog box. 

Even though the entries in the Summary Info di
alog box are optional, supplying appropriate in
formation will help you (or other workgroup 
members) find the file easily in the future. If you 
don't want the Summary Info dialog box to ap
pear when you save your new documents, 
uncheck the Prompt For Summary Info check 
box in the Open and Save options within the 
Preferences dialog box. 
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Preferences 

Setting preferences allows you to customize your 
word processing environment. The method for 
setting preferences has been completely re
vamped in Word 5.0. Selecting the Preferences 
command from the Tools menu displays the 
Preferences dialog box, as shown in Figure 84. 

-------------

Your Name: 

Your Initials: Ll m_d_f _--..J 

l!w.l Custom Paper Size Width: I 
:==~ Vitw 

Open And Save 

Ef 
Default Font 

II 
Spelling 
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Height: I._ _ _, 
Measurement Unit: linch 1 ..... 1 
1:81 "Smart" Quotes 
IZJ Background Repagination 
[8J Include Formatted TeHt in Clipboard 
1:81 Drag-and-Drop TeHt Editing 

Figure 84 Preferences dialog box. 

Word's new Preferences dialog box is reminiscent 
of the Control Panels desk accessory under Sys
tem 6 of the Macintosh operating system. 

The left panel of the dialog box contains a scroll
ing list of icons representing eight major catego
ries of preference options. 

You select a category of options by clicking on its 
representative icon in the scrolling list. Selecting 
one of the categories updates the main portion 
of the Preferences dialog box. Inside each cat ego-
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ry are a collection of optional settings applicable 
to the general category currently selected. 

The table in Figure 85 provides an overview of 
the eight general preference categories accessible 
from Word's Preferences dialog box. 

Category Preference Control 

General 

VIew 

User name and initials, custom paper 
size, preferred measurement unit, back
ground repagination, typographic 
quotes, formatted text copied to Clip
board, drag-and-drop text editing. 

Menu defaults, hidden text display, table 
grid display, document view, ribbon/ruler 
view, text boundaries, picture borders. 

Open And Save 
RTF translation, automatic backup, fast 
save, document save reminder. 

Default Font 

Spelling 

Grammar 

Thesaurus 

Hyphenation 

Default typeface and size. 

Dictionaries to be used. 

Grammar rules to be used. 

Localized language to be used. 

Hyphenation dictionary to be used. 

Figure 85 Preferences table. 

Any changes you make to any of the preference 
options are saved in your Word Settings (5) ftle. 
If you're using System 7, the Word Settings (S) 
ftle is stored in the Preferences folder inside your 
System folder. 

You can create any number of custom Word Set
tings ftles-for any number of specialized uses
by selecting the Commands ... command from 
the Tools menu. Click the Save As ... button and 
save your new Word Settings under a different 
name. The new ftle will become the default. 
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Publish and Subscribe 

Page 188 

Publish and Subscribe is a logical extension to 
the information transfer capabilities inherent in 
the Clipboard, automating the exchange of in
formation between documents. It's easiest to 
think of System 7's Create Publisher ... and Sub
scribe To ... commands as a live Copy and Paste. 

To initiate Publish and Subscribe you publish a 
document (or a section of a document), resulting 
in the creation of an edition file. You (or other 
workgroup members with access to the edition 
file) subscribe to the edition, inserting its infor
mation into other documents. 

When the linking has been completed, changes 
to the original document are propagated to the 
subscribing documents automatically. 

Documents do not have to be open in order to 
receive edition updates. Edition updates are for
warded automatically when the document is 
opened. System 7's Publish and Subscribe capa
bilities also work in a seamless manner across a 
network. Edition updates are stored on non
shared disks and are automatically forwarded to 
the appropriate subscribers the next time you 
share the volume or folder. 

Both the publisher and subscriber have some 
control over when the updating takes place, but 
the subscriber generally cannot modify the 
source published information. It's easiest to re
member that edition information always flows 
from the publisher to the subscriber. 

Publish and Subscribe is most useful for sharing 
information within a collaborative workgroup, 
across a local area network. This feature is Apple's 
standard implementation of exchanging infor
mation between varied software programs. 
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Embedding 

Publish and Subscribe (and Word's Linking and 
Embedding functions, discussed in the following 
sections) is available only with System 7. If you 
are running any version of System 6, the Create 
Publisher ... and Subscribe To ... commands will 
be unavailable. 

You can create a link in Word by copying a selec
tion, called the source, and pasting it at a new lo
cation, called the destination. Whenever the 
source information changes, the destination is 
updated. You are free to specify how frequently 
the links within a document are updated. 

Word's linking feature is most useful for creating 
cross-references within a document, and is espe
cially useful in long documents. 

Word 5.0 offers a third way to exchange informa
tion between certain other applications and 
word processing documents with its embedding 
feature. You can use the Copy Object and Paste 
Object commands on the Edit menu to include 
information created by other supported applica
tions in your word processing documents. 

Word's embedding feature is most useful when 
your documents require portability since all in
formation is contained within a single file. 

Of the three methods of exchanging information 
within the Word environment, Publish and Sub
scribe is the only one currently supported at the 
Macintosh operating system level. 
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Print Merge 

Microsoft Word's print merge capability has al
ways been among the program's strongest fea
tures. Word 5.0 offers a print merge function that 
simplifies the creation of form letters, mailing la
bels, and documents containing boilerplate text. 

Print merge allows you to automatically com
bine variable information with static text within 
the same document to create customized docu
ments for a variety of purposes. 

Word uses two separate documents to create a 
merged document: 

• The main document contains the static text 
and formatting that is common to each 
merged document. 

• The data document contains the list of vari
able information that makes each merged 
document unique. 

To perform the actual print merge in Word, you 
place a series of commands in the main docu
ment where you want the variable information 
to appear. When the document is printed, Word 
automatically retrieves the variable information 
from the data document and places it in the 
main document to create a custom version. More 
information is provided in Working With Print 
Merge beginning on page 265. 

Extensibility 
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Word 5.0 offers an unprecedented level of exten
sibility relative to other Macintosh word process
ing programs. Customized tools can be added to 
the Word environment through extensions to 
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the program. The advantage of this extensibility 
is a more customized workspace. You can add 
only the tools that you need, while at the same 
time eliminating those for which you have little 
use. Ideally, this results in a more efficient work
space. In practice, however, the resource require
ments of Microsoft Word are quite inefficient. 

Microsoft Word 5.0 ships with a useful set of ba
sic tools. These tools are discussed in the remain
der of this chapter. If you're a Power Book user
or a desktop Macintosh user with limited com
puting resources-you will find that you will 
probably have to balance the usefulness of the 
tools with the amount of memory and hard disk 
drive space they require. 

Grammar Checker 

The latest version of Word sports a customizable 
grammar checker. You can specify the rules you 
want the grammar checke~ to apply to your doc
uments through the Preferences ... command on 
the Tools menu. 

Word's grammar checker is based on Houghton 
Mifflin Company's CorrecText Grammar Correc
tion System, and is quite complete. Options are 
provided to flag both stylistic and grammatical 
errors. Some of the major rule groups included 
are cliches, weak modifiers, redundant expres
sions, vague quantifiers, multiple negatives, mis
used words, jargon, split infinitives, passive verb 
usage, and archaic expressions. 

Selecting the Grammar ... command from the 
Tools menu causes Word to automatically check 
the spelling of your document. This streamlines 
the proofing process in some situations. You can 
override this setting with the following steps. 
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1. Select the Preferences ... command from the 
Tools menu. The Preferences dialog box will 
be displayed. 

2. Select the Grammar icon from the scrolling 
list in the left portion of the Preferences dia
log box. The Grammar preferences will be 
displayed, as shown in Figure 86. 

Rule Groups--------, 

® Style 0 Grammar 

./ I Redundant Expressions 

./ j Inappropriate Prepositions 

./ i Informal Expressions 

./ l Cliches 

./ ! Weak Modifiers 

./ j Vague Quantifiers 

./ i Nonstandard Expressions 

./ l Open vs. Closed Spelling 

./ j Multiple Negation 

Catch 

(Ewplain ... ) 

Split I nfinitiues: I By More Than One Word , .... 

Consecutiue Nouns: I Mor e Than Three In A Row 1..-1 
Preposi tional Phrases: I More Than Three In A Row 1..-1 

181 Show Document Statistics 

Figure 86 Grammar Preferences dialog box. 

3. Click the Grammar Rule Groups radio but
ton . The dialog box will be updated to dis
play the grammar rule groups. 

4. Scroll to the bottom of the grammar rule 
groups list and uncheck the Spelling Errors 
option. It's the last item on the list. 

Microsoft Word 5.0 is capable of evaluating the 
readability level of a document, reporting the 
reading level required to understand the docu
ment. To enable this function, check the Show 
Document Statistics checkbox in the Grammar 
preferences dialog box, as indicated in Figure 86. 
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Thesaurus 

Word offers an optional Thesaurus command 
that can be included during the installation pro
cess (see Installing Word on page 197). You can 
use Word's integrated thesaurus to look up a syn
onym for a selected word within any Word doc
ument. Antonyms are also supplied. 

You can use the following steps to look up a word 
in the integrated thesaurus. 

1. Select the word you want to look up in the 
body of your document. 

2. Select the Thesaurus .. . command from the 
Tools menu. The Thesaurus dialog box
with your selected word in the Replace 
field-will appear with a list of Meanings and 
Synonyms, as shown in Figure 87. 

Replace: choice [Replace J [Original] 

'========;;;.~ G [took Up Df Cancel J With: 

s: 
euc ellent r ,.j_JI m preferred 

superior 
eHclusiue 
select 
superlatiue 
fine 
elegant 

PIC lc (noun) 

wish (noun) 

Antonyms 

Figure 87 Thesaurus dialog box. 

3. Select the appropriate usage (or the Ant
onyms item) from the Meanings list. 

4. Select the appropriate synonym from the 
Synonyms list. 
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5. Alternately, click the Lookup button to dis
play the usages and synonyms for the word 
currently highlighted in the With field. 

6. Click the Replace button to replace the se
lected word in your document with the word 
or phrase contained in the With field. 

Equation Editor 

Word's equation editor is based on a special ver
sion of Design Science Inc.'s MathType and is in
cluded in the Microsoft Word package. The 
equation editor is implemented as an optional 
command that can be included during the instal
lation process (see Installing Word on page 197). 

You can use the equation editor to create com
plex mathematical equations with a simple 
graphical interface. All spacing, positioning, and 
sizing of equation elements is handled automat
ically by the equation editor. In addition, Word's 
equation editor includes approximately 120 pre
designed equation templates. 

You can easily convert formulas that you created 
in earlier versions of Microsoft Word to equation 
editor equations simply by copying them from 
your document and pasting them into an equa
tion editor window. Note also that the familiar 
formula editing commands offered in previous 
versions of Word have been retained. 

File Conversion 
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Microsoft Word recognizes and automatically 
converts a wide variety of foreign file formats. 
This file conversion process is implemented as a 
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series of external commands that are added dur
ing the installation process (see Installing Word 
on page 197). Presumably, third-parties will offer 
other file conversion commands for use with 
Word. You can export your Word files in a variety 
of file formats for use with other software. 

Word recognizes and automatically converts the 
following file formats: 

• Word for Macintosh versions 1.0, 3.0, and 
4.0 (there never was a version 2.0) 

• Word for DOS versions 1.0, 2.0, 3.0, 3.1, 4.0, 
5.0, and 5.5 

• Word for Windows versions 1.0 and 2.0 

• Microsoft Works version 2.0 

• Rich Text Format (RTF; Microsoft's inter-
change format) 

• MacWrite versions 4.5 and 5.0 

• MacWrite II 

• WordPerfect for DOS versions 5.0 and 5.1 

• ASCII Text 

• MacPaint 

• Encapsulated PostScript (EPS) 

• Tagged Image File Format (TIFF) 

• PICT 

• PICT2 

The conversion process is automatic and takes 
place transparently. You can use the following 
steps to open a file created in another program 
supported by a Word file conversion command. 

1. Launch Microsoft Word. 

2. Select the Open ... command from the File 
menu. Word's standard Open File dialog box, 
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similar to the example shown in Figure 88, 
will be displayed. Notice that a pop-up menu 
containing a list of all supported file types is 
available at the bottom of the dialog box. 
The expanded file type pop-up menu is also 
shown in Figure 88. 

Select o Document: 

Ia WP Files (Word) ... I 
c:::> Further 

'-.il!JI I • . 
I) Rpple/ How To Write Bolloons 

1 125749K o"olloblo •.... 'I ( [j""' I I) Creoting Info. Products-2/ 91 
Cl Humon lnterfoce Notesf I 

I) Mocintosh Memory Guide ~:!! ( Concel) (Desktop) 

Cl Photoshop Tipsf Vi: ( Find File... ) 
I) PowerBook Guide, 2nd edition ~ D Reod Only 

list Files of Type: Reodoble Files 1 ... 
Rll Files 

..tReodoble Files 
Word Documents 
TeHt Files 
Rpple File EHchenge Binory 
Stotionery 
Grophics Files 
MocWrite 
EPS 
MocWrite II l.H 
PICT 
TeHt with Loyout 
TIFF 
Works 2.0 for Mocintosh 

Figure 88 Open File dialog box. 

3. Select the file type you want to open from 
the pop-up menu. The default is for all read
able file types to be displayed. 

4. Select the file you want to open from the 
scrolling list. 

5. Click the Open button. The selected file will 
be opened in a new window. 

• Alternatively, you can open the file by 
double-clicking its name in the list. 
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CHAPTER TWENTY-TWO 

Installing Word 

Microsoft Word 5.0 ships on five 800 KByte flop
py disks and must be installed using the accom
panying installer application. The Word program 
files are compressed on the floppy disks, so you 
can't simply copy the files to your hard disk. This 
chapter explains how to install Word and its as
sociated files on your hard disk drive. 

Resource Requirements 

Installing Word 

Word requires a Macintosh Plus or later with a 
hard disk drive, an 800 KByte floppy disk drive, 
and at least 1 MByte of RAM. 

Using MultiFinder or System 7 requires a mini
mum of 2 MBytes of RAM. Adding the grammar 
checker under System 7 requires a minimum of 4 
MBytes of RAM. 

Count on reserving at least 5 MBytes of hard disk 
space for even the most modest installation. 

At the time of this writing (Winter 1992) the 
three PowerBooks were shipped in standard con
figurations with between 2 MBytes and 4 MBytes 
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of RAM. Microsoft Word taxes the available re
sources of even the most resource-rich Power
Book. This is unfortunate since word processing 
is one of the most widely used portable comput
ing applications. 

The Installation Process 

When you launch the Installer application and 
select the target location and installation op
tions, the appropriate software is copied to your 
hard disk drive. After the software has been cop
ied, the Installer decompresses the files. 

You have two basic installation options: 

• The Easy Install option installs Word and all 
of its assodated files including sample docu
ments, online help, and all of the optional 
external commands. 

• The Customized Install option installs only 
the software options you spedfy. 

In most cases, the Easy Install option is the most 
appropriate choice. 

Easy Install Option 
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You can install Microsoft Word and all of its as
sodated files by following these steps. 

1. Make backup copies of all of your master 
Word floppy disks. 

2. Restart your computer with all virus protec
tion utilities turned off. The installation may 
not be successful if any virus detection or 
protection software is running. 
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3. Insert your backup copy of the Microsoft 
Word for the Macintosh Install Disk into 
your floppy disk drive. 

4. Launch the Installer application. 

• An introductory screen will be displayed. 

S. Click the OK button. 

• If this is the first time that you have run 
the Installer, you will be prompted to en
ter your name and the name of your or
ganization (if any). 

Note that your name and organization informa
tion will be written to the floppy disk. Always 
work with a backup disk and make sure that the in
formation you enter is correct. If you are not us
ing a backup of your master disk, go back to step 
1 and restart the installation process. 

6. Enter your name and organization. 

7. Click the OK button. 

• A message will appear prompting you to 
turn off any virus protection software 
that may be running. 

8. Click the Continue button. 

• A dialog box will appear indicating that 
the software will perform an Easy Install, 
installing the Word application and all of 
its supporting software. The dialog box 
will also indicate on which hard disk 
drive the software will be installed. 

9. Check the target hard disk drive. You can 
specify a different target disk by clicking the 
Switch Disk button. 

10. Click the Install button. 

• A dialog box, like the one shown in Fig
ure 89, will be displayed. You can choose 

Installing Word Page 199 



to install the software in an existing fold
er, or you can create a new folder for the 
Word application and its associated files. 

Select o folder for installation: 

I c::) Further~ I 
CJ Bookkeepingf ~ c::) Further 
CJ DoyMakerf 

( Desktop ) CJ FileMoker Prof 
CJ FrameMakerf 
CJ Grophicsf ( Open ~ 
CJ HyperCordf ( Install ) CJ MOREf 
CJ MS Wordf (New Folder) 
CJ PageMakerf 

( ) CJ QuorkHPressf .o- Cancel 

1 nstallotion folder: 
Further 
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Figure 89 Installer target folder selection. 

11. Open the target folder by selecting it and 
clicking the Open button, or by double
clicking on its name in the list. Alternatively, 
create a new target folder by clicking the 
New Folder button. 

• If you click the New Folder button you 
will be prompted for a name for the new
ly created folder. 

12. Click the Install button. 

• The installation process will begin. You 
will be prompted to insert the additional 
installation disks when appropriate. 
When the installation is complete, the 
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Installer will decompress the files it cop
ied to your hard disk drive. This process 
will take several minutes. When the de
compression is finished, the Installer will 
display a dialog box prompting you to 
specify a default font and point size. 

13. Specify a default font and point size to be 
used by every new document you create. 

You can change the default font or point size at 
any time within Word by using the Default Font 
preferences panel. A shortcut for changing the 
default font or point size is to select the Default 
Font ... command on the Font menu. This causes 
the Default Font preferences panel to be dis
played immediately. 

14. Click the Restart button when the installa
tion process is complete. 

Network Installation 

Installing Word 

Your network administrator may have placed the 
Microsoft Word installation files on a central 
server rather than distribute the installation 
disks. If this is the case, you can follow these in
structions to perform a network installation. 

1. Select the Chooser item from the Apple 
menu. The Chooser dialog box will appear. 

2. Click on the AppleShare icon in the left pan
el of the dialog box. 

3. Select the appropriate file server in the right 
panel of the dialog box. 

4. Click the OK button. 

5. Login to the file server you have selected by 
following the instructions provided by your 
network administrator. 
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6. Navigate to the folder containing the Word 
Installer application and its associated files. 

7. Follow steps 4 through 14 of the instructions 
provided in the Easy Install Option section, 
beginning on page 198. 

Customize Install Option 

Page202 

You can override the Easy Install option and in
stall only the files you specify with the Custom
ize Install Option. This is appropriate if you want 
to add only selected options if you have already 
installed Word or if you want to conserve hard 
disk space. You can perform a customized instal
lation with the following steps. 

1. Follow steps 1 through 8 of the instructions 
provided in the Easy Install Option section, 
beginning on page 198. 

2. Click the Customize button. 

• A dialog box will appear prompting you 
to select the options you want to install. 

3. Select the options you want to install by 
clicking on the first selection and Shift-click
ing on each additional option. As you add 
options, the dialog box will be updated to re
port the options you have selected. 

4. Follow steps 9 through 14 of the instructions 
provided in the Easy Install Option section, 
beginning on page 198. 
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CHAPTER TWENTY-THREE 

Working With Styles 

Mastering the concept of paragraph styles is the 
key to working effectively with Microsoft Word. 
This chapter provides basic information and a 
strategy for using Word's styles. 

Microsoft Word doesn't support character-level 
styles, but considers a paragraph style to be a col
lection of character and paragraph formats to 
which you assign a name. 

Using Word's styles provides you with the advan
tage of being able to apply a group of formatting 
information to a paragraph with a single step. 
This results in consistency across your docu
ment. Additionally, if you change a style's for
matting, every paragraph in your document that 
uses that style will be automatically updated to 
reflect the changes you made to the style. 

Defining a Style 

You create a style within the Word environment 
by formatting a paragraph-typeface, margins, 
tabs, line spacing, shading, etc.--as you want it 
to appear in the style and naming it. You can ere-
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ate up to 221 paragraph styles per document, 
and any styles that you create are saved with 
your document. 

Style names in Word can be up to 254 characters 
long and can include any combination of char
acters and spaces except the comma. Style names 
are case-sensitive, and you can give a style more 
than a single name. A good strategy is to give of
ten used styles two names: a long one to easily 
identify the style, and a short one to make apply
ing that style easier from the keyboard. For ex
ample, Heading 1 and hl to signify a level one 
heading in your document. 

You can use the following steps to define a style. 

1. Using the various menus or keyboard com
mands, format a paragraph as you want the 
style to be defined. Figure 90 shows an exam
ple of the formatting appropriate for a level 
one heading. 

Nitre~ to tln:l an immact:M!t m.:iia.system. tbkt reoog
ru- thatveybaslc !oct. 

11 }'I>U t-.oh J*>ple haw 10 usa th& Mo.clntosh or produce 
lnlllnetlw media. }'I>U can benefit hom this book. 

_,onomy-
orw based. 

Figure 90 Level one heading formatting. 

2. Select the entire paragraph you've formatted 
by triple-clicking anywhere within the para
graph or by double-clicking beside the para
graph in the selection bar. 

• The selection bar is an unmarked area that 
runs along the left edge of the window. 
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Style box 

When the cursor is within the selection 
bar, it turns into an arrow. Clicking once 
in the selection bar selects a line; clicking 
twice selects the paragraph; triple-click
ing selects the entire document. 

3. Click in the Style box on the ruler. (If the rul
er is not displayed, select the Ruler command 
on the View menu.) The Style box will be 
highlighted, as shown in Figure 91. 

Figure 91 Style box. 

4. Enter the name you want to use for the style 
in the Style box and press Return. 

5. A dialog box will appear, prompting you to 
confirm that you want to define the new 
style based on the paragraph selection. Click 
the Define button. 

The new style will appear in the Style pop-up 
menu on the ruler. 

Before you start creating a lot of styles for your 
document, you may want to take a look at the 
technique provided in A Style Strategy beginning 
on page 211. One of Microsoft Word's most pow
erful features is its ability to base paragraph styles 
on an existing style. 

Working With Styles Page205 



Refining o Style 

."', lml 
L!;_;:J 

~ 

Word's styles can be thought of as being fluid. 
You can change or edit the formatting informa
tion contained within any style at any time. 

Be aware that editing a style in an existing docu
ment will change the formatting of all the para
graphs that have been tagged with that style. 
Always work with a backup copy. If you save 
your document with the new style definitions, 
the original styles will be unrecoverable. 

The Headl style created in the previous section, 
Defining a Style beginning on page 203, would 
look better if it were set off from surrounding 
text. You can edit the style definition to add 
space before and after the paragraph spectfica
tions with the following set of steps. 

1. Place the cursor anywhere within the para
graph of which you want to refine the style. 
The Style box on the ruler will be updated to 
reflect the name of the style. 

2. Select the Paragraph ... command from the 
Format menu. The Paragraph Format dialog 
box, shown in Figure 92, will be displayed. 

Porogroph 

Spacing 

~ OK ~ Before:~~~ 
line: 

( ) Rfter: lo pt I I Ruto 1,..11 I Con eel 

( ) 
I ndentotion Pagination 

Rpply 

Left: loin I 0 Poge Break Before 
( lobs ... ) 

loin I 
0 Keep With NeHt 

Right: 0 Keep Lines Together (Border ••. ) 
loIn I First: 0 Suppress Line Numbers (Frome ... ) 

Figure 92 Paragraph Format dialog box. 
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3. Enter 18 pt in the Spacing Before field. This 
adds 18 points of white space before the 
paragraph, setting off the section head from 
the preceding paragraph. 

4. Enter 12 pt in the Spacing After field. This 
adds 12 points of white space after the para
graph, setting off the section head from the 
following paragraph. 

5. Check the Keep With Next Pagination 
checkbox. This assures that the section head 
will be kept on the same page as the first 
paragraph that follows it. 

6. Click in the Style box on the ruler. The Style 
box will be highlighted. 

7. Enter the name you want to use for the style 
in the Style box and press Return. 

8. If you name the altered style the same as 
your original style-or any existing style
the Reapply Style dialog box, shown in Fig
ure 93, will be displayed. 

Style: heading 1 ([ OK D 
® Reapply the style to the selection? 

(Cancel) 0 Redefine the style based on selection? 

Figure 9 3 Reapply Style dialog box. 

9. Click the Redefine the style based on selec
tion radio button. The altered style will re
place the original style. The formatting of all 
paragraphs in your document that are tagged 
with the style name will be updated to reflect 
the new style definition. 

Working With Styles 

• Clicking the Reapply the style to the se
lection radio button reapplies the origi
nal style to the paragraph. All existing 
paragraphs are unaffected. 
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Applying a Style 

When you have defined a style, you can apply it 
to any number of paragraphs within your docu
ment. When you apply a style to a paragraph, 
the formatting characteristics you defined for 
that style are assigned to the paragraph. 

With the Ruler 

Auto 
Bullt tl 
Bullt tl Lu t 
Bulltt2 
Bulltt2 Last 
Bulltttd Paragroph 
B~lint 
Callout Ftgurt 
Chaptor Numbtr 
Chapttr Tttlt 
Codt 
Codt Lut 
Conttnts Chapttr 
Covtrl 
Covtr2 
Display 
Ftgurt 
Figurt Caption 
Figur• Holdtr 
foottr 
footnott rt ftrtr.ct 
footnot• toxt 

You can use these steps to apply a style to any 
paragraph in your document. 

1. Place the cursor anywhere within the para
graph to which you want to apply the style. 
You can also select multiple paragraphs. 

2. Select the style you want to apply from the 
Style box pop-up menu on the ruler, as 
shown in the example in Figure 94. 

relreshirl! 10 lind an inti!Retiw media system thu raoog· 
nirlos that vmybos!o !>.ct. 

U )'OtlteaDh people how 11> use the Macintosh or prodw:e 
intenetlw media )'Otl can benefit hom lhls book. 

As o ur culture: m~ trom 3.. produot·based. .,ommyo
earmarked byow:rconsumplionof nsO\IlCes-lo ol'll! based 
on lnt~ibW., wewillo.U beusl'l! lnleractilla medlo. on 
some level In our work. Al we coUa::tive!y mal<& this shill 
betv.een the t~ible ani the int~ible, we will begin to 
appraoio.talha "l!erll!nlivanatura of thl ,.,_, lnt~ibles : 
li>*>rmatlon, .. ~the lnstaht ""'dhtill from thl.t 
lnlormatlon. 

· · · · · ·'ihii am,;w;; oi liilc:iim:.:i;;;n:;.;;; u. >J.rt:ri.inliiiki. W!iiiW!ll. · · · · · · · · · · · · · · · 
onlylnc,.,..e. More th<Hat<of tb! lnc..,..e will 
iueU lncn!O.Sa. at a loss as to how 11:> nav!· 

Figure 94 Style box pop-up menu. 
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With the Keyboard 

1111'1 
·~~· -~-

If you prefer to assign paragraph styling from the 
keyboard, you can do so with these steps. 

1. Place the cursor-using the arrow keys on 
the keyboard-anywhere within the para
graph to which you want to apply the style. 

2. Press Command-Shift-S. The word Style will 
appear in the status bar at the bottom of the 
document window. 

3. Enter the name of the style and press Return. 

• Note that you need to type only enough 
of the style name to uniquely identify 
the style. If you have multiple section 
head styles, for example, named Heading 
1, Heading 2, Heading 3, and so on you 
would have to type the entire style name. 
This is why it makes good sense tore
name your most commonly used styles 
with abbreviated names such as Hl, H2, 
H3, and so on. 

You can apply the same style to multiple para
graphs with this shortcut: Select the next para
graph to which you want to apply the style and 
press Command-Y. Alternatively, you can select 
the next paragraph and Select the Repeat com
mand from the Edit menu. 

With the Worlc Menu 

A third way of applying a style within the Word 
environment is to add it to the Work menu and 
select the style from there. This option is espe
cially useful if you are working on a small screen 
and elect to hide the ruler and ribbon. 
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You can add your most commonly used styles to 
Word's Work menu with these steps. 

1. Select the Style ... command from the Format 
menu. The Style dialog box, shown in Figure 
95, will be displayed. 

K OK D 
(Cancel) 

•heading 3 [ Apply ) 
•heading 4 . . 
•headin 5 ( Define) 

Show: @ Document Styles 0 Rll Styles (Delete ) 
~S~ty~l_e_: __________________ ~ 

I heading 2 I( Use ns Default ) 

heooing 1 + Font: 12 Fbint, Sj::loce Before 14 pt 

Based 0 n: ~~ h!!!!!e!!!!!a!!!!!di!!!!!n~g!!!!!l!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!~IEJ 
NeHt Style: I Normal IEJ 

Page 210 

Figure 95 Style dialog box. 

2. Press Command-Option-+ on the keyboard. 
(That's Command-Option-Shift-=). The cur
sor will change to a bold plus sign. 

3. Click the style name in the Style dialog box 
you wish to add to the Work menu. 

• If a Work menu does not already exist, 
Word will create one automatically and 
add the style you have selected to it. 

You can subsequently assign a paragraph style by 
placing the cursor an ywhere within the para-
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graph to which you want to apply a style and se
lecting the style from the Work menu. 

You can remove any item from your Work menu 
by pressing Command-Option-(minus) on the 
keyboard and selecting the menu item. 

A Style Strategy 

One of Microsoft Word's most impressive fea
tures is its ability to build a style sheet by basing 
new styles on existing ones. All of the available 
styles for a document are referred to as that doc
ument's style sheet. A document's style sheet is 
saved as an integral part of the document. 

Most documents can use styles that are based on 
two basic styles: one for body text and one for 
display elements such as chapter titles, heads, 
and figure captions. If you are creating each style 
from scratch, you're working too hard. 

Begin by using these steps to define a body style. 
Note that Word uses the Normal style as a default 
for the most commonly used style. 

1. Place the cursor anywhere within the para
graph to which you want to apply the style. 
You can also select multiple paragraphs. 

2. Select the Style ... command from the Format 
menu. The Style dialog box, shown in Figure 
95 on page 210, will appear. 

• The upper portion of the dialog box con
tains a scrolling list of all available styles 
in the document. This list contains 
Word's default style sheet (default styles 
are preceded with a • bullet character). 
The lower portion of the dialog box con
tains the actual style description and op-

Working With Styles Page 211 



tions for assigning a Based On style and 
a Next Style. 

3. Select the Normal style (•Normal) from the 
scrolling style list. The lower portion of the 
dialog box will be updated to reflect the in
formation for the Normal style. 

• If you are working with a new document, 
the Normal style will be the only avail
able style in the document. The font and 
size will be the defaults you specified 
when you first installed Word. 

4. With the Style dialog box still open, select 
the appropriate typeface for your document's 
body text from the Font menu. 

5. Select the appropriate typeface size from the 
Font menu, again with the Style dialog box 
still open. 

6. Select appropriate typeface styling attributes 
from the Format menu. In most cases, the 
body text will be the Plain Text or Roman 
version of the typeface. 

7. Click the Define button to add the altered 
Normal style to the document's style sheet. 

• Alternatively, you can click the Use as 
Default button. This adds the altered 
Normal style to Word's default style 
sheet that is used by all new documents. 
This is especially useful for maintaining 
consistency across various documents. 

Next, you can use these steps to add a base style 
for the display elements of your document. 

1. Select the New Style entry from the scrolling 
style list in the Style dialog box. 

• If the Style dialog box is not displayed, 
select the Style ... command from the 
Format menu. 
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2. Enter the name for the style on which you 
will base other display type styles. In this ex
ample, the name Display will be used. 

3. Select the characters in the Based On field 
and press the Delete key to delete them. 

4. Select the appropriate typeface for your doc
ument's display text from the Font menu. 

5. Select the appropriate typeface size from the 
Font menu. 

6. Select appropriate typeface styling attributes 
from the Format menu. 

7. Click the Define button. Assuming that you 
started with a new document, the Style dia
log box should now look similar to the exam
ple shown in Figure 96. 

OK D 
( Close J 

( Rpply ) 

(Define) 
Show: @ Document Styles 0 Rll Styles (Delete) 
Style: 

I Display I( Use Rs Default ) 

Font: B 2Stxme Sans Ebld 18 Point, Italic, Rush left 

Based On: II IEJ 
NeHt Style: I Display IEJ 

Figure 96 Style dialog box with Display style 
definition. 
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8. Select the Normal style from the Next Style 
pop-up menu. In most cases body text will 
follow a paragraph containing display text. 

9. Click the Define button to add the altered 
Normal style to the document's style sheet. 

• Alternatively, you can click the Use as 
Default button. This adds the Display 
style to Word's default style sheet that is 
used by all new documents. This is espe
cially useful for maintaining consistency 
across various types of documents. 

You now have defined the base styles for your 
document. The overwhelming majority of other 
styles you create will be based on one of these 
base styles. 

You can use the following set of steps to define a 
style based on the Display style you have already 
set up. 

1. Select the New Style entry from the scrolling 
style list in the Style dialog box. 

• If the Style dialog box is not displayed, 
select the Style ... command from the 
Format menu. 

2. Enter the name for the style you wish to cre
ate. In this example, the name Head! will be 
used, to indicate level one headings. 

3. Select the Display style in the Based On pop
up menu. The Based On field will be updated 
to reflect your selection. 

4. Select the appropriate typeface size from the 
Font menu. 

5. Select appropriate typeface styling attributes 
from the Format menu. 

6. Select the Paragraph ... command from the 
Format menu. The Paragraph Format dialog 
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box will be displayed. This dialog box allows 
you to specify additional attributes for the 
new style. 

7. Enter 18 pt in the Spacing Before field. This 
adds 18 points of white space before the 
paragraph, setting off the section head from 
the preceding paragraph. 

8. Enter 12 pt in the Spacing After field. This 
adds 12 points of white space after the para
graph, setting off the section head from the 
following paragraph. 

9. Check the Keep With Next Pagination 
checkbox. This assures that the section head 
will be kept on the same page as the first 
paragraph that follows it. 

10. Click the OK button. The additional at
tributes will be added to the Head 1 style def
inition within the Style dialog box. 

11. Click the Define button. The Head 1 style 
definition will be added to the document's 
style sheet. 

• Alternatively, you can click the Use as 
Default button. This adds the Head1 
style to Word's default style sheet that is 
used by all new documents. This is espe
cially useful for maintaining consistency 
across various types of documents. 

You can base all of your additional heading level 
styles on this Head1 style, which itself is based 
on the Display base style. In addition, you can 
create any number of additional ranges of depen
dent styles for use in your documents. 

The two advantages to using this approach to 
managing your style sheets is efficiency and con
sistency. To change the typefaces used in your 
document, for example, would require the alter
ation of no more than the two base styles. 
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Style Tips 

Any change you make to a style that other styles 
are based on will automatically ripple through
out your document. Developing a strategy for 
defining styles within the Word environment is 
crucial to using the word processor effectively. 

Here's a list of a few tips to keep in mind when 
you are working with Word's style sheets. 

• Never put multiple line spaces between para
graphs. Use the Space Before and Space After 
settings in the Paragraph Format dialog box 
instead. (Select the Paragraph ... command 
from the Format menu.) 

• You can override the Next Style option and 
continue with the current style in the next 
paragraph by pressing Command-Return to 
start the next paragraph. 

• Text copied from one document to another 
changes to match the style defined in the 
second document. If the second document 
does not contain the style used by the text 
being copied, however, the style will be add
ed to the second document's style sheet. 

• You can merge the styles from a document 
by opening the Style dialog box, selecting 
the Open ... command from the File menu, 
and opening the document that contains the 
style sheet you want to merge with the style 
sheet of the active document. 

• You can remove any character formatting 
not defined in a selected paragraph's style by 
selecting the Revert To Style command from 
the Format menu. 
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CHAPTER TWENTY-FOUR 

Working With Tables 

Word offers a table editor that is almost seamless
ly integrated into the word processing environ
ment. Tables are useful whenever you need to 
align columns of text or numerical information. 

There are other uses for tables, however, that are 
not generally thought of, including the genera
tion of parallel vertical columns and letterhead. 
Microsoft Word's tables can also contain graph
ics that you paste in from the Clipboard. 

A table in word is comprised of a group of cells 
arranged in columns and rows. You create a table 
with the number of columns and rows you need 
to present your information and then fill in the 
cells. You can edit the contents of any cell at any 
time without affecting any of the other cells. 
Similarly, you can change the column widths by 
manipulating markers on the ruler. 

You can use this set of instructions to add a basic 
table to your document. 

1. Open a new document or the document to 
which you want to add a table. 

2. If the ribbon is not displayed, select the Rib
bon command from the View menu. 
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3. If the ruler is not displayed, select the Ruler 
command from the View menu. 

4. If you don't see paragraph markers in your 
document, click the Show/Hide CJ[ button in 
the ribbon, as indicated in Figure 97. 

IEJ Uo IEJ I B III Yl 1-~·1···1 

Show/Hide 1 button 

~ ~ R ifilml I 

Figure 97 Show/ Hide ljJ button in the ribbon. 

• Microsoft Word's table editor is easier to 
work with if the paragraph markers are 
displayed. The Show /Hide 1 button also 
toggles the display of end-of-cell mark
ers, end-of-row markers, and gridlines 
within tables. 

5. Select the Table ... command from the Insert 
menu. The Insert Table dialog box, shown in 
Figure 98, will be displayed. 

Number of Columns: l-It OK J 
Number of Rows: 12 I ( Cancel J 
Column Width: 13in I (Format ... ) 

Conuert From ------------------------~ 
0 Paragraphs 
0 Tab Delimited 

0 Comma Delimited 
0 Side by Side Only 

Figure 98 Insert Table dialog box. 

• Word supplies a default table setting of 
two columns and two rows, dividing the 
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available document width between the 
columns. You can override these settings 
if you like; the example provided here 
will use a table that has three columns of 
equal width with five rows. 

6. Enter 3 in the Number of Columns field. 

• Note that the Column Width field is au
tomatically updated to reflect the change 
you made in the Number of Columns 
field. In this case, the Column Width 
field is adjusted to 2 in. 

7. Enter 5 in the Number of Rows field. 

8. Click the OK button. Assuming you started 
with a new document, your table should 
look like the example shown in Figure 99. 

End-of-cell marker End-of-row marker 

•• , 
·~·· ·~· 

Figure 99 Simple table document. 

If you don't see the table's gridlines, select theTa
ble Gridlines option in the View panel of the 
Preferences dialog box. The dotted gridline of the 
table does not print; it's displayed only to show 
you the boundaries of the columns and rows of 
the table. Similarly, the end-of-cell markers and 
end-of-row markers do not print and are merely 
wayfinding aids. 

9. Enter your information in the first cell. 
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10. Press Tab to advance to the next cell. 

11. Enter your information in the next cell. 

12. Repeat steps 10 and 11 until the information 
in your table is complete. 

You can add more rows to your table automati
cally by pressing Tab at the end of the last cell. A 
new row of empty cells will be automatically 
added to the bottom of your table. Information 
you type within a cell will automatically wrap 
within the cells boundaries and the cell will au
tomatically expand to contain your information. 

Selecting Components 

Before you can adjust the formatting of a table 
you have to select the component of the table 
you want to work with. Every Word table con
tains selection bars that you use to select a cell, a 
column, or a row. 

• The Cell selection bar runs along the left 
edge of each cell. Clicking in any cell's selec
tion bar selects that cell. 

• The Row selection bar is the same as the Cell 
selection bar, but it is activated with a dou
ble-dick. 

• The Column selection bar runs along the 
right side of each cell, to the outside of the 
end-of-cell marker. It provides visual feed
back: move the cursor within the Column se
lection bar and the cursor changes into a 
down arrow. You can select a column by 
clicking in the Column selection bar while 
the cursor is a down arrow. 

• You can select the entire table by holding 
down the Option key while double-clicking 
anywhere within the table. 
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Deleting Components 

You can use this simple two-step procedure to de
lete the contents of any cell or range of cells. 

1. Select the cells from which you want to de
lete the contents. 

2. Select the Cut command from the Edit 
menu. You must use the Cut command; 
pressing the Delete key deletes only the con
tents of the first cell of the selection. 

Note that when you delete the contents of a cell 
or range of cells, only the information contained 
within the cells is removed; the cells themselves 
remain intact. 

You can use the following three sequences to de
lete the actual cell components from a table. De
leting the components from a table deletes both 
the cell and the information it contains. 

Deleting Rows of Cells 

1. Select the row or range of rows to delete. 

2. Press Command-Control-X. 

Deleting Columns of Cells 

1. Select the column or range of columns you 
want to delete. 

2. Select the Table Layout ... command from the 
Format menu. The Table Layout dialog box 
will be displayed. 

3. Click the Column radio button. 

4. Click the Delete button. 
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Deleting Selected Cells 

1. Select the range of cells you want to delete. 

2. Select the Table Layout ... command from the 
Format menu. The Table Layout dialog box 
will be displayed. 

3. Click the Shift Cells Horizontally radio but
ton to shift the remaining cells to the left, fill
ing the available space. 

• Alternatively, click the Shift Cells Verti
cally radio button to shift the remaining 
cells up, filling the available space. 

4. Click the Delete button. 

Adding Components 
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If you're adding more than a single component 
(cell, row, or column), you must first select an 
area with an identical number and arrangement 
of cells that you want to add. 

Adding a Row to the End of a Table 

1. Place the cursor in the table's last cell. 

2. Press Tab. 

Adding Interior Rows 

1. Select a range of rows directly below the 
point at which you want the new rows add
ed. The selection range must be identical in 
number to the ones you want to add. 

2. Press Command-Control-V. 
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Adding a New Column to the Right 

1. Place the cursor at the end of the table's first 
row, but before the end-of-row marker. 

2. Select the Table Layout ... command from the 
Format menu. The Table Layout dialog box 
will be displayed. 

3. Click the Column radio button. 

4. Click the Insert button. 

You can insert additional columns by choosing 
the Repeat command from the Edit menu. 

Adding Interior Columns 

1. Place the cursor in the column to the right of 
where you want to add the new column. 

• If you want to add several interior col
umns, select exactly as many columns as 
you want to add to the right of where the 
new columns are to be inserted. 

2. Select the Table Layout ... command from the 
Format menu. The Table Layout dialog box 
will be displayed. 

3. Click the Column radio button. 

4. Click the Insert button. 

Merging Cells 

There are times when you will want to merge a 
range of cells within a row to create a single cell. 
This technique is useful, for example, to create a 
heading that spans a range of cells. You can 
merge a range of cells to create a single cell with 
the following three-step procedure. 
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1. Select the range of cells you want to merge. 

2. Select the Table Layout ... command from the 
Format menu. The Table Layout dialog box 
will be displayed. 

3. Click the Merge Cells button. 

You can split a merged cell into its original com
ponent cells by following steps 1 through 2 of 
the above procedure and clicking the Split Cell 
button in the Table Layout dialog box. Note that 
you cannot split a cell that has not been merged. 
If the Split Cell button is unavailable, the cell 
you have selected is not a merged cell. 

Table Formatting 

Page224 

When you insert a new table into your docu
ment, the text formatting is the same as the para
graph that contains the insertion point. You can 
change any of the text contained within a table 
with any of the standard text formatting com
mands and methods. 

A variety of table formatting controls are accessi
ble by selecting the Table Cells ... command on 
the Format menu. Using these controls you can 
do any of the following: 

• Specify the alignment of the table. 

• Specify a border for the table. 

• Specify a shade for the table. 

• Specify a fixed height for each row. 

• Specify the spacing between columns. 

• Specify the width of columns. 

Some of these controls are also accessible from 
the ruler. 
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Regardless of the method you use to apply these 
formatting controls, the formatting affects only 
those cells you have selected. 

Selecting the Table Cells ... command from the 
Format menu causes the Table Cells dialog box, 
shown in Figure 100, to be displayed. 

Tobie Cells 

Apply To: I Entire Rows Selected 1..-1 

' OK J 
( Cancel ) 
( Apply ) 

1-1 
-Row-----------------. 

._1 A_ut_o_ ... l..-... 1 I I 

Column Width: 

Height: 

Space Between Columns: I 0.11 in I 
I 

(Border .•. ) 

Indent: I 0 in 

Alignment: I Left 

Figure 100 Table Cells dialog box. 

Changing Column Width 

When you insert a new table in your document, 
Word automatically calculates the column width 
based on the size of the text area available be
tween the margins. Minimal spacing between 
the columns is also automatically added. 

You can change the column width of your table 
with the Table Scale button on the ruler. 

In those instances that require a higher degree of 
precision, however, a better option is to use the 
Table Cells command, as explained in the follow
ing set of steps. 
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1. Select the column or range of columns you 
want to adjust. 

2. Select the Table Cells ... command on the 
Format menu. The Table Cells dialog box, 
shown in Figure 100 on page 225, appears. 

3. Enter the new width for the column or range 
of columns in the Column Width field. 

4. Click the OK button. 

You can change the spacing between columns by 
performing steps 1 through 2 in the above se
quence and entering the appropriate measure
ment in the Space Between Columns field. If you 
want varying amounts of space between differ
ent columns, you can select each column and 
use the indent control on the ruler. 

Adding Borders and Shading 
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You can add borders and shading to your table to 
increase your document's readability. This tech
nique is effective for setting off table headings 
and the like. 

It's very effective in long tables to lightly shade 
every fifth row or so as a visual reference and 
wayfinding aid. 

Note that you can add borders and shading to 
virtually any element in your document, not just 
tables. You can use borders to set off columns in 
a multiple column document, for example, and 
use shading to call attention to a single para
graph. The techniques described in this section 
are not limited to tables, and are applicable to 
various elements throughout your document. 

You can use the following set of steps to add bor
ders and shading to your table. 
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1. Select the table components to which you 
want to add borders or shading. 

2. Select the Table Cells ... command from the 
Format menu. The Table Cells dialog box, 
shown in Figure 100 on page 225, appears. 

3. Click the Border ... button. The Border dialog 
box, shown in Figure 101, will be displayed. 

Border 

Border----------~ Line -----------.., n OK l None 
Dotted 
Hairline 
Single 
Thick 
Double 

From TeHt: I 0 pt 
L-----=======::..1 Shading: 

Preset Borders I 
None 

(Cancel) 

IEJD l±J h~jjj~~ ~ Apply To: 
None BoH Shadow .-1 P"-a'-r""""a'-g-ra_p_h-------y-1 T--,1 

Figure 7 01 Border dialog box. 

4. Select the appropriate Preset Border from the 
options available in the lower left portion of 
the dialog box. 

• Alternatively, select the boundaries for 
the border by clicking the appropriate 
axes from the Border items in the upper 
left portion of the dialog box. 

S. Select the appropriate Line format from the 
available options in the upper right portion 
of the dialog box. 
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6. Select a shading option from the Shading 
pop-up menu shown in Figure 102. 

Border------. n OK D 

From TeHt: I 0 pt 

None 
Dotted 
Hairline 
Single 
Thick 
Double 

( Cancel ) 

Preset Borders---. r======= D [±] [±] 
None DoH Shadow 

1·:::·:::·:::·:::·:::·:11------.---,. 
1::::::::::::::::::::::11---...&.....1 
I:Ei:EEEEi:EEEil l;;;;;;;;;;;;;;;;;;;;;;;;;;;;;a:;;;;;!l 
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20% 
25% 
30% 
37.5"/o 
40"/o 
50"/o 
60"/o 
62.5% 
70"/o 
75% 
BO"lo 
87.5% 
90"/o 
1 OO"lo 

Figure 102 Border dialog box with Shading menu. 

7. Select the appropriate shading percentage 
from the pop-up menu. 

8. Click the OK button . 
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Table Tips 

Here's a list of a few tips to keep in mind when 
you are working with Word's table editor. 

• Formatting basic tables is tedious work; add 
them to your Work menu. 

• Adding borders and shading are even more 
tedious. Any borders and shading effects you 
add to your table (or other paragraphs) are 
part of the paragraph's formatting. Add the 
borders and shading effects when you set up 
your document's style sheets. 

• You can control the spacing between rows of 
your table more easily (and more precisely) 
by using styles to format the table's cells. 
Also, if you use styles, the row spacing will be 
consistent throughout the document. 

• If you repeatedly use a certain kind of table, 
store the table as a glossary item, and add it 
to your Work menu. 

• You can use your tables as simple spread
sheets. You can total a column of numbers 
(or a row of numbers, for that matter) by se
lecting the appropriate cells and choosing 
the Calculate command from the Tools 
menu. The sum is calculated and stored on 
the Clipboard. You can then paste the result 
into your document. 

• You can sort the contents of your tables by 
selecting the appropriate cells and choosing 
the Sort command from the Tools menu. 

• To alphabetize a list of names, use separate 
cells for first and last names and sort the con
tents of the last names column. 

• If you find yourself working with tables more 
than you thought you would (and you prob-
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ably will), you can add various options from 
the Table Layout dialog box to the appropri
ate menus with the Commands command 
on the Tools menu. You can also add key
board shortcuts to the new commands. 

• You can use Word's table editor to easily cre
ate multiple-column documents such as sim
ple newsletters, resumes, and the like. This 
strategy works best with documents that are 
symmetrical rather than asymmetrical. 

• You'll save yourself a lot of headaches if you 
use the Show /Hide'][ button in the ribbon to 
display all paragraph and table markers. 

• You seldom need to specify the number of 
rows, since a Tab will add a row for you. You 
don't have to use the standard margins of the 
rest of the document; you can set your own 
for the table itself. 

• Use Page Preview early and often to see how 
you are doing. 

• To help size columns, type in the longest 
piece of text that will appear in a single cell. 
Using this sample, resize the cell. 

• A table is an easy way to do a letterhead with 
graphics and text. Use the First Page Header 
option and insert a table. Next, establish col
umns for the elements of the letterhead. 
Then, resize the columns as needed. Finally, 
paste your graphics where desired and type 
letterhead text in the appropriate table col
umn. The resulting elements will appear 
only on the first page. 
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CHAPTER TWENTY-FIVE 

Working With Outlines 

Microsoft Word sports an integrated outline view 
that can be applied to any Word document. This 
outline view simplifies the creation and manage
ment of long documents. It's taken me quite a 
few years to realize that our grammar school 
teachers were right: long documents are much 
easier to create if you work from an outline. 

There are Macintosh outliners available that of
fer a more complete and customizable feature 
set, but none that are as seamlessly integrated 
within a complete word processing environ
ment. The main benefit to this approach is that 
you don't have to create an outline separately 
from your working document. In Word, your 
outline is part of your working document. 

Apply the outline view to your document by se
lecting the Outline command from the View 
menu. In the outline view, you can expand and 
collapse the headings and subheadings in your 
outline. Expanding the outline results in more 
detail being displayed, while collapsing the out
line causes only the underlying structure of the 
document to be displayed. 

In addition to providing a structural overview of 
your document, Word's outline view also serves 
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as an easy way to move large pieces of a docu
ment from one place to another. 

Figure 103 offers a comparative view of a portion 
of a very large Word document and its outline. 

Figure 103 Document (rear) and outline (front) 
views of the same document. 

Creating a New Outline 
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You can create a new outline with the following 
set of steps. 

1. Open a new document. 

2. Select the Outline command from the View 
menu. The ruler will be updated to reflect the 
outline view. 

3. Enter a level one heading by typing the in
formation at the insertion point. 
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Promote head 

Demote head 

4. Press Return to mark the end of the level one 
heading. A new level one heading will auto
matically be inserted. 

5. Continue adding level one headings by re
peating steps 3 and 4 as needed. 

6. You can add a level two heading-a subtopic 
in your outline-by clicking the demote 
heading level icon (Right Arrow) on the rul
er. The current outline item will be indented 
a half-inch denoting that it is a subtopic. 

7. You can add subsequent levels of subtopics
level three headings, etc.-by using the de
mote heading level icon (Right Arrow) on 
the ruler to set the appropriate level. The 
subtopic (heading) level is also reported in 
the status bar at the bottom of the window. 
Figure 104 shows a sample outline that was 
created using these techniques. 

Expand to level 

Expand a ll 

o This is a level one heading 
o This Is also a level one heading 

o This Is a leveltwoheading 
o This Is another level two heating 

o This is a level three heading 
o This is als>o a level three heading 

o This is another level two heating 
Cl This is anomer level one heading 

Figure 104 Sample outline with various subtopic 
(heading) levels. 
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You can use the various controls on the ruler to 
manipulate the elements of your outline. You 
can add body text at any time with the following 
four-step procedure. 

1. Position the cursor at the end of the heading 
immediately before where you want to insert 
body text. 

2. Press Return. 

3. Click the Convert to Body Text button on 
the ruler. 

4. Type your body text. 

Organizing by Outline 
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You can use the outline view to make wholesale 
organization changes to your document at any 
time. Instead of cutting and pasting a large range 
of text, you can simply enter the outline view, se
lect a section by its heading, and drag it to a new 
location in your document. 

When you select a heading in the outline view, 
all of its associated subheads and body text are 
selected with it. 

Here's a more accurate way to move a heading 
and all of its associated subheads and body text. 

1. Select the Outline command from the View 
menu. The outline view of your document 
will be displayed. 

2. Select the appropriate expansion level by 
clicking on one of the Expand to Level but
tons on the ruler. 

3. Select the heading you want to reposition. 
Note that you're changing the location of the 
selection, not its level. 
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4. Click the appropriate Move Head button on 
the ruler. Repeat this step as necessary to re
position the selected heading. 

Heading Styles 

Word has default definitions for nine heading 
styles, Heading 1 through Heading 9. You can 
change these style definitions in the same man
ner you would use for any paragraph style. 

Information related to changing and working 
with Microsoft Word's paragraph formatting 
styles is provided in the Working With Styles 
chapter beginning on page 203. 

Note that you cannot apply or edit styles while 
you are in the outline view. You must either re
turn to the normal view or you must split the 
document window and apply the styles in the 
normal or page layout views. You can use this set 
of steps to split the document window into two 
independent views. 

1. Drag the split bar, shown in Figure lOS, to 
split the window. 

c:1 Ibis Is a revel one heading 
o Tbjsls also a level one heading 

Cl Tb Is Is a level two heading 
o Ibis Is another level two heading 

Cl nus is a level three heading 
Cl nus is abo a level three heading 

c:1 Ibis Is another level two heading 
co ]bls Is another level one heading 

Figure 1 OS Split bar. 
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• Alternatively, you can double-click in the 
split bar to split the window into two 
panes of equal size. 

2. Click within the lower pane of the window. 

3. Select the Normal command from the View 
menu. The upper pane of the window will re
main in the outline view; the lower pane of 
the window will appear in the normal view, 
as shown in Figure 106 . 

"' lbls Is a level one hea!Sin g 
o This Is also a level one heading 

"' Th!Sisaleveltwoheading 

This is also a level three heading 

This Is another lewl two heading 
nus Is body copy associated. with lbe levell\loO beldil:lg Immediately above. 
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Figure 106 Split document window. 

4. Edit the heading styles using the techniques 
described in the Defining a Style section be
ginning on page 203. 

5. To rejoin the two panes of the window, dou-
ble-click within the split bar. 

Note that using Microsoft Word's split bar is not 
limited only to formatting heading styles. The 
split window offers an effective way to simulta
neously work within two different views of your 
document for various tasks. Displaying the out
line view in one pane and the normal document 
view in the other, for example, allows you to 
work quickly on large documents. Similarly, 
multiple split window views allow you to quickly 
evaluate formatting changes and easily navigate 
within a long document. 
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Numbering Outline Entries 

You can automatically number your outline 
headings with virtually any numbering scheme. 
You can use alpha-numerics, bullets, or any oth
er symbol. The following set of steps explains 
how to number your outline entries using the 
Harvard outlining style. 

1. Select the Outline command from the View 
menu. The outline view of your document 
will be displayed. 

2. Select the range of headings and subhead
ings that you want to number. 

3. Select the Renumber command from the 
Tools menu. The Renumber dialog box, 
shown in Figure 107, will appear. 

Paragraphs: @ Rll 0 Only If Already Numbered 

Start at: Format: ._I ____ _. 

Numbers: @ 1 0 1.1 ... 0 By EHample 0 Remoue 

[ OK ll (Cancel) 

."', 'm' L!:-::.1 

Figure 107 Renumber dialog box. 

4. Enter 1 in the Start at field. 

5. Enter I.A.l.a.i in the Format field. 

6. Click the OK button. 

Note that if you rearrange your headings in the 
outline after you have numbered them, the 
headings carry their associated number with 
them. The outline is not automatically renumbered. 
A good strategy is to number your outline as one 
of the last steps in preparing your document. 
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Outline Tips 

• You can use the headings in your outline to 
automatically generate a table of contents. 
This is the most effective way of creating a ta
ble of contents, especially in documents that 
will change on a regular basis. For more in
formation about this feature and a suggested 
strategy for its use, refer to the Long Docu
ment Features chapter beginning on page 
245. 

• You can display only the first line of body 
text paragraphs in the outline view by click
ing the First line toggle button on the ruler. 
Clicking the button again returns the display 
to all body text lines. 

• You can hide all the body text paragraphs in 
the outline view by clicking the Expand all 
button on the ruler until only the headings 
are displayed. You can then select the level of 
headings to display by clicking on the appro
priate Expand to level button on the ruler. 
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CHAPTER TWENTY-SIX 

Working ·with Graphics 

Microsoft Word 5.0 offers a very basic set of inte
grated drawing tools. Mostly, you will want to 
create your graphics in another program and im
port them into Word, but the integrated drawing 
tools are useful for adding very simple graphics 
to your documents. 

Previous versions of Word were incapable of di
rectly importing complex graphic formats. Word 
5.0 offers direct support for Pier, Encapsulated 
PostScript (EPS), and tagged image format (TIFF) 
graphics. This addition makes Word much more 
useful than ever before. 

The Picture Command 

For the most part you will find yourself using 
Word's Picture command on a fairly infrequent 
basis. It's useful only for creating very simple line 
art and adding text to existing graphic images. 

The Picture command is accessed from the Insert 
menu or the Picture button on the ribbon. It 
contains its own tool palette that is available 
only when a Picture window is open. 
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You can use these steps to open a Picture window 
in your document and create a simple graphic. 

1. Select the Picture ... command from the In
sert menu. The Insert Picture dialog box, 
shown in Figure 108, will be displayed. 

Select a Graphics File or Create 11 New Picture: 

I= Further ..,.I 

·-=·· •• I 

D DayMakerf 

=Further 
125950K auoiloble 

D FileMaker Prof 
D FrameMakert 
D Graphicsf 

• (( Open D [ £jt~e1 J 

, [Cancel J [Desktop J 
D HyperCordf [ Find File... J 
D MOREf 

( New Picture ) 

List Files of Type: I Grophics Files 

Page240 

Figure 108 Insert Picture dialog box. 

2. Click the New Picture button. The Picture 
window, shown in Figure 109. will appear. 

Tool palette 

Status bar 

Sample box 

Figure 109 Picture window. 

Word 5.0 Rapid Reference 



• You can also open the Picture window by 
double-clicking on an existing graphic or 
by clicking the Picture button on the rib
bon. If you create a new Picture window 
the window's name is Insert Picture. If 
you open an existing graphic, the win
dow's name is Edit Picture. 

3. Use the various tools available on the Picture 
window's Tool palette, identified in Figure 
110, to create your graphic. 

Selection tool 

Line tool 

Rectangle tool 

Ellipse tool 

Rotation tool 

Font/back tool 

Text alignment tool 

Line color palette 

Fill color palette 

LlJ\ 
'D 
D 0 
0 ' (). ~ 

lm)@ffi 
~EI 
El •• ] .Eg 

DJg) ....... 

D 

Text tool 

Polygon tool 

Round-rectangle tool 

Arc tool 

Duplication tool 

Flip tool 

Line width tool 

Arrowhead tool 

Line pattern palette 

Fill pattern palette 

Sample box 

Figure 11 0 Picture window Tool palette. 

• The Status bar will be continually updat
ed to reflect changes to the size of the 
graphic element and the degree of rota
tion when you use the Rotation tool. 

4. Close the Picture window by clicking its 
Close box. The graphic contained in the Pic
ture window will be automatically placed in 
your document at the insertion point. Word 
treats the component elements of any graph
ic you create as a single character. 
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Importing Graphics 

The best way to import a graphic is to use the Pic
ture command and select the graphic you want 
to import in the Insert Picture dialog box. 

1. Place the cursor where you want the graphic 
image to be placed. 

2. Select the Picture ... command from the In
sert menu. The Import Picture dialog box 
will be displayed. 

3. Select the file to import. Note that you can 
use the List Files of Type pop-up menu, as 
shown in Figure 111, to restrict the types of 
files listed in the Import Picture dialog box. 

Select a Graphics File or Create a New Picture: 

Ia MS wordf ... , 

[] A!H Masters llllord I m 
Cl Glossaries 

CJFurther 
125827K auallable 

Cl Settings Files ([ Open )J I ( l:jt~t;1 ] 

(Cancel] (Desktop] 
Cl Word Commands 
Cl WP Flies (Word) 

[ Find File... J 

( New Picture ] 

List Files of Type: t-G ... ~--~P~Fh=1 :-::-F_I_Ie_s _____ __._ ... .._;;;;;;;:;;;::;;;;;iiiiiliiliiii1ii011iiiiiiiiii;;;;;;;;t,~ 
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Readable Files 
Word Documents 
TeHt Files 
Rpple File EHchange Binary 
Stationery 

..~'Graphics Files 
MacWrite 
EPS 
MacWrite II 1.H 
PICT 
TeHt with Layout 
TIFF 
Works 2.0 for Macintosh 

Figure 111 List Files of Type pop-up menu. 
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4. Double-click the file's name or select the file 
and click the Import button. The graphic 
will be placed within your document at the 
current insertion point. 

If you are working with graphic images that are 
24-bits deep, perform all your editing-includ
ing adding any borders or callouts-in the origi
nating graphics program instead of using Word's 
Picture window. If you edit a 24-bit color image in 
the Picture window, all color information will be re
duced to the 8 colors supported by Word. If you open 
the Picture window by mistake, select the Undo 
command from the Edit menu immediately after 
closing the Picture window. 

If you copy a graphic image from a PostScript il
lustration program, such as Aldus FreeHand or 
Adobe Illustrator, Word will recognize only the 
PICT information on the Clipboard. To include 
the PostScript instructions used to describe the 
graphic image, hold down the Option key while 
selecting the originating program's Copy com
mand from the Edit menu. 

You can use this set of steps to place only the 
PostScript instructions of an Encapsulated Post
Script (EPS) file within your Word document. 

1. Check the Show Hidden Text checkbox in 
the View panel of the Preferences dialog box. 
This step is not required but will make it pos
sible to view the PostScript instructions con
tained within the EPS file. 

2. Select the Open ... command from the File 
menu. The standard Open File dialog box 
will be displayed. 

3. Select the Readable Files option from the List 
Files of Type pop-up menu. 

4. Select the file that contains the PostScript in
structions you want to include. 
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5. Click the OK button. Word opens the file in 
Text Only format. 

6. Select all of the PostScript instructions. 

7. Select the Style ... command from the Format 
menu. The Style dialog box will appear. 

8. Click the All Styles radio button. 

9. Select the PostScript style from the scrolling 
list of available styles. 

10. Click the OK button. The PostScript style will 
be applied to the selected text. 

11. Select the Copy command from the Edit 
menu. Alternatively, press Command-C. 

12. Open the Word document in which you 
want the PostScript code to be inserted. 

13. Place the insertion cursor where you want 
the PostScript image to appear. 

14. Select the Paste command from the Edit 
menu. Alternatively, press Command-V. 

• The image described by the PostScript 
commands will not appear in the docu
ment, but will appear when you print the 
document to a PostScript printer. 

15. Select the Print ... command from the File 
menu. The Print dialog box will appear. 

16. Check the Print Hidden Text checkbox. 

17. Click the Print button. 

Your document will be printed, including the 
image described by the PostScript commands 
you copied into your document. 

If you are not printing to a PostScript printer, the 
graphic image will not be printed. 
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CHAPTER TWENTY-SEVEN 

Long Document features 

Word 5.0 offers some excellent features for creat
ing long documents-table of contents and in
dexing- but others-cross-referencing and 
precise typographic control-are missing. 

I've created documents as long as a 250-page 
book completely within an earlier version of Mi
crosoft Word, though, so it can be done. Within 
the framework of this book, a long document 
can be considered any document longer than 
about 20 or 30 pages. 

Word is especially effective when used in con
junction with page layout applications such as 
PageMaker or QuarkXPress that do not offer ex
tensive word processing features. 

The key to working effectively with long docu
ments is pre-planning. Microsoft Word provides 
a feature set that allows you to consistently con
trol the formatting of your document while at 
the same time working more efficiently than 
many other word processing environments. 

This chapter provides information that is crucial 
to working with long documents, but much of it 
is also useful for working with Word more effi
ciently, regardless of document size. 
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Creating a Template 
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Your first inclination when faced with the task of 
creating a long document may be to simply start 
typing at the keyboard. Don't. You won't be hap
py with the results. If you have a burning insight 
that you're convinced will escape if you don't 
capture it, go ahead and whack away at the key
board for a page or two. But don't overdo it. 

The most efficient place to begin is to create a 
style sheet for your document and save it as a sta
tionery document. Then use the stationery docu
ment as a template for each chapter or other 
chapter-length section. The final tip is to use the 
outline view whenever necessary. 

Working with a series of small documents is 
much more efficient than working with one big 
one. I know, you've heard it before and it doesn't 
make sense to litter your hard disk drive with 10 
or 12 files when one would do. Trust me. Break 
your document up into separate files for each 
chapter. They open faster, save faster, and they're 
easier to navigate. Besides, think of how you 
would feel if you crash and lose the entire file. 
And it will happen. It happened to me on page 
238 of a 250-page book. 

If you're thinking that you'd still like to use a sin
gle document because of the trouble with con
necting all the parts at print time, don't worry 
about it. Word has a way of automatically link
ing a collection of documents when you initiate 
the print command. It even automatically ad
justs the page numbers. For more information on 
linking documents at print time, see Linking 
Documents beginning on page 263. 

Begin creating the template for your document 
by specifying the margins and other document
wide formatting attributes with these steps. 
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1. Open a new document in Word. 

2. Select the Page Setup ... command from the 
File menu. The Page Setup dialog box for the 
currently selected printer will appear. The 
Page Setup dialog box for the Laser Writer is 
shown in Figure 112. 

• Note that the currently selected printer 
in the Chooser will affect how your doc
ument is formatted. Make sure you have 
the appropriate printer selected. 

LaserWrlter Page Setup 1.1.1 

Paper: ® US Letter 0 R4 Letter 
0 US Legal 0 85 Letter 0 I Tabloid ~ I 
Reduce or 11111111% 
Enlarge: 

Printer Effects: 
181 Font Substitution? 
181 TeHt Smoothing? 

n OK n 
(Cancel ) 

(Options) 

Orientation 

-~ 
181 Graphics Smoothing? 
181 Faster Bitmap Printing? 

(Document ... ) 181 Fractional Widths 0 Print PostScript Ouer TeHt 

0 Use As Default 

Figure 7 7 2 LaserWriter Page Setup dialog box. 

3. Select the appropriate standard settings with
in the Page Setup dialog box. 

4. Check the Fractional Widths checkbox to 
improve the character spacing within your 
document. Note that the state of this check
box affects both printed output and display. 

5. Check the Print PostScript Over Text check
box if you intend to use PostScript effects 
within your document. 

• You may have to experiment with this 
setting. If this option is checked, the 
PostScript effect is laid on top of the text 
on the page. If this option is unchecked, 
the text is laid down on the page first. 
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6. Click the Document ... button. The Format 
Document dialog box, shown in Figure 113, 
will be displayed. 

• You can also access this dialog box by se
lecting the Document ... command from 
the Format menu. 

Document 

lns,~~~;-----~======~======~1 OK B 
Top: 11 In II Rt least! ... l ~-~~~~~~ 
Bottom: 11 In II Rt Leost!•l ( Concel J 
0 Mlrror'-E-ue-n-/ O_d_,d (Use Rs Defoult J 

~F~o~o~tn~o:\;te~s~~~~==~~~~~;:~~ ( File Series... ] r~ ~ Widow Control 
Position: I Bottom of Poge I•! D Print Hidden TeHt 
0 Restllrt Eoch Poge 0 Euen/ Odd Heede.;:.:.rs~---. 
® Number From: 1,..::1:....._----, Oefoult lob Stops: I 0.5 In 
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Figure 113 Format Document dialog box. 

7. Set the margins as appropriate for your doc
ument in the provided fields. 

• Click the Mirror Even/Odd checkbox if 
your document is two-sided and you 
wish to mirror the pages. Note that if this 
option is selected, the Margin labels 
change to read Outside and Inside in
stead of Left and Right. 

• The Gutter field is provided for a gutter 
margin. A gutter margin is extra space 
added to the inside margin needed for 
bound documents that are printed on 
both sides of the page. 

• Note that the Top and Bottom margin 
specifications have accompanying pop
up menus with At Least and Exactly op
tions. They are self-explanatory. 

8. Specify the location for the footnotes by se
lecting either the Bottom of Page, Beneath 

Word 5.0 Rapid Reference 



Text, End of Section, or End of Document op
tion from the Position pop-up menu. 

9. Specify the numbering for the footnotes by 
clicking either the Restart Each Page radio 
button or the Number From radio button. 

• If you clicked the Number From radio 
button, enter the number for the first 
footnote in the provided field. 

10. Check the Widow Control checkbox to pre
vent the first or last line of a multi-line para
graph from being left at the top or the 
bottom of any page. 

11. Check the Print Hidden Text checkbox to 
print any hidden text contained within your 
document. Note that if this option is activat
ed, PostScript instructions will be printed out 
in list form rather than the commands actu
ally being executed. 

12. Specify a default tab stop setting in the pro
vided field. Word's default is to place a tab 
stop at half-inch increments. 

Creating the Style Sheet 

i~, 
lml t.=_::J 

You can begin to create and refine your docu
ment's style sheet by following the instructions 
provided in the Working With Styles chapter, be
ginning on page 203. 

Note that Word provides you with a standard set 
of default heading styles: Heading 1 through 
Heading 9. These heading style names are used 
by Word internally to keep track of table of con
tents entries and outline headings. It's a good 
idea to keep the naming conventions intact. 
Word is incapable of tracking other style names for 
use in tables of contents and the outline view. 
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Before you jump headlong into altering Word's 
default heading styles for use within your docu
ment, take a minute to review the information 
provided in A Style Strategy beginning on page 
211. One of Microsoft Word's most powerful fea
tures is its ability to base paragraph styles on an 
existing style. 

Saving as Stationery 
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A stationery pad is a template of a document that 
you can use an unlimited number of times as a 
master template or format pattern. 

You can open a stationery pad like any other doc
ument. When you open a Word stationery docu
ment-either by double-clicking on it or by 
using the Open ... command on the File menu, a 
new, untitled document will be opened. This is a 
copy of your original stationery document, not 
the document itself. 

To save your style sheet, page setup, and other 
document formatting information as a statio
nery pad or document, follow these steps. 

1. Select the Save As ... command from the File 
menu. Word's Save document dialog box will 
be displayed. 

2. Enter a name for your stationery template. 

3. Select the Stationery option from the Save 
File As Type pop-up menu. 

4. Click the Save button. The Summary Info di
alog box will be displayed. 

5. Enter the appropriate summary information 
for your document in the Summary Info dia
log box. 

Your stationery document will be saved to disk. 
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Using the Glossary 

Microsoft Word's glossaries can be used as repos
itories for frequently used text and graphics. You 
can create as many glossaries as you like, and it 

· might be a good idea in certain situations to cre
ate a series of spectalized glossaries for different 
types of documents. 

You may prefer to add your glossary entries to 
Word's standard glossary, making them available 
within all of your documents. 

The glossary makes working in Word much more 
effi.dent. Once you have defined a glossary entry, 
you can simply select it instead of manually en
tering a lengthy paragraph of text or a common
ly used graphic element. 

Word ships with a standard glossary that con
tains several useful entries. 

Defining an Entry 

One of the most powerful aspects of Word's glos
sary feature is that all formatting is retained in 
the glossary entry. This makes things like defin
ing entries for letterheads, proposals, memos, 
and the like very simple and powerful. 

The following sequence shows you how you can 
define a glossary entry to automate the creation 
of a new article format, containing a title, subti
tle, byline, copyright notice, first paragraph for
mat, and subsequent paragraph format. 

These instructions will use the stationery docu
ment created in the first section of this chapter, 
although the instructions are generic in nature 
and can be used within any document. 
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•date 

1. Open the stationery document that was cre
ated in the first section of this chapter. If you 
don't have it, open a new document. 

2. Enter the appropriate title, subtitle, byline, 
copyright, first paragraph, and second para
graph information in the document. 

3. Apply the appropriate paragraph styles to the 
information you entered. 

4. Select the full range of elements that you 
have added in the document. 

5. Select the Glossary ... command from the 
Edit menu. The Glossary dialog box, shown 
in Figure 114, will be displayed. 

•date abbreuiated 
•date long 

n Insert D 
(Define) 

(Delete ) 

( Close ) •date short 
•da abbreuiated 

Show: 181 Standard Entries 181 User Entries 

Name: 
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Figure 114 Glossary dialog box. 

6. Enter a descriptive name for your new glossa
ry entry in the Name field. 

7. Click the Define button. Your entry will be 
added as a User Entry to Microsoft Word's 
standard glossary. Your glossary entry will 
now be available for use within any Word 
document you create. 
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Inserting an Entry 

You can insert any available glossary entry
Word's standard entries or any user entries that 
you have created-with these steps. 

1. Place the insertion cursor at the point at 
which you want to inset the glossary entry. 

2. Select the Glossary ... command from the 
Edit menu. The Glossary dialog box, shown 
in Figure 114, will appear. 

3. Select the glossary entry you want to insert 
from the scrolling list. 

• Checking only the Standard Entries 
checkbox limits the scrolling list to 
Word's built-in glossary entries. 

• Checking only the User Entries check
box limits the scrolling list to the user 
entries you have created. 

4. Click the Insert button. The selected glossary 
entry will be inserted in your document. 

Inserting an Entry from the Keyboard 

Here's an even more efficient way to insert a glos
sary entry from the keyboard. 

1. Place the insertion cursor at the point at 
which you want to insert the glossary entry. 

2. Press Cpmmand-Delete. A portion of the ac
tive window's status bar will be highlighted. 

3. Enter the name of the glossary entry you 
want to insert. 

4. Press Return. The specified glossary entry will 
be inserted in your document. 
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Glossary Entries in the Work Menu 

You can add a glossary entry to your Work menu 
with this set of steps. 

1. Press Command-Option-+ on the keyboard. 
(That's Command-Option-Shift-=). The cur
sor will change to a bold plus sign. 

2. Select the Glossary ... command from the 
Edit menu. The Glossary dialog box appears. 

3. Select the glossary entry you want to place in 
your Work menu from the scrolling list. 

4. Close the Glossary dialog box. 

Saving the Glossary 

Any glossary entries that you have defined are 
not automatically saved. You must specifically 
save the glossary document. If you haven't saved 
the glossary document during your work session 
you will be prompted to save it when you quit 
the Word application. 

If you don't pay close attention to the screen dis
play when you quit the Word application you 
can lose your unsaved glossary work quite easily. 
To prevent the loss of your work, save your al
tered glossary documents early and often using 
the following sequence. 

You can use the following steps to save your glos
sary entries to disk. • 

1. With the Glossary dialog box active, select 
the Save or Save As ... command from the File 
menu. 

• Use the Save command to save the glos
sary under the current name. 
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• Use the Save As ... command to save the 
glossary under a new name. 

2. If you've selected the Save command your 
glossary will be saved to disk. 

3. If you've selected the Save As ... command, 
the Save Glossary As dialog box will appear. 

4. Enter a name for your new glossary. 

5. Click the Save button. Your new glossary will 
be saved to disk. 

Merging Glossaries 

You can merge a glossary stored on disk with 
your current glossary with these steps. 

1. Select the Glossary ... command from the 
Edit menu. The Glossary dialog box will ap
pear with your current glossary entries listed. 

2. Select the Open ... command from the File 
menu. Word's Open Glossary dialog box will 
be displayed. 

3. Select the glossary you want to merge into 
your current glossary. The entries from the 
newly opened glossary will be merged with 
your current glossary. 

• When you merge a glossary from disk 
with your current glossary, and both 
have an entry with the same name, the 
entry from the newly opened glossary re
places the one in your current glossary. 

Do not move the Standard Glossary file from the 
Word folder. If you move this file, Word will be 
unable to locate it. You can force Word to open 
any glossary by renaming it "Standard Glossary" 
and placing it in the Word folder. 
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Working With Sections 

1111, 
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Word allows you to divide your word processing 
document into any number of sections. A section 
in Word can be as short as a single paragraph or 
as long as the entire document. You can make a 
banner headline span two or more columns, for 
instance, by formatting the headline paragraph 
as a separate section. 

You create a new section whenever you want to 
change the number of columns per page (unless 
you use the table editor to create pseudo-col
umns), footnote locations, page numbering, or 
headers and footers. 

You can create a new section anywhere in your 
document with this simple two-step procedure. 

1. Place the insertion cursor where you want 
the new section to begin. 

2. Select the Section Break command from the 
Insert menu. 

• In the normal view, a double dotted line 
appears at the insertion point to signify 
the end of the previous section. The dou
ble dotted line does not print and is used 
only as a wayfinding element. 

The keyboard shortcut for creating a new section 
is even simpler: 

Press Command-Enter where you want the new 
section to begin. 

Word stores all of its section formatting informa
tion in the section mark. If you delete the section 
mark, all of the section formatting for the preced
ing section is deleted. The adjacent sections are 
merged automatically, using the existing section 
mark formatting information. 
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Formatting Sections 

Stort: I No Breok 

Columns 
Number: 

Spoclng: 

Heoder/ Footer 

You can apply formatting characteristics to a sec
tion with the following steps. 

1. Place the insertion cursor anywhere within 
the section you want to format. 

2. Select the Section ... command from the For
mat menu. The Format Section dialog box, 
shown in Figure 115, will be displayed. 

Section 

0 Include Endnotes n OK D 
Poge Numbers 
Formot: II 2 3 l..,l ( Con eel 

0 Res tort ot 1 ( Rpply 

0 Morgin Poge Numbers 

From Top: lo.s in From Top: I O.S in ( Use Rs Defoult ) 
From Bottom: I 0.5 in lo.s in From Right: (Line Numbers ... J 
0 Different First Poge 

Figure 115 Format Section dialog box. 

3. Select the starting point characteristic from 
the available options in the Start pop-up 
menu: No Break, New Column, New Page, 
Even Page, or Odd Page. 

4. Specify the number of columns for the sec
tion in the Number field. 

S. Specify the column spacing for the section in 
the Spacing field . 

6. Specify the header and footer characteristics 
in the appropriate Header/Footer fields. 

• Checking the Different First Page 
checkbox allows you to use the First 
Header and First Footer commands on 
the View menu. 
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7. Specify the page numbering characteristics 
using the Format pop-up menu and the asso
ciated checkboxes and fields. 

8. Click the Apply button to test the changes 
you have made. 

9. Click the OK button to apply the formatting 
selections you have made in the Format Sec
tion dialog box. 

Table of Contents 

You can create a table of contents-as well as 
other listings such as lists of illustrations, tables, 
and figures-for your document quite easily. 

The key to easily generating a table of contents is 
to use Word's nine built-in default heading styles 
(Heading 1 through Heading 9) for document el
ements that you want to include in your table of 
contents. This approach allows you to generate a 
table of contents automatically. 

You can also use hidden ".C." paragraph codes 
("dot codes") placed within the paragraphs you 
want to include in your table of contents. This 
approach is useful if you want to include a lot of 
different tables of lists in your document, but is 
not as quick, intuitive, or as automatic as using 
the heading styles method. 

Generating a Table of Contents 
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Assuming that you have used Word's built-in de
fault heading styles (Heading 1 through Heading 
9) to format the heading~ and subheadings of 
your document, you can generate a table of con
tents with these steps. 
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1. Select the Table of Contents ... command 
from the Insert menu. The Table of Contents 
dialog box, shown in Figure 116, will appear. 

Table of Contents 

Collect------, 
®Outline 
0 .C. Paragraphs 

[81 Show Page Numbers 

n Start l 
(Cancel) 

Leuel: @All 0 From: lr:-1----.1 To: ._I ---..J 

Figure 116 Table of Contents dialog box. 

2. Click the Outline radio button. This in
structs word to consider table of contents en
tries based on the default heading styles. 

3. Check the Show Page Numbers checkbox. 
This includes the page numbers of the table 
of contents entries in the generated list. 

4. Click the All radio button to specify that all 
heading levels be included in the generated 
list. Alternatively, click the From radio but
ton and enter the ranges of the heading 
styles to include in the generated list. 

• The latter option allows you to specify a 
limited range of heading styles to in
clude-Heading 1 through Heading 3, 
for example-in the generated list. This 
approach is useful for including other ta
ble listings in a document that uses only 
a few of the nine available heading for
mats. For example, you can use Heading 
9 as a style for figure captions and specify 
only that heading level in the From and 
To fields to generate a list of figures. 
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5. Click the Start button. 

Word automatically repaginates your document, 
compiles the table of contents, and inserts it in a 
new section at the beginning of your document. 

Creating on Index 
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Creating an index is somewhat harder than gen
erating a table of contents because you have to 
use the hidden ''dot codes'' in your document to 
tag the words or phrases to be indexed. 

As inconvenient as the index dot codes may be, 
it is certainly easier than the alternative of index
ing your document by hand. Once the dot codes 
have been placed within your document they 
"float" from page to page as necessary and the in
dex can be updated at any time to reflect accu
rate page numbers. 

You can use the following set of steps to index 
your document. Note that indexing is easier if 
you have Word configured to display hidden text 
(Check the Show Hidden Text checkbox in the 
View panel of the Preferences dialog box). 

1. Select the text you want to include (up to 252 
characters) as an entry in the index. 

2. Select the Index Entry command from the 
Insert menu. Word automatically inserts the 
index code (.i.) and the end-of-entry code (;) 
and formats them as hidden text. 

3. If you want to include text you type from the 
keyboard in your index (names of people in 
"Last Name, First Name" format, for exam
ple), place the insertion cursor where you 
want the index entry to appear. Select. the In
dex Entry command from the Insert menu. 
Word automatically inserts the index code 
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and the end-of-entry code with the insertion 
cursor between them. Enter the text as you 
want the entry to appear in the index. 

4. Indicate index subentries by separating the 
entries with colons between the index code 
and the end-of-entry code. The table in Fig
ure 117 shows several examples. 

· Index Entry Index Code 

hypertext 50-60 

Nelson, Ted 50 
thinkertoys 50 

Nelson, Ted 50 
thinkertoys 50 

concept 50 

Nelson, Ted: father of 
hypertext 

multimedia (see 
hypermedia) 

(pp. 50] .i(.hypertext; 
(pp. 60] .i).hypertext; 

.i.Nelson, Ted; 

.i.Nelson, Ted:thinkertoys; 
----~--------~ 

.i.Nelson, Ted; 

.i.Nelson, Ted:thinkertoys; 

.i.Nelson, Ted:thinkertoys:concept; 

.i.'Nelson, Ted: father of hypertext'; 

.i.multimedia#(see hypermedia); 

Figure 117 Index subentries example. 

5. Indicate page ranges and literals using the 
open and close parentheses and single 
quotes respectively, as shown in the example 
in the table in Figure 117. 

6. Repeat Step 1 through Step 5 throughout 
your document until you have tagged all of 
your index entries. 

The tagging for your index is now complete. 

Be sure to turn off the display of hidden text be
fore generating the index. You can do this by 
Unchecking the Show Hidden Text checkbox in 
the View panel of the Preferences dialog box. The 
page numbers will not be accurate if you generate the 
index with hidden text displayed. 
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Generating an Index 

Once you have tagged all of your index entries as 
described in the previous section, you are ready 
to have Word generate the index. You can ini
tiate the process with these steps. 

1. Select the Index ... command from the Insert 
menu. The Index dialog box, shown in Fig
ure 118, will be displayed. 

lndeH 

Format: @Nested 
0 Run-in 

n Start » 
(Cancel) I ndeH Characters: 

@All 

0 From: D To: D 
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Figure 118 Index dialog box. 

2. Click the Nested radio button if you want in
dex subentries to appear below the main en
try. Alternatively, click the Run-in radio 
button if you want the index subentries to 
appear on the same line as the main entry. 

3. Click the All radio button to include all of 
the index entries in your document. Alterna
tively, click the From radio button to include 
only a specific alphabetic range if you're 
working with an especially long index. 

4. Click the Start button. 

Word automatically repaginates your document, 
compiles the index, and inserts it in a new sec
tion at the end of your document. 

Word 5 .0 Rapid Reference 



Linking Documents 

Easily linking documents in a sequential manner 
at print time is the pay-off for working with 
smaller individual Word documents. 

You can link multiple small component docu
ments to create a single large document in either 
of two ways: 

• Split the document into several small com
ponent documents and link them and print 
time, or 

• Create a control document that contains a 
series of Include statements for each compo
nent document. 

You can use these steps to link a set of compo
nent documents, creating a long document at 
print time. 

1. Open the first document. 

2. Select the Document ... command from the 
Format menu. The Format Document dialog 
box will be displayed. 

3. Click the File Series ... button. The File Series 
dialog box, shown in Figure 119, will appear. 

File Series 

Page Numbers 

0 Continue 
® Number From: 

Number Lines From: 

NeHt File ... 

n OK » 
1=-==1 (Cancel) 

11 I 

Figure 119 File Series dialog box. 
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4. Click the Continue button. This instructs 
Word to number pages consecutively, across 
the component documents, starting with the 
current document. 

5. Click the Next File ... button. Word's stan-
dard Open File dialog box will be displayed. 

6. Select the next component document. 

7. Click the Open button. 

8. Click the OK button in the Format Docu-
ment dialog box. 

9. Save the document. 

10. Open the next document in the series. 

11. Repeat Step 2 through Step 10 for each com
ponent document in the series. 

12. For the last component document in the se
ries, repeat Step 2 through Step 4. 

13. Save the last component document. 

Printing the Linked Documents 
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To print the linked documents, use this simple 
four-step procedure. 

1. Open the first component document. 

2. Select the Print ... command from the File 
menu. The Print dialog box will be displayed. 

3. Set the appropriate options. 

4. Click the Print button to print the entire 
string of linked documents in sequence. 
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CHAPTER TWENTY-EIGHT 

Working With Print Merge 

Word's print merge feature is useful for a wide va
riety of different tasks ranging from relatively 
complex invoices to more commonplace form 
letters and mailing labels. 

Word uses two separate documents to create a 
merged document: 

• The main document contains the static text 
and formatting that is common to each 
merged document. 

• The data document contains the list of vari
able information that makes each merged 
document unique. This information is stored 
in a collection of fields within records. 

With the addition of the Print Merge Helper 
command on the View menu, the merge feature 
has been semi-automated. You can use the Print 
Merge Helper and the following steps to partially 
automate the process of creating the data docu
ment that will be used by the main document. 

1. Open a new document in Word. 

2. Select the Print Merge Helper ... command 
from the View menu. Word's Open Data 
Document dialog box will be displayed. 
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3. Click the New button. The Data Document 
Builder dialog box will be displayed, as 
shown in Figure 120. 

Data Document Bu er 

Field Name: ( OK ) 

~II ====================~! K Rdd J 
~~~~ 

( Delete ) 
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(Cancel ) 

Figure 120 Data Document Builder dialog box. 

4. Enter the name for the first data field you 
want to include in your data document in 
the Field Name field. 

S. Click the Add button. 

6. Repeat Step 4 and Step S for each data field 
you want to include in your data document. 

7. Click the OK button. The Save Data Docu
ment dialog box will be displayed. 

8. Enter a name for your data document. 

9. Click the Save button. Your data document 
will be saved to disk and Word automatically 
places a Data instruction at the current inser
tion point of your main document. This Data 
instruction tells the main document where 
to locate the data document. Your print 
merge data document and main document 
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should look something like the examples 
shown in Figure 121. 

Figure 121 Print merge data document (top) and 
Print merge main document (bottom). 

Next, fill in the fields within each record of your 
data document. Press Tab to move between each 
field. Press Tab at the end of the last record to add 
a new record to the data document. 

You can prepare your main print merge docu
ment with these steps. 

1. Enter and format the text of the main docu
ment that you want to include in each ver
sion of the merged document. 

2. Place the insertion cursor where you want 
the first variable information to be inserted. 

3. Select the appropriate field name from the 
Insert Field Name pop-up menu. The field 
name will be inserted with surrounding print 
merge characters(«»). 
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4. Repeat Step 2 and Step 3 for each variable in
formation element you want to add to your 
merged documents. 

• You can reuse the field names as many 
times as you like within the document. 

5. Select the Save command on the File menu. 

The final step in using Word's print merge func
tion is to actually merge and print the docu
ments. You can do this with the following steps. 

1. Click the Check Errors button in the Print 
Merge Helper bar, shown in Figure 122. 

Check Errors button 

•I ltnsert Key word 

Merge to Printer button 

Figure 122 Print Merge Helper bar. 

2. Click the Merge to File button to create a se
ries of new documents-one for each record 
in the data document-with unique variable 
information. You can print each of these 
documents individually by selecting the 
Print command on the File menu. 

3. Click the Merge to Printer button to print 
the customized documents, one for each 
record in the data document. 
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compatibility issues 1-8 

hard disk space requirements 5 
RAM requirements 1-5 
software 6 

Connectix Corp. 4 
Conservatree Paper Company 145 
Control Panels 30 
controller 94-95 
corona wire 177-178 
cover page 155 
Create Publisher ... command 7 6--78 
Custom Paper Size ... radio button 152 
custom views 38-39 

outline view 38-39 
Cyan, Magenta, Yellow, and Black (CMYK) color 

model127 

D 
Dantz Development Corp. 8 
desk accessories 83-84 
Desktop DB 37 
Desktop DF 3 7 
Different First Page checkbox 257 
discharge pins 177 
disk cache SO 
disk-to-disk copy 

invisible files 88 
Display PostScript 129 
downloading a PostScript file 169 
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downloading fonts 163-166 
duty cycle 107 

E 
Edition Preview dialog box 77, SQ-81 
Edition window 79 
electricity consumption 111 
Embedding 189 

Copy Object 189 
Paste Object 189 

engine 92-94 
Canon LBP-LX 92 
Canon LBP-SX 92 
resolution 93-94 

enlarge 151 
envelope cassette 110 
equation editor 194 
Ethernet5, 109-110,113 
EtherTalk 109-110 
extensibility 19Q-196 
Extensions folder 31 

F 
face-up tray 15 7 
Faster Bitmap Printing 152 
Fifth Generation Systems Inc. 31, 36, 134 
file conversion 194-196 
file copy, background 46 
file sharing 53-7 4 

access privileges 58-6 7 
accessing shared files 67-73 
disconnecting 73 
problems 73 
starting 54-55 
users and groups 55-58 

Find File ... command 184-185 
Find ... command 43-45 
Finder 37-48 

navigation 4G-43 
FinePrint 104, 115-116 

typographic logic 116 
fixing roller assembly 17 6 
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fixing rollers 173, 176-177 
Flip Horizontal153 
Flip Vertical 153 
font conflicts 137 
Font Harmony 136, 137 
Font Substitution 152 
font suitcase 135 
Font/DA Mover v4.1 136, 137 
fonts 

downloading 163-166 
listing available 167-168 

Fractional Widths checkbox 247 
FWB Inc. 15 

G 
glossary 251-255 

defining an entry 251-252 
inserting an entry 253-254 
merging 255 
saving 254-255 

grammar checker 191-192 
graphics 239-244 

Encapsulated PostScript (EPS) 243-244 
importing graphics 242-244 
Picture command 239-241 

Graphics Smoothing 152 
gray scale printing 118-123 
Group Upgrade Kit 10-12 
gutter margin 248 

H 
halftones 119-123, 156 
half-toning 118 
hard disk drive 95 
hard disk formatting 9, 15-16 
hard disk space requirements 5 
Hard Disk Toolkit 15 

I 
index 260-262 

end-of-entry code 260 
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index code 260 
nested 262 

indicator lights 175 
installation 197-202 

CD-ROM 21-23 
Customized Install 198-201, 202 
Easy Install 198-201 
local hard disk 12-18 
network 19-24 
network installation 201-202 

Invert Image 153 
invisible files 88 
lTC Zapf Dingbats 107 

K 
Keep With Next 207 
KernEdit 138 
kerning 138 

L 
landscape 152 
Larger Print Area 154 
laser printers 

classes of 9 5-96 
heavy-duty PostScript printers 96 
light-duty PostScript printers 96 
medium-duty PostScript printers 96 
personal PostScript printers 96 
personal printers 95 

Laser) et III 113 
LaserWriter Font Utility 163-170 
LaserWriter II upgrades 111 
LaserWriter Ilf 105-108, 113 

PhotoGrade memory requirement 117 
LaserWriter Ilf/IIg driver 107 
Laser Writer Ilf/IIg utility software 108 

Calibrate 108 
Configuration 108 
Disable Start 108 
Download Fonts 108 
Enable FinePrint 108 
Naming 108 
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Select Halftone 108 
LaserWriter Ilg 108-111, 113 
LaserWriter IINTX 106, 109 
LaserWriter utility 148 
legal size printing 114 
licensing 24 
Linking 189 

destination 189 
source 189 

linking documents 263-264 
long document features 245-264 
Low Toner Level light 17 5 

M 
maintenance 173-180 
margins 111 
MathType 194 
memory 

managing 32, 86-8 7, 90 
requirements 1-5 

Memory control panel SO 
Merge to File button 268 
Merge to Printer button 268 
Mirror Even/Odd checkbox 248 
MODE32 4 

N 
Namer utility 148 
National SONIC chip 109 
navigation 40-43 
network zones 149 
new features 181-196 
New Group command 57 
New User command 56 
Next Style 216 
Number From radio button 249 

0 
Options button 153 
Orientation button 152 
outline view 231-238 
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creating a new outline 232-234 
First line toggle button 238 
heading styles 235-236 
numbering outline entries 23 7 
organizing by outline 234-235 
table of contents 238 

p 
page orientation 152 
Page Setup ... command 150-154 
Paged Memory Management unit (PMMU} 49 
PageMaker 245 
Pairs Software 138 
paper 139-146 

bond 139-140 
book 140 
brightness 143, 171 
calendering 141 
Conservatree Premium Rag Bond 146 
Conservatree Premium Xerographic 3HP 146 
cover 140 
grain direction 143 
Hammermill Laser Plus 143 
Hammermill Laser Print 143-144 
ink holdout 142 
LaserPro 145 
Neenah Paper Classic Crest 145 
offset 140 
opacity 142 
paper dust 146 
recycled paper 144-145, 146 
specialty 146 
text 140 
texture 141 

coated 141 
felt 141 
laid 141 
offset 141 
smooth 141 

weight 142 
paper cassette 110 
Paper Direct 146 
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paper handling 11 Q-111 
paper path 92 
PCL 113 
Peripheral Interface Controller (PIC) 102 
Personal LaserWriter 1.5 98-101, 113 
Personal LaserWriter NT 101-103, 113 
Personal LaserWriter SC 100 
Personal Upgrade Kit 9-10 
PhotoGrade 104, 117-124 

gray shades 118 
Laser Writer Ilf memory requirement 117 

portrait 152 
PostScript 

downloading a file 169 
PostScript Level1101 
PostScript Level2 105, 125-130 

caches 130 
color support 127-128 
composite font technology 129 
halftone algorithms 128 
memory allocation 128-129 
printer drivers 125-126 
speed enhancements 126-127 

PostScript Log file 169 
PostScript Type 1 fonts 135-138 
PostScript v51.8 102 
PostScript® File option 156 
power consumption 111 
PowerBooks 90, 197-198 
Precision Bitmap Alignment 154 
Preferences 183, 185, 186-187, 192, 260 

preference categories 187 
Preferences folder 32 
Print Hidden Text checkbox 249 
print merge 190, 265-268 

data document 190, 265 
Data instruction 266 
main document 190,265 
print merge characters 267 
Print Merge Helper command 265-267 

Print PostScript Over Text checkbox 247 
Print ... command 154-157 
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printer driver 14 7 
printer fonts 135 
PrintMonitor 158-163 
processes, halting execution of 48 
publish and subscribe 75-82, 188-189 

Create Publisher 188 
edition file 188 
editions, controlling 82 
Embedding 189 
Linking 189 
nested publisher 79 
overlapped publisher 79 
publisher, creating a 76-80 
Subscribe To 188 
subscriber, creating a 80-81 

Q 
QuarkXPress 245 
QuickDraw 100--101 
QuicKeys 41 

R 
RAM requirements 1-5 
Reapply the style to the selection 207 
Red, Green, and Blue (RGB) color model 127 
Redefine the style based on selection 207 
reduce 151 
Resolution Enhancement Technology (RET) 113, 

115 
Restart Each Page radio button 249 
Restart Printer ... command 169-170 
Retrospect 8 
Retrospect Remote 8 
Revert To Style 216 
RGB 127 
Ribbon tool182-183 
Ruler 183 

s 
sample page 168 
screen 119 
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screen frequency 120 
screens 119-123 
SCSI 95 
Section Break command 256 
section mark 256 
sections 256-258 
selection bar 204-205 
Set Print Time ... button 161 
Sharing ... command 60 
Show Hidden Text checkbox 260 
Show/Hide 'IT button 218 
SIMMs 2-4 
Small Computer System Interface (SCSI) 95 
software compatibility 6 
Space After 216 
Space Before 216 
spooling 158 
Startup Items folder 31-32, 47 
stationery pad 84-85,250 
style sheet 211, 249-250 
styles 203-216 

applying 208-211 
defining 203-205 
names204 
refining 206-207 
strategy 211-216 

Suitcase II 31, 36, 134, 135, 136, 137 
Summary Info 185 
support 24 
System 7 Tune-Up 89-90 
System Folder 25-32 

Apple Menu Items folder 29-30 
Control Panels 30 
Extensions folder 31 
Preferences folder 32 
Startup Items folder 31-32 
System file 27-29 

T 
table editor 217-230 

adding a basic table 217-220 
adding column 223 
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adding interior columns 223 
adding interior rows 222 
adding row 222 
borders and shading 226-228 
cell selection bar 220 
changing column width 225-226 
column selection bar 220 
deleting column 221 
deleting row 221 
deleting selected cells 222 
glossary items 229 
gridlines 219 
merging cells 223-224 
multiple-column documents 230 
row selection bar 220 
sorting table contents 229 
spacing between rows 229 
tables as simple spreadsheets 229 

table of contents 258-260 
Technology Works 2 
telephone support 10, 12 
template 246-249 
Text Smoothing 152 
thesaurus 193-194 
thumbnails 15 7 
toner cartridge 104-105, 107, 173 

recharging 180 
recycling programs 179 
replacing 175-180 
rocking 179-180 

transfer corona wire 177-178 
transfer guide 179 
transfer guide wires 17 7 
TrueType 28, 34, 35-36, 101, 106, 132-133, 

133-134, 135 
Tune-Up 89-90 
typography 131-138 

u 
Unlimited Downloadable Fonts 154 
Users & Groups control panel 56, 57 
users and groups SS-58 
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v 
Views control panel39 
virtual memory 5, 49-52 
VM_error 129 

w 
Widow Control checkbox 249 
Word Settings 187 
Work menu 209-211 
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